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One

Actran in a Nutshell

Actran is a general purpose finite element program for modelling sound propa-
gation, transmission and absorption in an acoustic, vibro-acoustic or aero-acoustic
context. Actran is characterized by:

• a large material library:

– acoustic fluid;

– thin acoustic layer and narrow tubes (or channels) including visco-
thermal effects;

– visco-elastic solids, solid shells, thin shells and beams;

– incompressible solids;

– composite materials;

– lumped mass and springs (discrete structural elements);

– rigid porous, lumped porous and poro-elastic materials (Biot theory);

• a complete element library:

– linear and quadratic;

– 2D, 3D and axisymmetric;

– standard volume elements and special transverse elements for the
accurate modelling of special configurations: shells, stiffeners, thin
acoustic layers, . . .

– conjugated infinite elements or adaptive PML elements for acoustic
radiation;

• a rich set of boundary conditions, operating conditions and sources:
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Actran in a Nutshell

– acoustic sources;

– incident and free duct modes for rotating machines;

– pressure, velocity, acceleration and admittance boundary conditions;

– kinematical excitations : imposed displacements and rotations;

– mechanical excitations : point load, distributed load, distributed pres-
sure, moments;

– in-build models of real-life excitations : incident diffuse sound field or
various models of turbulent boundary layer;

– interface with the leading structural FEA software packages (Nastran,
Ansys and Abaqus) for the import of dynamical results;

– interface with the leading CFD software packages (among others:
Fluent, star-CD and CFX) for the import of the heterogeneities of the
acoustic medium and the computation of the aero-acoustic sources;

– volume-based and surface-based aerodynamic source terms (Lighthill’s
and Möhring’s analogies) for analyzing broad-band noise generation
by turbulent flows;

• several unique features (non exhaustive list):

– sound propagation and absorption in a non-uniformly moving fluid;

– sound propagation in non-isothermal conditions;

– sound propagation in rotating acoustic components;

– sound propagation taking into account visco-thermal losses occurring
in thin air layers, tubes or arbitrarily-shaped cavities;

– random acoustics in both modal and physical coordinates;

• multiple calculation procedures:

– direct frequency response analysis;

– modal frequency response analysis using existing Actran, Ansys or
Nastran normal modes;

– compressible flow analysis;

– modal extraction;

• various solution strategies:

– restart capability;

– multiple load capability;

– strong or weak vibro-acoustic coupling;

– multi-level sequence tree to avoid unnecessary re-computations;

– hybrid Modal/Physical approaches;
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Actran in a Nutshell

– in-core and out-of-core solvers supporting sequential and parallel
(SMP and DMP) computer architectures;

– fast frequency response synthesis using the KRYLOVKRYLOV solver.

All the Actran features are seamlessly integrated in ActranVI, the dedicated
pre-post processing tool for Actran.
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Two

Introduction to Actran
Release 2023.1

Contents
2.1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

2.2 Major new features of Release 2023.1 . . . . . . . . . . . . . . 22

2.1 Introduction

Dear Actran Users,

Hexagon AB and its subsidaries is very proud to introduce the Actran Release
2023.1. Indeed, some major improvements are included in this revision. Please
refer to the next sections for more details. The new features and bug fixes
of Actran DGM are presented in the dedicated section of the Actran DGM
manual.

2.1.1 Important note concerning this release

• Actran 2023.1 supports the operating systems below:

– RedHat-7

– RedHat-8

– Suse-121

– Suse-15

– Windows-10
1Please note that GPU acceleration is not supported anymore on the Suse-12 operating system.
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Introduction to Actran Release 2023.1

– Windows-11

Further information can be found at https://hexagon.
com/support-success/manufacturing-intelligence/
design-engineering-support/platform-support.

2.2 Major new features of Release 2023.1

2.2.1 Vibroacoustics
Inverse method for equivalent sources computation
A new analysis type has been introduced in this release, the
EQUIVALENT_BC_ANALYSIS, to compute the equivalent amplitudes of any
set of loadings from a target output file, which can contain pressure at local
microphones, or sound power levels from different panels. This analysis is
compatible with both acoustic and structural loadings. It provides a framework
to represent complex sources in simplified form in terms of equivalent boundary
conditions, and facilitates easy exchange of information across teams without the
need to share detailed models.

Improvements in the Nastran super-elements based Virtual SEA work-
flow
Several key improvements have been added to the Nastran super-elements based
Virtual SEA workflow. First, multi-processes runs are now supported, activated by
the --dmp and --smp keywords in the launch command line. The Actran and Nas-
tran parallelism can also be differentiated with the four keywords --nastran_smp,
--nastran_dmp, --actran_smp, --actran_dmp. The Nastran assembly phase can
also be independently parallelized with the --nastran_dmp_assembly command.
Secondly, new structural connection cards are now supported, namely CBEAM and
CELAS2, allowing to solve more realistic models.

Represent acoustic trims as Insertion Loss (IL) in Virtual SEA
A new interface type (INSERTION_LOSS) has been added in Virtual SEA analysis.
It allows to represent an acoustic trim in between a couple of structure and
cavity subsystems by only specifying its Insertion Loss (IL). The fluid-structure
Coupling Loss Factor (CLF) will be scaled by this insertion loss. This allows to
define acoustic trims with minimal information, without specifying the material
properties and thicknesses of each layer.

Output requests in Virtual SEA
OUTPUT_REQUEST datablocks can now be specified in Virtual SEA anlaysis. This
allows to output easily local quantities. The available quantities for structural
subsystems are (squared) displacement, (squared) velocity, (squared) acceleration
and (squared) Gacceleration. The available quantity for acoustic subsystems is
(squared) pressure.
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Introduction to Actran Release 2023.1

Field maps in Virtual SEA
Output field maps can now be requested in Virtual SEA analysis, with the
same setup as in Direct Frequency Response. Those field maps will display
spatially dependent results (such as pressure, displacements, accelerations,...)
from subsystem-wise energies, which are spatially distributed based of the
available modes shapes.

Virtual SEA: support of ANSYS modes and matrices
In addition to Actran and Nastran, the Ansys modes (.rst) and matrices (.emat)
can now be used in Virtual SEA analysis, extending the support of compati-
ble modal extraction solvers. They can be used both for MODAL_ACOUSTIC and
MODAL_ELASTIC components.

Output folder for Direct Frequency Response analysis
A new option has been added for Direct Frequency Responses, allowing to write
all the files produced by the Actran computation in a specified folder. This
allows to keep the working directory clean, and find files more easily when
several runs are done. For a command line launch, this new option can be used
by adding the " --run_dir=output_folder" option, where output_folder is the
name of the created folder that will contain all the produced files. It can also be
activated for simulations launched from ActranVI by activating the "run in a
new folder" option, available in the settings.

Pass-by Noise Workflow: Possibilty to correlate sources
This new release of Actran brings the possibility to assign each acoustic source
of the pass-by noise workflow to a certain group. Sources within a group are
correlated, meaning that their phase is considered when they are combined,
which is important to have correct results for tonal noise. Uncorrelated sources
(which are in different groups) are combined discarding their phase, which
should be used with broadband sources. This addition also brings the possibility
to analyze the results by group of sources.

EM noise workflow: support rotor skewing
Skewed rotors are now supported in the EM noise workflow. With this im-
provement, linear and V-shape skewing can be specified for the rotor in the new
rotor skewing category in the Electromagnetic Model, with custom angles, and
a different 2D result can be used for each angle.

EM Noise Workflow: support of axial motors with double air gap
The EM noise workflow was also modified to support axial motors, which have
a different geometry than radial ones. The rotor is annular and sandwiched
between two stators, and the electromagnetic flux is then along the rotation
axis. To define such a motor, the Flux type, in the geometry category of the
Electromagnetic model, should be set to axial instead of radial.
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Damping Pad Positioning Workflow: advanced damping configuration
reports
Two new improvements have been developed for the damping pad positioning
workflow, in partnership with Autoneum. First, in the damping configuration
tab, the selection of elements to define a damping area can be done automatically
based on values of the computed mobility map. This allows to select easily
elements where the mobility map is the highest, ensuring an efficient damping.
Secondly, in the mobility map tab, an advanced damping configuration analysis
report has been added. If several different dampings have been defined, this
report will display which damping pads are the most efficient based either on a
maximum allowed mass, or a relative efficiency threshold.

Nastran/Actran Space Workflow: possibility to re-use existing modes
A new option has been added to the WM_SPACE workflow, which connects Actran
and Nastran for Diffuse Sound Field (DSF) applications. This option allows to
skip the structure modal extraction step if the modes are already avalaible. This
decreases significantly the computational cost of running multiple configurations
where the structural model is not changing. This option can be activated with the
following syntax: --modes_files_storage_directory=folder where folder is
the directory containing the already computed modes.

2.2.2 Aeroacoustics
Equivalent fan noise sources
This release of Actran comes with a new ICFD utility (RING_DIPOLES) to compute
equivalent fan noise sources from fan specifications, such as its diameter, RPM,
power and number of blades. From those inputs, Actran will compute the
equivalent drag and thrust, and create a ring of properly phased dipoles. Those
dipole sources can then be used in any acoustic simulation to represent the fan
acoustic excitation.

Support of Double Degree Of Freedom (DDOF) liners and wire mesh as
resistive layer
In previous releases, the acoustic liner material was limited to SDOF (Single
Degree Of Freedom) with only perforated plate available as resistive layer. This
release brings the possibility to specify a DDOF (Double Degree Of Freedom)
acoustic liner, and specify a wire mesh as resistive layer. Those improvements
allow for a more accurate representation of the liner impedance, integrating
grazing flow effects and a higher flexibility, with parametrized liner geometry.
To model a DDOF liner, an ACOUSTIC_LINER boundary condition can be created,
which should point to two LINER_LAYER materials.

Ensight Gold format support for ICFD idle mode
The ICFD idle mode can be used to launch simultaneously the CFD and ICFD
computations. ICFD will process CFD results ‘on the fly’ as soon as they are
available. This feature is now compatible with the EnsightGold format. The CFD
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solver should export the .case/.encas file at the beginning of the computation
and update it at each timestep. As for the other CFD formats which were already
compatible, this idle mode can be activated by specifying CHECK_CFD_FILES and
CHECK_WAIT_TIME in the CAASOURCES ICFD datablock.

2.2.3 Solvers
Automatic usage of Block Low Rank factorization with high precision
A new automatic behavior of the Block Low-Rank (BLR) methodology is available
for the MUMPS solver, which can be activated with the BLR AUTO parameter in the
MUMPS solver property window. The solver will automatically switch between
full and BLR high precision factorizations, based on the size of the model and
the available memory. This will decrease computational time and memory
consumption during factorization step, while still ensuring the results accuracy.

2.2.4 Graphical User Interface
Spectrogram plots in WaterfallViewer
A new spectrogram plot tool is available in WaterfallViewer. It allows to plot
results along engine orders, resulting in a spectrogram diagram, with one line
for each order. It allows to a better visualization and analysis of RPM-based and
order-based results. The input data can be coming from one .plt file containing
the complete run-up, or several .plt files (one by RPM/order). This tool can plot
any given quantity (pressure, displacements, power, ...), and will automatically
detect the orders for RPM-based results.

Post-processing data in project (.apf) files
Project (.apf) files saved with Actran 2023.1 can now contain post-processing data,
such as maps or deform visualizations. It allows to safely store progress when
doing post-processing in ActranVI and re-import easily custom post-processing
diplays.

New statusbar in the Graphical User Interface
An interactive statusbar has been added in all applications (ActranVI, PLTViewer,
WaterfallViewer and WorkflowManager). It allows the user to see and change
interactively the working directory, check the number of warnings of the last
operation done and have a better understanding of the application state (busy or
idle). In ActranVI, the active analysis and the location of the saved project .apf
file are also part of this statusbar.

Merge of ’Real part’ and ’Animate’ operators
In previous releases, the Animate operator had to be manually selected in the
display property window to perform a harmonic animation, instead of the default
Real Part operator. Both operators have been merged for this release, introduc-
ing a new default operator, "Real Part (and Phase control/Animate)", which
allows to perform harmonic animations more easily.
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Keeping PID information in extruded meshes
Two new options have been added to the Extrude meshing tool. "Keep original
PIDs distinction" allows to generate one extruded volume PID for each surface
PID selected as input, and "Generate PIDs interface" will create a single
surface PID which contains all the inner interfaces between the extruded volumes
PIDs.

2.2.5 Various other improvements

• Improved user experience for the Extract Blade tool.

• Virtual SEA: Simplified setup for trimmed acoustic radiation,
and EXTERIOR_PELLICULAR_ACOUSTIC is now compatible with
EXTENDED_SOLUTION.

• Virtual SEA: Support subsystems which contain only 0D and 1D elements.

• WorflowManager: Control curve styles in all plots, and allow graphical
addition and removal of cuts.

• WorflowManager: scripting now supports images and data export.

• WorflowManager: WM_SPACE supports OP2 and OP4 Nastran super-elements.

2.2.6 Known issues resolved

• Energy Analysis: The output request code for injected power is changed
from Wi to ijP, to be aligned with all other analysis.

• Virtual SEA: Better robustness for industrial TL models

• Virtual SEA: Better robustness with LOCAL_DAMPING
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Contents
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3.1 Overview of the documentation

This User’s Guide covers ActranVI, PLTViewer and WATERFALLViewer.

The modules Actran/Acoustic, Actran/VibroAcoustic,
Actran/AeroAcoustic, Actran/TM, Actran DGM and Actran for
Nastran are covered in dedicated User’s Guide.

This User’s Guide is organized in five parts:

Part I - Getting started with ActranVI - contains an overview of the
Actran features (Chapter 1), an introduction to this new revision (Chap-
ter 2), the present overview of the documentation and tips for an efficient
support (Chapter 3) and the guidelines for the installation (Chapter 4). This
part also provides the different way to launch ActranVI (Chapter 5) and,
finally, a guided example to quickly start with ActranVI (Chapter 6).

Part II - ActranVI Reference Guide - extensively describes all the func-
tionalities of ActranVI to pre- and post-process an Actran analysis. It
contains five chapters:

• Chapter 8 describes all the menus and settings;

• Chapter 9 describes the graphical render window;
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• Chapter 10 describes the different data trees and their content;

• Chapter 11 describes the usage of the toolbox;

• Chapter 12 describes the element selection tool.

Part III - PLTViewer Reference Guide - extensively describes all the func-
tionalities of PLTViewer to post-process Actran frequency response func-
tions It contains five chapters:

• Chapter 16 is the overview of the PLTViewer;

• Chapter 17 describes all the menus and settings;

• Chapter 18 describes the different data trees and their content;

• Chapter 19 describes the creation and edition of functions;

• Chapter 20 describes the graphical render window and the edition of
figures.

Part IV - WATERFALLViewer Reference Guide - extensively describes all
the functionalities of WATERFALLViewer to post-process Actran waterfall
diagrams. It contains five chapters:

• Chapter 22 is the overview of the WATERFALLViewer;

• Chapter 23 describes all the menus and settings;

• Chapter 24 describes the different data trees and their content;

• Chapter 25 describes the creation and edition of functions;

• Chapter 26 describes the graphical render window and the edition of
figures.

Part V - Sessions and Scripting - details the use of sessions (Chapter 27
and the advanced capabilities of the API to easily create user scripts in
ActranVI (Chapter 29) or PLTViewer and WATERFALLViewer (Chap-
ter 30).
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3.2 How to get support

Contents
3.1 Overview of the documentation . . . . . . . . . . . . . . . . . 27
3.2 How to get support . . . . . . . . . . . . . . . . . . . . . . . . . 29

3.2.1 Contact

For any technical question, please visit SimCompanion platform:
https://simcompanion.hexagon.com/.

Support Team may be contacted by creating a case from following webpage:
https://simcompanion.hexagon.com/customers/s/case/Case/Default

Alternatively, Support Team may be contacted by e-mail or phone:

For USA and North-America :

• e-mail : mi-msc-fft.support.na@hexagon.com

• phone :1-800-732-7284 and press 5

For France :

• e-mail : mi-msc-fft.support.fr@hexagon.com

• phone :+33-5-34-51-96-33

For all other countries : please contact your local distributor or support at:

• e-mail : mi-msc-fft.support@hexagon.com

• phone :+32-10-48-79-53

3.2.2 Submit a technical issue

To help us providing you an efficient support, please follow the guidelines below
when submitting a technical issue:

• specify your name, company, department, e-mail address and phone num-
ber;
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• specify the concerned product name and version;

• describe the issue by giving as many relevant details as possible:

– a small picture can be very useful to understand the issue;

– provide the full command line used to launch Actran;

– provide the error message displayed by Actran;

– ZIP and attach the input file and all related files (include files, output
files, report directory, script used to launch Actran, mesh files . . .);
if the total files size is larger than 10Mb, please refer to the section
below specifying how to send large files.

• explain which investigations have already been done to solve the issue;

• give the computer configuration (hardware type, number of CPUs, Operat-
ing System, available RAM, local scratch disk size. . .).

Your submitted issue will receive a Ticket ID (included in the subject field of the
Support Team answer). When replying to the email, please do NOT modify the
subject field as it contains important tracking information. If you want to submit
another technical issue not related to a previous one, please do not use a previous
subject including a Ticket ID already assigned and start from a blank e-mail. It
will ease the treatment of your issue.

3.2.3 Start to solve an issue

Determine where the error message is coming from by looking the output mes-
sages such as the *.log file:

• is it an Actran error message?

• is the error message generated by the operating system?

If an Actran error message is related to a specific data block, try to reproduce
the issue after removing this data block from the data file.

Send these preliminary conclusions to together with the other documents.

3.2.4 Exchange files

The Hexagon e-mail server blocks e-mails containing large attachment (larger
than 10Mb) but there are several other ways of exchanging large files. Be confident
that all files provided to Hexagon will be handled as confidential material. Please
contact the support team to define the proper way to exchange larger files.
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4.1 Supported platforms and ’s Lifecycle

is committed to providing the Actran community with releases on the most
suitable and popular platforms for numerical simulation. constantly monitors
the market and evaluate the customers needs in order to remove old-fashion
platforms from the supported list and add new ones that are the most relevant.

In this framework, Actran has been compiled and tested on several platforms.
The list of the supported platforms is available in the platform definition
document, available at:
https://hexagon.com/support-success/manufacturing-intelligence/
design-engineering-support/platform-support.

Please contact if your platform is not in the list.

4.1.1 ’s lifecycle

In order to rationalize the portfolio of platforms, a Product Lifecycle Manage-
ment (PLM) has been set-up. A dedicated platform evolves in time from the
BeginOfSales status to successively the EndOfSales, the EndOfLife and finally the
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EndOfSupport status.

4.1.2 BeginOfSales

A platform supporting Actran is at BeginOfSales when we provide an external
release built on this platform.

4.1.3 EndOfSales

At any point in time, any supported platform can be decided to be at its EndOf-
Sales. This may happen when a platform is unpopular or if the vendor of the
platform marked the platform to be at its EndOfSales. From this point onward, we
target to perform one last major release of Actran on this platform. Afterwards,
this platform reaches its EndOfLife.

4.1.4 EndOfLife

At that time, a last minor release of Actran is performed. Bug-fixes on this
platform may be provided until its EndOfSupport, depending on their origin.

4.1.5 EndOfSupport

At this point, no support at all will be provided anymore on this platform. The
time between EndOfLife and EndOfSupport is maximally one year.

4.2 Online download of Actran

Actran can be downloaded from the https://mscsoftware.
flexnetoperations.com website.

4.3 Setting Up Actran

To properly install Actran, please preferably refer to the complete instructions
available on our server at https://www.fft.be/Actran-installation. Installa-
tion guidelines are provided in the following sections.

4.3.1 Windows platforms

Simply launch the graphical installer and follow the given instructions.

Windows Firewall may block some MPI features on all public and private networks.
In case of a Windows Security Alert pop-pup appears, please allow access to the
needed processes to communicate on these networks.

4.3.2 Unix/Linux platforms

Execute the installer in a prompt and follow the given instructions.
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4.4 Setting up the Actran licensing server

The Actran usage is controlled by FLEXnet. The set up of a minimal FLEXnet
server is described here. It is however strongly advised to contact your organiza-
tion’s FLEXnet manager, who will be able to set up the server in compliance with
your local rules related to licensing management.

The MSC licensing tool can be downloaded from the https://mscsoftware.
flexnetoperations.com website.

To setup the Actran licensing, execute the installer downloaded and follow the
given instructions. Then, to correctly pursue the installation, please refer to the
https://www.fft.be/Licensing-installation page.

To obtain a valid license file for this server, please contact the Support Team.

4.5 Advanced - Parallel version

Please refer to https://hexagon.com/support-success/
manufacturing-intelligence/design-engineering-support/
platform-suppor for more details about:

• the MPI libraries used within the parallel Actran version;

• the supported interconnects.

The selected standard is IntelMPI . This version is entirely integrated within the
Actran productline.

4.6 Installation Directory

In the installation directory, besides the folders related to the different Actran
releases, two other folders are available.

Figure 4.1: Bin and conf folders

The bin folder contains the script launched in background by Actran when
executing the application. The script must not be modified in any case.
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The conf folder contains two files the user can edit. The user can have a look to the
actran.in.template which specifies the syntax to follow in the actran.ini file.
This last one contains the default version that will be executed when launching
the application. It can also contains the path to the license file which will be used
in case the MSC_LICENSE_FILE environment variable can not be specified due to
user rights.

Figure 4.2: Conf folder
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5.1 Introduction

The script to launch ActranVI is available in the installation folder under the
name actranvi. On Windows platforms, a shortcut to this script is automatically
created in the START menu.

5.2 Screen resolution requirements

ActranVI requires at least a full-HD (1920x1080) resolution. For high DPI
screens (like 4K screens), it is possible for the user to scale the UI by defining
ACTRAN_HIGH_DPI_SCALING as environment variable. This can improve
readability.

5.3 OpenGL requirements

ActranVI requires to have a graphical card and matching drivers compatible
with OpenGL-3.2.
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5.4 Syntax of the command line

The execution of ActranVI can be started at the operating system prompt by
typing a specific command line.

ActranVI command line options are provided by typing the following command:

actran -u VI --help

The usage of the command line for ActranVI is:

actran -u VI [options]

where the different options available are listed here below:

--autoparse, -e : is followed by the filename of the Actran input file to be
read;

--import_mesh, -i : is followed by the mesh file to be read;

--execute, -x : is followed by the script file to be executed;

--no_graphics, -n : deactivates the graphical support (post-processing is also
disabled);

--export, -o : is followed by the filename of the output analysis read from
--autoparse option;

--interfaces, -f : activates visualization of topological interfaces;

--report : is followed by the path of the report directory, were session and trace
files will be written;

--debug : activate debug information and deactivate the redirection of the
standard output to log frame;

--errorlevel : is followed by the severity level (INFO, EFFICIENCY, CAUTION,
WARNING, FATAL) at which the application will abort;

--background, -b : leave the main window iconified;
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--run_dir : is followed by a foldername within which all files or directories
created by Actran will be dumped. This option is currently only available
for direct frequency response analyses.

The options [--autoparse, -e] and [--import_mesh, -i] and [--execute, -x]
for the Actran input file, the mesh file or the script file respectively are not
mandatory when using the commandline actranvi. If the user do not specify
one of the options, ActranVI will automatically detect if the file is an Actran

input file, a mesh file or a script file. The autodetection of filetype is supported
for standard formats (.nff, .bdf, .op2 etc.). However, the autodetection is not
supported for CFD formats. Consequently, it is mandatory to specify the options
when working with CFD formats.

PLTViewer and WATERFALLViewer command line options are provided by
typing the following command :

actran -u PLTViewer

actran -u WaterfallViewer

5.5 Launching the Actran Launcher

The Actran launcher (see Section 7.1.1 of Volume 1) can be used to launch an
ActranVI session.

On Windows platforms, the Actran launcher can be launched using the START
menu:

START→ MSC.Software→ Actran Launcher [2023.1]

On Linux platforms, the Actran launcher can be launched using the following
command, after sourcing Actran (see next section):

actranw

5.6 Remarks and Further Reading

• On Windows platforms, the graphical applications can be launched in the
START menu.
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5.6.1 Sourcing script (backward compatibility)

In Actran versions prior to 2023 release, the sourcing of Actran was required in
batch mode. This requirement is not necessary anymore and Actran can directly
be used after installation without sourcing when using the "actran" command.
For backward compatibility purposes, the sourcing shell script is still available
in the installation directory under <actran-path>/productline/etc/ directory
(setenv.bat for Windows platform, setenv.sh for Linux platform).

In order to secure the execution of Actran in batch mode, a configuration shell
script is available in the Actran installation directory. The execution of this
script has two major effects:

• it updates the PATH environment variable and adds the bin directory to the
current PATH;

• it updates the LD_LIBRARY_PATH environment variable and adds the lib
directory to the current LD_LIBRARY_PATH.

As those modifications are done in a shell script, they do not survive the session.
As soon as the terminal is closed, the modifications are lost. Only one single
version of Actran can be used per session of terminal.

Use on Linux platforms
To call the shell script using BASH, please enter the following line (productline
in lowercase) :

source <actran-path>/[productline]

For example, to use Actran_2023_1 that is installed in the directory /opt/FFT/,
type :

source /opt/FFT/actran_2023_1

To call the shell script using SH, please enter the following line (be careful to
write DOT SPACE before the productline):

. <actran-path>/[productline]
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You will then be able to run the executables contained in the Actran productline.
To use multiple productlines, it is required to open a new session for each
different productline. Undesired effects could occur if this general rule is not
respected.

Use on Windows platforms
To call the shell script, simply call (productline in lowercase):

<actran-path>/[productline]

For example, to use Actran_2023_1 that is installed in the directory C:\FFT\,
type :

C:\FFT\actran_2023_1.bat

You will then be able to call the executables contained in the productline. To use
multiple productlines, it is needed to open a new command prompt for each
different productline. Undesired effects could occur if this general rule is not
respected.
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Six

A Guided Example - Horn
Model

6.1 Introduction

A guided example is provided, through this Chapter, to illustrate the process
of building an Actran analysis, launching the analysis, and performing the
post-processing.

The model that is considered represents a simple horn that radiates in half free
field.

When following this guided example, the user should perform the same oper-
ations as indicated in the guide. In the current chapter, these operations are
indicated in the following style (bullet and italic):

• This is an action that the user needs to perform

• This is another action that the user needs to perform

6.2 Overview of the Graphical User Interface

• Start ActranVI. (Refer to Chapter 5)

Figure 6.1 shows an overview of ActranVI’s Graphical User Interface (GUI).

The GUI is composed of the followings parts:
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• Data tree panel: containing mesh data, analysis data, and visualization;

• render window: for visualizing the finite element mesh;

• Toolbox;

• Element selection tool panel. By default, this panel is hidden when starting
ActranVI

When ActranVI is started, the Render window is empty and the data tree panel
contains only the basic data trees.

Figure 6.1: Overview of ActranVI’s Graphical User Interface

6.3 Pre-processing

6.3.1 Import mesh

The following mesh data file is available in the folder of the ActranVI User’s
guide.

mesh_horn.dat

• Load the mesh using the menu.
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File→ Import mesh ... → DAT

• Click on "Display mesh".

When the mesh is imported, it is visualized in the Render window. The mesh
information is shown under the Topologies tree.

A topology is composed of a Mesh tree and a Domain tree. In the Mesh tree,
the imported finite element mesh is available. The different parts of the mesh
appear in different groups according to their dimensions, element orders (linear
or quadratic) and properties (identified by a property ID or PID).

• Left-click on the "+" and "-" signs in the Topology tree to develop or fold the trees,
respectively (see Figure 6.2).

Figure 6.2: Develop and fold the trees

6.3.2 Render window operation and Mesh visibility

The set of icons on the bottom pane of the Render window may be used to change
the angle of view (Figure 6.3).

Figure 6.3: Render window controls
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In the Render window, the left mouse button is used to rotate the mesh. The
middle button is used to translate the mesh (by holding the button and moving
the mouse). The right button is used to zoom in or zoom out the mesh. The scroll
wheel can also be used to zoom in or zoom out the mesh.

The visibility of the mesh parts can be changed using the three icons on the left
side of the mesh parts items in the Data tree panel.

• Adjust the mesh’s size and position in the Render window;

• Adjust the visibility of the different trees in order to visualize the finite elements’
wire. Set the 3D part semi-transparent, the 2D parts completely opaque, as shown
in Figure 6.4

• Set different colors for the different mesh parts. Right-click on the topology’s node
(MESH.0), and choose "Set auto colors", as shown in Figure 6.5.

Figure 6.4: Adjust the visibility of the mesh
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Figure 6.5: Set auto colors for different PID’s

The resulting mesh visualization in the render window is shown in Figure 6.6.

Figure 6.6: The mesh visualized in the render window

6.3.3 Identify the different parts in the input mesh

The mesh contains 3 parts: a 2D inlet surface; a 2D exterior surface and a 3D
volume. (Figure 6.7).
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Figure 6.7: Different parts of the mesh

• Identify the three parts of the mesh in ActranVI

6.3.4 Create analysis

The horn model is solved in the frequency domain. For that, the user needs to
create a Direct Frequency Analysis.

• Create a Direct Frequency Response using the main menu bar

Add→ Analysis→ Direct Frequency Response

As the analysis is created, its property window pops up. In this window, the
user can specify the desired frequency range of the analysis. This is shown in
Figure 6.8.

• The objective is to define a frequency range from 10Hz to 2000Hz, with a step of
10Hz. For this purpose, Fill in the "Frequencies" field with value [10,10,2000] in
the popup window;

• Close the window.
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Figure 6.8: Specify the frequency range of the model

6.3.5 Create domains

In order to build an Actran Analysis, the user needs first to create the Domains
in the Topology tree.

• Create a Domain for the volume: right-click on the "Domains" and select "Add
Domain..." (Figure 6.9);

• In the popup property window of the new domain, change the name of the Domain
to "horn_volume" and select the volume mesh in the scope selector (Figure 6.10)
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Figure 6.9: Add a new domain using the right-click menu of Domains

Figure 6.10: Select the volume mesh in the scope selector

• Create a Domain for the inlet surface. Domain name: inlet_surface;
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• Create a Domain for the exterior surface. Domain name: exterior_surface.

The resulting Topology tree is shown in Figure 6.11.

Figure 6.11: Topology tree after Domain creations

6.3.6 Create material

In order to model the acoustic propagation in the air medium, the user needs
to create a fluid material. A material is created via the right-click menu of the
Materials tree.

• Right-click on the "Materials" item and choose "Add Material..." in the contextual
menu, then choose "Fluid Material" (Figure 6.12);

• In the popup property window of the fluid material, enter the material properties
of air. The user can use the default value for each property, using the green icon
(Figure 6.13).
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Figure 6.12: Add a new fluid material

Figure 6.13: Edit the properties of the material

Remark: One can also import the air material from a material library. See Import
material for more information.

6.3.7 Create a Finite Fluid component

In order to model the horn volume, the user needs to create a Component. A
component can be created in the Components node of the analysis.

• Right click on the "Components" item and choose "Add Component..." in the
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contextual menu, then choose "Finite Fluid" (Figure 6.14);

• In the popup property window of the component, select the previously created fluid
material and select the "horn_volume" domain in the scope selector ( Figure 6.15).

Figure 6.14: Create a Finite Fluid Component

Figure 6.15: Edit the Finite Fluid Component

6.3.8 Create an Infinite Fluid component

In order to model the acoustic radiation in free field, the user needs to create an
infinite fluid component. The infinite fluid component will be associated with
the exterior surface mesh (the half ellipsoid).
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• Right-click on the "Components" item and choose "Add new Component" in the
contextual menu, then choose "Infinite Fluid";

• In the popup property window of the infinite fluid component:

– Select the fluid material created previously

– Edit the properties of the infinite component: specify an interpolation order
"5"

– Enter the center and the axes of the infinite domain ellipsoid,

– Check the "Visible in viewports" box to visualize the ellipsoid,

– Select the "exterior_surface" in the scope selector (Figure 6.16);

• Un-check the "Visible in viewports" box and close the window.

Figure 6.16: Edit the Infinite Fluid Component

6.3.9 Create the excitation

The horn inlet is excited by an acoustic acceleration. For this purpose, the user
needs to create an acceleration boundary condition.
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• Right-click on the "Boundary Conditions" item and choose "Add BC..." in the
contextual menu, then choose "Acceleration";

• In the popup property window of the acceleration BC, enter the BC field value "1",
and select the "inlet_surface" in the scope selector. (Figure 6.17).

Figure 6.17: Edit the Acceleration Boundary Condition

6.3.10 Add the output requests

Three types of results can be produced by Actran:

• Output FRF: output of Frequency Response Functions. This is the evolution
of a specific result (acoustic pressure, acoustic intensity, etc.) with respect
to the frequencies;

• Output Map: output of color map on the finite element mesh. This is a
visualization of a result quantity everywhere in the computational domain
for particular frequencies;
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• Output Field Map: output of color map on a post-processing mesh that is
different from the Actran finite element mesh.

• Right-click on the "PostProcessing" item of the analysis and choose "Add Output
FRF" in the contextual menu. In the popup property window, enter the Output
filename (the filename’s extension is PLT):

horn.plt

If one is interested in knowing the sound pressure level at specific locations,
virtual microphones (called Field Points) should be defined in the Toolbox (below
the Render window). In this example, the user will create two arcs of field
points in far field (Figure 6.18), outside the finite element region, in order to plot
directivity curves.

Figure 6.18: Two arcs of field points in the far field

• In the Toolbox, access to "Mesh" → "Meshing Tools" → "Points" → "Polar";
enter the parameters shown in Figure 6.19 and choose click "Create..."→ "Field
Points"

54



A Guided Example - Horn Model

Figure 6.19: Create first series of field points

A new topology containing the field points is created. In this topology a PID
Domain and a Domain are automatically created. The Domain is placed in the
field point’s scope under the Output FRF in the analysis (Figure 6.20)

Figure 6.20: Field points created in Topology and associated with the Output FRF

A second set of field points needs to be created.
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• In the Toolbox, access to "Mesh" → "Meshing Tools" → "Points" → "Polar";
enter the parameters shown in Figure 6.21;

• Select the field point topology created for the first series of field points; and click
"Create..."→ "Field Points".

Figure 6.21: Create second series of field points

This second set of field points is created in the same topology as the first set.
Under the Output FRF, a second field point is created.

Next, the user needs to create the Output Map request.

• Right-click on "PostProcessing" item and choose "Add Output Map" in the
contextual menu (see Figure 6.22);

• In the popup property window, edit the parameters as shown in Figure 6.23)
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Figure 6.22: Create Output Map request
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Figure 6.23: Edit the parameters of Output Map request

In order to produce color map on a post-processing mesh outside the finite ele-
ment mesh, the user needs to add an Output Field Map under the PostProcessing
node. For this purpose, a field mesh should be created (Figure 6.24).
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Figure 6.24: Mesh supporting the field map

• In the Toolbox → Mesh → Meshing Tools → Structured Mesh, create the first
plane of field mesh (Figure 6.25);

• Create the second plane of field mesh (Figure 6.26)

Figure 6.25: Create the first plane of field mesh
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Figure 6.26: Create the second plane of field mesh

• Right-click on new topology item and choose "Auto create domains" in the contex-
tual menu;

• Right-click on "PostProcessing" item and choose "Add Field Map" in the contextual
menu;

• In the popup property window, edit the properties (Figure 6.27).
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Figure 6.27: Edit the properties of the Field Map
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6.3.11 Add solvers

Next, an algebraic solver needs to be selected. In this example, the Krylov solver
is used. This Krylov solver will use the MUMPS solver as an internal sub-solver.
For more information about the solvers, please refer to the Actran User’s Guide,
Chapter 6 of Volume 1.

• Right-click on the Solver and add a Krylov solver (Figure 6.28);

• Right-click on the created Krylov solver and add a MUMPS sub-solver (Fig-
ure 6.29);

The resulting solver tree is shown in Figure 6.30.

Figure 6.28: Select the Krylov solver

62



A Guided Example - Horn Model

Figure 6.29: Select MUMPS as the sub-solver

Figure 6.30: The resulting solver tree, with a Krylov solver and a MUMPS sub-solver

6.3.12 Export analysis

Once the complete model is built in ActranVI, the following step is to export
the analysis into an Actran input file.

• Right-click on the Direct Frequency Response, choose Export analysis (EDAT
format), as shown in Figure 6.31;

• In the popup window, select the ACTRAN output format for the Topology, as
shown in Figure 6.32;

• Name the exported analysis "horn.edat".
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Figure 6.31: Export the analysis in EDAT format

Figure 6.32: Choose ACTRAN format for the Topology export

6.4 Launch the computation

The computation can be started using the Actran launcher (Figure 6.33). Refer
to Chapter 5 on how to start the Actran launcher.
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• When starting the Actran launcher, choose the model file "horn.edat" ;

• Edit the Command line options as it is shown in Figure 6.33 and click on the arrow
to run the command.

Figure 6.33: Launch the analysis model using the Actran launcher

6.5 Post-processing

The computation produces three results files/folders:

• horn.plt: a text file containing frequency response functions of global and
local indicators. For more information about the PLT file, please refer to the
Actran User’s Guide, Section 12.5 of Volume 1;

• horn.nff: a folder containing the finite element mesh used in the computa-
tional domain and the color maps (NFF database);

• horn_field_map.nff: a folder containing the field mesh and the associated
color maps.

6.5.1 Plotting the FRF’s and directivity curves in PLTViewer

In this section, one will plot the frequency response functions (FRF’s) and direc-
tivity curves using the PLTViewer. The PLTViewer is the dedicated utility to
post-process and visualize the frequency response functions produced and stored
in the PLT files by Actran . Refer to Chapter 16 for more information on the
PLTViewer.

• Start PLTViewer. Refer to Chapter 5
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• Open the "horn.plt" result file in PLTViewer (Figure 6.34).

Figure 6.34: Import the PLT result file into PLTViewer

The imported PLT file is shown in the upper left window, as shown in Figure 6.35.

Figure 6.35: PLT results shown in the PLTViewer as data tree

Results calculated on the two arcs of field points are stored in "POINT_1" and
"POINT_2".

• Plot the FRF of the acoustic pressure (dB) on point 10 in the first set of field points
(Figure 6.36);
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• Edit the properties of the curve in the Figure properties window and in the curve
properties (Figure 6.37 and Figure 6.38).

Figure 6.36: Plot the FRF of pressure in dB
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Figure 6.37: Edit the figure properties

Figure 6.38: Edit the curve properties

The resulting curve is shown in Figure 6.39.
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Figure 6.39: The FRF curve of pressure in dB

The next step aims at plotting the directivity curves of the pressure along different
arcs of microphones at 2000Hz.

• Create a new figure window via the menu (Figure 6.40);

• Re-organize the PLT results in the data tree: Add a reverse set of the results
(Figure 6.41).

Figure 6.40: Create a new figure window

Figure 6.41: Add a reverse set of the PLT results
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The reversed set of results is shown in Figure 6.42.

Figure 6.42: Reversed set of the PLT results

• In the reversed set, in the first series of field points, plot the pressure in dB for all
the points at 2000Hz (Figure 6.43);

• In the second series of field points, plot the sound pressure level (SPL) in dB for all
the points at 2000Hz. The resulting curves are shown in Figure 6.44.

Figure 6.43: Plot the SPL directivity at 2000Hz
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Figure 6.44: Directivity curves of pressure at 2000Hz

The directivity curves can be plotted in polar representation.

• Select "Polar" in the figure properties window (Figure 6.45);

• Edit the functions of both directivity curves, in order to reflect the real angle of the
series of the field points, as described in Figure 6.46. Click on Plot/Update after
function edition.

The resulting directivity curves are shown in Figure 6.47.

71



A Guided Example - Horn Model

Figure 6.45: Polar representation for directivity curves

Figure 6.46: Edit the function of the directivity curves
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Figure 6.47: Directivity curves of pressure at 2000Hz shown in polar representation

6.5.2 Color maps on the horn model mesh

The results for plotting the color maps are stored in the NFF databases. In
this example, the databases are named "horn.nff" and "horn_field_map.nff" (see
Figure 6.23 and Figure 6.27). The "horn.nff" contains results on the acoustic
computational domain. The "horn_field_map.nff" contains results on the post-
processing mesh.

First, import the results from the "horn.nff".

• In ActranVI, import the "horn.nff" via the menu File→ Import mesh→ NFF
and select "Display Mesh"

The mesh is imported as a Topology under the Topologies tree in the Data tree
panel.

• Turn off the visibility of all the topologies except the lastly imported "horn.nff"
(Figure 6.48)
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Figure 6.48: Import the horn.nff database and turn off the visibility of all other topologies

The next step is to import the results contained in the NFF database. This is done
in the Toolbox.

• In the Toolbox, Import results tab, select the topology corresponding to the horn.nff
and select the Pressure quantity to import, as shown in Figure 6.49;

• Left-click on the Import Selection.

Figure 6.49: Import the pressure results from the horn.nff database

Next, plot the pressure map in the Display results tab in the Toolbox.

• In the Display results tab, the quantity "PRESSURE" is automatically selected (as
the last one imported) in the Quantity field (Figure 6.50);
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• Left-click on Apply, the real part of the pressure is plotted in the Render window
(Figure 6.51).

Figure 6.50: Plot the pressure results in color map

Figure 6.51: The pressure results plotted in the Render window

The result is displayed by default at the first available frequency. In order to
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change the frequency, the user can adjust the parameters on the right side of the
Toolbox (Figure 6.52).

Figure 6.52: Change the frequency of the visualized result

The range for the visualized quantity can also be adjusted. This is done in the
Properties tab. Figure 6.53 illustrates the steps to change the range of the pressure
results.

Figure 6.53: Change the range of the visualized result

Besides the visualization of the results on the model’s exterior surface, one can
also visualize the results in the interior of the domain, using the "Cut Planes".

• Add a cut-plane in the Cutplane tab (Figure 6.54).
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Figure 6.54: Create a cut-plane on the map result

As a cut-plane is added, the map visualized in the render window is on a flat
2D surface inside the computation domain. In the Properties tab, the cut-plane’s
position can be adjusted, together with its other properties.

• Change normal direction of the cut-plane from the X axis to the Y axis (Figure 6.55).

Figure 6.55: Change the properties of the cut-plane

The resulting map is shown in Figure 6.56.
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Figure 6.56: Result shown on a cut-plane

Several cut planes can be successively added to the visualization.

• In Cutplane tab, add another cut-plane. Use the default properties for this second
cut-plane

The resulting map is shown in Figure 6.57.
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Figure 6.57: Result shown on two cut-planes

6.5.3 Color maps in far field

The results in far field (in the field map) are stored in the "horn_field_map.nff"
database. The results can be imported and added to the current visualization.

• Import the "horn_field_map.nff" via the menu File→ Import mesh→ NFF;

• In the Toolbox→ Import results tab, import the pressure results on the field mesh
(Figure 6.58).
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Figure 6.58: Import pressure results on the field mesh

When plotting the pressure result on the field mesh, the topology of the field
mesh should be specified, as illustrated by Figure 6.59.

• Plot the pressure results on the field mesh. (Figure 6.59)

Figure 6.59: Plot the pressure results on the field mesh

Remark: If the user did not specify the topology of the field mesh, the pressure
results will be plotted on all topologies where the pressure results have been
imported.

The resulting map is shown in Figure 6.60.
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Figure 6.60: Pressure result on the field mesh

The results visualized in the render window can be saved in an image file:

Menu→ File→ Export Image
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Seven

ActranVI Unified Interface

7.1 Introduction

The three pre-processing and post-processing tools available in Actran (namely
ActranVI, PLTViewer & WATERFALLViewer) can be accessed from a single
graphical user interface ("GUI") window. This main window consists of two
different parts : the applications notebook part and the info frame / console part.
Figure 7.1 shows the unified graphical user interface.

Figure 7.1: The unified user interface
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The user is able to resize these two parts by left-clicking on the horizontal
separation bar and moving the mouse to the new desired position.

7.2 The applications notebook panel

In the applications notebook part, each tool (namely, ActranVI, PLTViewer

and WATERFALLViewer) can be opened in a separate tab, allowing the user to
quickly switch from one tool to the other by left-clicking on the corresponding
tab or by using the combination of <Ctrl+Tab> or <Ctrl+Shift+Tab> buttons to
move between tabs in a downwards or upwards fashion respectively. Each tab
is entitled with the name of the tool it contains. Only one instance of each tool
can be opened in the main window, so there can be at most three tool tabs in
this window, corresponding to ActranVI, PLTViewer and WATERFALLViewer

simultaneously opened. The user can however open as many unified interface
windows as he wants, exactly as the previous Actran releases allowed to open
any number of ActranVI, PLTViewer or WATERFALLViewer windows.

Most of the time, the user has two types of results he wants to post-process
with the Actran graphical user tools : FRF (frequency response function) results
in the form of a plt (or txt) file (PLTViewer and/or WATERFALLViewer), and
color map results in the form of any output format available in Actran (NFF,
OP2, ...) (ActranVI). For results analysis purposes, the user should want to
compare these two types of results in an easy and convenient way. The user can
detach each tab from the current window by left double-clicking on the tab. The
detached window can then be put side-by-side with the original window. The
tab can be re-inserted to the applications notebook panel by closing the detached
tab using the X at the top-right corner.

7.3 The Console/InfoFrame panel

The second part of the main interface window is the info frame / console
part. This part is common to all tabbed applications opened in the applications
notebook part. It consists of the Console widget and the InfoFrame widget. The
Console widget is where all the API commands (corresponding to the actions that
are performed by the user in the graphical user interface) are dumped, and the
InfoFrame is a container for all the user, warning, and error messages. All the API
commands coming either from ActranVI, PLTViewer or WATERFALLViewer

are dumped in this unified Console widget. In the same way, all the messages to
the user, produced by any of the opened tool, are written in the unified InfoFrame
widget. The user has the possibility to resize the Console/InfoFrame as he wants
using the vertical separation bar between the two widgets. A keyboard shortcut
is available to quickly hide/show the Console/InfoFrame panel : <Ctrl+t>. The
Console and InfoFrame widgets can also be displayed in full-screen mode by
clicking on the dedicated tabs that are located at the applications notebook panel.
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ActranVI Menu

The main menu bar is located at the top of the ActranVI application. Different
menus are available:

• File;

• View;

• Add;

• Tools;

• Utilities;

• Window;

• Wizards;

• Help.

Click here to see a video example.

8.1 "File" menu

Figure 8.1 shows the functions that can be accessed through the File menu.

87



ActranVI Menu

Figure 8.1: File menu in ActranVI

8.1.1 Load Actran project

The "Load Actran project" function imports an Actran project into ActranVI.
Only projects created with the same version of ActranVI can be loaded.

8.1.2 Save Actran project

The "Save Actran project" function exports the current Actran project into an
.apf file. This function is useful when the user wants to save their progress while
the analysis is not yet complete.

8.1.3 Load session

The "Load Session" function imports and executes an ActranVI session. Two
options are available:

• Automatic import file(s): all files referred in the session script are imported
automatically (e.g. the import of a mesh file);

• Interactive import file(s): all files referred in the session script are not
imported automatically. The application prompts the user to select the files.
Therefore the user can select different files than those referred in the session
script.
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8.1.4 Save session

The "Save Session" function exports the operations recorded as API commands in
an ASCII file (Chapter 29) since the current session of ActranVI has been started.
The format of the exported session can be .py or .sess.

More information related to sessions and to the API language of ActranVI can
be found in the section Console and in Chapters 27 and 29.

8.1.5 Import analysis

The "Import analysis" function is subdivided into four tabs:

• "Actran analysis" imports an Actran analysis and/or an Actran utility
analysis (iCFD, etc.).

Remark. The Flow mesh model cannot be imported through this
function, see section below.

• The "Nastran analysis" function imports an Nastran analysis. For more
information, please refer to Section 58.12 of Volume 1.

• The "Nastran OP2 PEM analysis" function imports an Nastran OP2 file
generated during the initialization of a PEM computation through Nastran

(Nastran 2013 or any release following this version is required). Please
refer to the Nastran Quick Reference guide for further details about the
PEM definition or contact the Hexagon Support.

• The "Flow Mesh analysis" function imports a Flow mesh model.

8.1.6 Import mesh

A large number of input mesh formats are supported by ActranVI. When a
mesh file is imported, a Topology is created.

It is also possible to import a CAD file directly in ActranVI. The supported format
are:

• CATIA_V5: *.CATPart, *.CATProduct

• *.igs

• Inventor: *.ipt

• SolidWorks: *.SLDPRT

• *.step
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• Parasolid: *.xt

When importing a CAD file, the user has the possibility to define the maximum
length of the elements and the maximum deviation in order to get the desired
mesh. Also, a CAD item will be created in the Topology datatree. From this
datatree, the user will be able to visualize the CAD structure organized in
assembly, sub-assemblies and entities. By right clicking on the assembly, it is
possible to remesh or stitch the entire CAD. In addition, new flexibility is added
by having the possibility to select multiple sub-assemblies or multiple entities to
be remeshed or stitched, without having to work on the entire CAD.

8.1.7 Import Recent Session files/analysis/mesh...

ActranVI keeps an history of the recent open/saved files. One can respectively
access a specific recent session, analysis or mesh straightly through the related
"Import Recent..." function.

8.1.8 Export image

The Export image function generates a screen shot of the render window and
save it as an image file. The supported image formats are: BMP, JPEG, PNG and
EPS.

8.1.9 Set working directory

This function sets the working directory for ActranVI. When clicked, a pop-up
appears (Figure 8.2).

Click here to see a video example.

The specification of the working directory is important when importing and/or
exporting an analysis file where references to other files are included.

Figure 8.2: Set working directory

When the user imports an analysis, the working directory is updated to
the directory containing the Actran input file. For analyses containing
INCLUDE_FILEINCLUDE_FILE keywords (refer to Actran User’s Guide Sec-
tion 2.10 of Volume 2), ActranVI locates the included files using the combination
of the working directory and their relative paths. This localization operation can
be automatically performed.
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8.1.10 Settings

In the Settings configuration panel, the user can configure the settings of
ActranVI. More information on settings can be found in Section 8.9.

8.1.11 Clear All

The "Clear All" function deletes all the following items in an ActranVI applica-
tion:

• Topologies;

• Materials;

• Tables;

• Analyses;

• Viewports;

• Results and results visualizations.

The session of the current ActranVI application is not cleared. Operations
after the "Clear All" in the same ActranVI application are recorded in the same
session file.

8.1.12 Exit ActranVI

Exit ActranVI.

8.2 "View" menu

Figure 8.3 shows the functions that can be accessed through the View menu.

Figure 8.3: View menu in ActranVI

8.2.1 Viewport

The following operations related to viewports can be accessed:
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• Add Viewport (new): Add a new empty viewport;

• Add Viewport (clone): Add a new viewport and copy the content of other
viewports into this new viewport (the visualisation is not copied, only the
topologies);

• Remove Viewport: Select a viewport to remove;

• Sync/unsync cameras: Switch between synchronized and unsynchronized
cameras of different viewports.

8.3 "Add" menu

Figure 8.4 shows the functions that can be accessed through the Add menu.

Figure 8.4: Add menu in ActranVI

8.3.1 Mesh

The "Add > boxpro topology" function creates a new Topology using the boxpro

formalism. This is powerful for box-like problems (Section 10.3.12).

The other functions in this sub-menu are direct links to the Mesh creation tab of
the Toolbox panel (Section 11.1).

8.3.2 Material

The "Add > Material" function creates a Material. Refer to Actran User’s Guide
Section 7.1 of Volume 2.

8.3.3 Table

The "Add > Table" function creates a Table. Refer to Actran User’s Guide
Section 11.30 of Volume 2.

8.3.4 Analysis

The "Add > Analysis" function creates an Actran Analysis.
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8.3.5 Utilities analysis

The "Add > Utilities" analysis function creates an Actran Utility analysis.

8.4 "Tools" menu

Figure 8.5 shows the functions that can be accessed through the Tools menu.

Figure 8.5: Tools menu in ActranVI

8.4.1 Wavelength Computation tool

This computational tool allows to compute the acoustic, bending or structural
analytical wavelengths for fluids, solids and porous materials. This tool allows
to quickly evaluate the required element size to model a particular frequency.
Figure 8.6 shows an example for the acoustic component.
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Figure 8.6: Wavelength computation utility

8.4.2 Fluxes Computation tool

This tool allows to compute the average and total flux on a PID domain and
the local, average and total flux flowing through the interface between two PID
domains. Table 8.1 shows the quantities computed by the Fluxes Computation
tool.
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Quantity identifier Quantity name
itf_* Interface flux: the flux through the in-

terface between 2 elements
total_itf_* Total interface flux: the total flux

through the interface between 2 PID
domains

avg_itf_* Average interface flux: the average flux
through the interface between 2 PID
domains

total_* Total domain flux: the total flux on a
domain

avg_* Average domain flux: the average flux
on a domain

Table 8.1: The results output by Fluxes Computation tool. * is the field name.

For the case of the vibrational intensity computed by the nas_postpro utility,
for example, all quantities are output as total value; divided into membrane,
bending and transverse shear or their combination. For PSOLID, only total value
is computed. The different components output for the vibrational intensity by
Fluxes Computation tool are then as listed in Table 8.2.

Component identifier Component name
* Total value
*_bend Bending
*_memb Membrane
*_trans_shear Transverse shear
*_bend_trans_shear Bending + transverse shear
*_memb_bend Membrane + bending
*_memb_trans_shear Membrane + transverse shear

Table 8.2: The components can be output for a quantity by Fluxes Computation tool. * is
the quantity identifier (see Table 8.1)

• total_flux The total flux on group of elements (grouped by PID) is
computed as the following equation:

total_ f lux = ∑i f luxi.Vi

Where:

– f luxi is the flux on element i
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– Vi is the volume of element i

• avg_flux The average flux on group of elements (grouped by PID) is
computed as the following equation:

avg_ f lux = ∑i f luxi ∗ (
Vi

∑i Vi
)

Where:

– f luxi is the flux on element i

– Vi is the volume of element i

• itf_flux The flux through the interface between two elements is computed
by averaging the flux f lux projected on the normal of the interface.

it f _ f lux =
f lux1.area1.~n + f lux2.area2.~n

area1 + area2

Where area1 and area2 are the cross areas of element 1 and element 2 at the
boundary. For example, for 2D elements:
area1 = inter f ace_length.thickness1
area2 = inter f ace_length.thickness2

Remarks:

– it f _ f lux is not computed if there are more than 2 neighboring ele-
ments at the interface.

– it f _ f lux is computed using only the f lux of the element which has
the dimension of the dimension of the interface +1.

• total_itf_flux The flux through the interface between two groups of
elements is computed by integrating the it f _ f lux over the interface
between 2 PID domains.

total_it f _ f lux = ∑i it f _ f luxi.areai

Where areai is the average cross area of 2 neighboring elements at interface
i. For example, for 2D elements:
areai = inter f ace_lengthi.(thicknessi1 + thicknessi2)/2

• avg_itf_flux The average flux through the interface between 2 groups of
elements is computed by dividing the total_it f _ f lux by the total area.
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avg_it f _ f lux =
total_it f _ f lux

∑i areai

Where areai is the average cross area of 2 neighboring elements at the
interface i.
The input files for flux computation by the Fluxes Computation tool of the
vibrational intensity computed by the nas_postpro utility, for example, are:

– the NFF database containing the vibrational intensity on elements
computed by the nas_postpro utility

– and the mesh file in any supported format. The element groups can
be created automatically based on number of elements by using the
Split function in the Meshing tool.

Figure 8.7 shows the procedure to compute the vibrational intensity in
Actran .

Figure 8.7: The procedure to compute the vibrational intensity

8.4.3 Nastran Post Processing tool

This tool allows to compute particular fields (e.g. vibrational intensity) from
Nastran outputs by the nas_postpro utility in ActranVI. Figure 8.8 shows an
example.
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Figure 8.8: Nastran Postprocessing Utility

Where:

• mesh.bdf the structure mesh stored in BDF format

• res.op2 the results stored in OP2 format

• output.nff is the name of the output file in Actran NFF format. If not
specified, the output NFF database will have the same radical name than the
OP2 Nastran results file

This tool is used to run the nas_postpro utility inside ActranVI, refer to Section
58.18 of Volume 1 for more information about its usage.

8.4.4 RPM Computation tool

This computational tool allows to compute Rotation per minute(RPM) and tread
passing frequency for a tire based on time period of revolution and tire size
information. This tool allows to quickly evaluate the RPM, number of treads and
tread passing frequency of a particular tire. Figure 8.9 shows an example of RPM
compuation tool.
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Figure 8.9: RPM computation tool

8.5 "Utilities" menu

Figure 8.10 shows the functions that can be accessed through the Utilities menu.

Figure 8.10: Utilities menu in ActranVI

8.5.1 PLT Viewer

Open a PLTViewer application in a new tab (Chapter 16).

8.5.2 Waterfall Viewer

Open a WATERFALLViewer application in a new tab (Chapter 22).

8.6 "Window" menu

Figure 8.11 shows the functions that can be accessed through the Window menu.
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Figure 8.11: Window menu in ActranVI

• Data tree: The Split function splits the Data tree panel into the main data
tree panel and the data tree sub-panel. The Merge function hides the data
tree sub-panel. Refer to Chapter 10 and Section 10.1.4;

• Toolbox panel: The Show and Hide functions respectively show and hide
the Toolbox panel (Chapter 11);

• Selection panel: The Show and Hide functions respectively show and hide
the Element Selection panel (Chapter 12);

• Mesh: Provides a direct access to the Mesh Tab of the Toolbox. Refer to
Section 11.1;

• Import results: This function is the link to the Import results tab in the
Toolbox. Refer to Section 11.2;

• Display results: The four functions (Visualization, Animation, Properties,
Cutplane) are the links to the corresponding tabs in Display results in the
Toolbox. Refer to Section 11.3;

• Run: The Run function is the link to the Run tab in the Toolbox. Refer to
Section 11.4;

8.7 "Wizards" Menu

Figure 8.12 shows the functions that can be accessed through the Wizards menu.
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Figure 8.12: Wizards menu in ActranVI

8.7.1 Diffuse Sound Field Wizard

The Diffuse Sound Field wizard provides a clearly defined, 5-step process that
allows the user to create and run a Direct Frequency Response using the Diffuse
Sound Field Boundary Condition in Actran . All the components needed for the
analysis are created automatically by the wizard based on the user’s inputs. At
the end of the wizard, the user may directly run the analysis. When the wizard is
closed, the user is given the possibility to save or discard the analysis. By saving
the analysis, the user can later perform additional manual operations. If the user
chooses to discard the analysis created by the wizard, the analysis is deleted.

8.7.2 Acoustic Radiation Wizard

The Acoustic Radiation wizard provides a clearly defined, 5-step process that
allows the user to create an Acoustic Radiation Analysis and works in an identical
way as the Diffuse Sounds Field wizard. The wizard is further subdivided into
three different parts where each corresponds to a different type of analysis:

• The Frequency Acoustic Radiation wizard creates a direct frequency re-
sponse.

• The Time Acoustic Radiation wizard creates a time domain analysis.

• The Green Acoustic Radiation wizard creates a Green analysis.

8.7.3 EA damping Optimization Wizard

The EA damping optimization wizard provides a process to generate an optimiza-
tion script to identify the patches on which it is optimal to apply damping pads.
It generates an EA Analysis excited by a diffuse sound field with the localisation
of the surface to be optimized. An optimization script is generated and can be
run inside ActranVI to obtain to best patches to be treated. These patches can be
visualized inside ActranVI and the corresponding squared normal velocity of
the untreated, fully treated and optimally treated configuration can be visualized
inside the PLTViewer.
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8.7.4 SEA model building from TL data Wizard

The SEA model building from TL data wizard provides a clearly defined 6-step
process that allows the user to create a functional SEA model of cavity subsystems.
Those subsystems will be linked and/or excited by panels, which are defined
by their Transmission Loss (TL) and absorption coefficient data. The Coupling
Loss Factor (CLF) between two cavities is computed from the TL value of the
panel linking them, and the Damping Loss Factor (DLF) of a single cavity is
computed from the absorption coefficients of all its neihboring panels. The model
can be loaded either by injecting a power in a cavity subsystem, or by specifying
squared pressures on exterior panels. Energetic results in each cavity subsystem
are produced and can be vizualized inside PLTViewer.

8.8 "Help" menu

Figure 8.13 shows the functions that can be accessed through the Help menu.

Figure 8.13: Help menu in ActranVI

8.8.1 Users Guides

The user can access to the User’s Guide of Actran and the User’s Guide of
ActranVI.

8.8.2 Actran API

The user can access the documentation of the Actran API.

8.8.3 Open Global Information file

Allows to open a global information file generated during an Actran compu-
tation. More information on this file can be found in Section 12.2.4 of Volume
1.

8.8.4 Controls

This provides a description of the different mouse and keyboard shortcuts in the
Render window. Please refer to Chapter 9 for more detailed descriptions.
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8.8.5 About...

Information related to the ActranVI application and to the computer’s environ-
ment.
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8.9 Settings

The settings of the ActranVI application can be modified in a window accessible
through the File menu. Note that changing some settings may require a restart of
the application before they are properly taken into account.

8.9.1 General

Figure 8.14 shows the General tab of the ActranVI Settings. Additional informa-
tion on some of these options is given below.

Figure 8.14: ActranVI Settings: General

Units

• The "Default unit system" setting determines the length unit of the visu-
alization in ActranVI, and is used as a default value to initialize the unit
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system of analyses, topologies, materials and tables when no information is
available. More detailed information can be found in Chapter 14.

• The checkbox "Display units" (checked by default) activates the display
of units within ActranVI, in particular the units of any property with a
physical dimension in the property windows.

• The checkbox "Display unit system warning" (checked by default) activates
the display of a warning message when importing an analysis without a
unit system definition. The message states that the analysis unit system
will be initialized following the "Default unit system" setting. The user can
disable this warning at any time, either from the settings or directly from
the warning window.

Session:

• Overwrite session: when this box is checked, the automatically saved
session file of an ActranVI application overwrites the previous session
file. This session file is stored in the directory from which ActranVI is
launched. On Windows platforms, an ActranVI application launched via
the Start menu is launched in its "Start in" directory. This "Start in" directory
can be found in the Properties of the ActranVI application link in the
Windows Start menu, shown in Figure 8.15.
User should avoid working with more than one ActranVI applications
while this option is checked. By default, this option is not checked;

• Save all camera positions: when this option is checked, all changes of
camera positions are saved in the session file. When un-checked, camera
positions are saved only before exporting an image, exporting a session or
launching an animation in Display results tab. By default, this option is not
checked;

• Expand import analysis commands: allows selecting a short or long descrip-
tion of the input of an analysis. By default the "Short" format is selected;

• Use relative path when writing the session file: Path to imported or exported
files are written in the session file using relative path instead of absolute
path by default.

• Ask for confirmation: Allows to put or remove popup windows associated
to checks occurring when performing various operations in the graphical
user interface.

• Use working directory as default in filechoosers: When activated, the
filechoosers windows (e.g. Import Mesh, Import Analysis) is opened in the
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Figure 8.15: ActranVI "Start in" directory in Windows

current working directory and not in the directory where the last file was
imported.

• User scripts directory: When a directory is specified, an additional "User’s
scripts" menu appears in PLTViewer. From this menu, all Python (.py) and
session (.sess) files located in the specified directory can be run.

• Material library database: the user can select, remove and backup the
material library database folder;

• Splashscreen: Allows to display or hide the splashcreen at application
startup.

8.9.2 Topology

Figure 8.16 shows the Topology tab of the ActranVI Settings. Additional infor-
mation on some of these options is given below.
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Figure 8.16: ActranVI Settings: Topology

• The option "BDF format: when exporting a BDF mesh, only use large
format", when selected, will output BDF files in large format. Exporting in
large format may be necessary (large node or element numbering) but will
create larger files.

• The option "NFF Format: use compact format for exporting an nff database
mesh", when selected, the exported NFF files will be output in compact
format, allowing to output smaller files.

• The NFF format can be compressed further in order to save space. By
default, no compression is applied. The user can apply the desired level
of compression by specifying it on a scale from 1 to 9, with one being the
fastest possible and 9 being the best possible.

• The option "Check for duplicated nodes before export" activates the check

107



ActranVI Menu

in the exported analysis or mesh of nodes separated by a smaller distance
than the specified topology tolerance.

• boxpro topologies are exported by default to the Actran input file. Two
options are available: boxpro format (refer to Section 10.3.12 and to Actran

User’s Guide Section 5.6 of Volume 2) and Actran mesh format.

• File topologies default export format: specifies how the File topologies are
exported by default to the Actran input file. Two options are available:
File format (refer to Section 10.3.6 and to Actran User’s Guide Section 5.6
of Volume 2) and Actran mesh format.

• Import mesh options: if set to "Ask all options", when loading a mesh
file, a dialog box appears with options specific to the mesh format of the
imported mesh. There is a common option to all mesh format : "Display
mesh", which allows the user to display the mesh or postpone this display.
If the "Import mesh options" is set to "Display mesh (use default for other
options)"/"Don’t load mesh (use default for other options)", then the dialog
box does not appear, the "Display mesh" option is on/off so the mesh is
displayed/not displayed. In both cases, all others options specific to the
imported mesh format are set to their default value.

• Visualization, Domain default color: this option sets the default color of
any PID Domain when it is imported or created in ActranVI. Refer to the
Section data tree visibility (Section 10.1.1) for more information.

• Performance, Create topological interfaces only when needed: when this
option is checked, the topological interfaces construction is performed only
when necessary. When checked, this option improves the performance of
ActranVI.

• CDB format: do not create volumes when reading CMBLOCK entries.
When this option is selected, the CDB input driver does not create volume
elements for CMBLOCK entries. The users can then use the CMBLOCK
block for supporting the boundary conditions.

8.9.3 Display

Figure 8.17 shows the Display tab of the ActranVI Settings.
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Figure 8.17: ActranVI Settings: Display

• The Layout options configure the start-up layout of the application;

• The Render window colors set the default colors of the render window
together with the text color in the window;

• The Rendering options set the default rendering methods. When Parallel
Projection method is unselected, the projection method is switched to
Isometric projection. The Reset Camera Clipping option, when selected,
resets the render window camera after each mesh operation;

• The Size of Sources in Viewport option allows to assess a global scaling
factor for the visualization of spherical, cylindrical and planar sources

• The Point thickness in pixels option allows modifying the rendering size of
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0D elements, shown as points. The larger the size, the larger the visualiza-
tion sphere is.

• View boundary conditions activates the visualization of boundary con-
ditions (point load, point moment, displacement and rotation) when an
analysis is loaded;

• View beam geometry and offset activates the visualization of beam proper-
ties when an analysis containing beam components is loaded.

8.9.4 Post Processing

Figure 8.18 shows the Post Processing tab of the ActranVI Settings. Additional
information on some of these options is given below.
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Figure 8.18: ActranVI Settings: Post Processing

• Reference value for dB pressure: user can specify a reference value to plot
pressure color maps in dB;

• Reference value for dB power: user can specify a reference value to plot
power color maps in dB;

• Reference value for dB intensity: user can specify a reference value to plot
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intensity color maps in dB;

• Multiplier value for dB: user can specify a multiplier value to plot a color
map in dB. This can be used to deal with quadratic values;

• The formulation of the dB operator used in ActranVI is:
Multiplier log value2

value2
reference

;

• Other configurations in the Post Processing tab set the default settings for
the results visualization. More information can be found in the section View
results.

8.9.5 Applications

Figure 8.19 shows the Applications tab of the ActranVI Settings.

Figure 8.19: ActranVI Settings: Applications

• Autostart PLTViewer : start automatically the PLTViewer with ActranVI;

• Autostart WaterfallViewer : start automatically the WATERFALLViewer

with ActranVI.

8.9.6 Devices

Figure 8.20 shows the Devices tab of the ActranVI Settings.
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Figure 8.20: ActranVI Settings: Devices

• Mouse settings : the mouse buttons can be remapped

8.9.7 Remarks and Further Reading

• The user needs to restart the ActranVI application in order to apply the
changes in the Settings;

• All the setting options have default values. These default values can be
restored by clicking on the green icons on the line of the option;

• Avoid changing background colors in presence of mesh loaded in
ActranVI, as this may take a long time for the window to refresh.
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ActranVI Render Window

The render window (Figure 9.1) is the window in which the model is displayed.

Figure 9.1: Render window of ActranVI

The render window contains one or multiple viewports.
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The background color and the color of the text in the render window can be
edited in the settings.

9.1 Mouse and Keyboard Render Window Controls

The different view, selection, tree, console mouse and keyboard controls are listed
in the Controls Information that can be displayed from ActranVI Help menu.

Figure 9.2: Controls of ActranVIRender Window

9.2 Render Window Controls

The various icons placed at the bottom right of the render window represent
various shortcuts to ease the visualization. They contain user-customized views
(right hand sided buttons) and predefined views perpendicular and ISO views.
Specific camera settings (zoom, angle of view and position) can also be saved
within Custom Views. Other Visualization tools are also available, such as the 90
degree rotating command and a zoom extend feature.

Figure 9.3: Render window controls
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9.3 Viewport

The render window is controlled by the different viewports, which define the
content to be visualized.

Figure 9.4 shows an example of 4 different viewports in the render window.

Figure 9.4: An example of four viewports in ActranVI

The viewports parameters can be shown in the visual sub-tree of the data tree
panel (Figure 9.5). Refer to Section 10.8 for more information on the Visual tree.
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Figure 9.5: Viewport shown in data tree

The visual tree is hidden by default in ActranVI. It can be shown by changing
the default option in the settings (Display tab).

9.3.1 Viewport control

Below the render window, the viewport control bar (Figure 9.6) is used to perform
the following operations (ordered according to the position of the buttons from
left to right in the control bar):

• Enable/disable the display of only the first viewport;

• Add a new viewport;

• Add a clone viewport;

• Remove an existing viewport;

• Synchronize/desynchronize the camera views of all the different viewports;

• Export viewport to image;

• Copy the viewport to clipboard;

• Enable/disable viewport fast rendering.

Figure 9.6: Viewport control bar
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9.3.2 Viewport configuration

Each viewport is characterized by its own properties, which can be accessed by
right-clicking on the viewport in the visual tree. The viewport properties window
is shown in Figure 9.7.

Figure 9.7: Viewport options.

The visibility, the position and the size of the viewport can be edited. By adjusting
the positioning bars, different viewports can also overlap each other. The three
dimensions along X, Y and Z axes of the model contained within the viewport
can be visualized and edited. The color of the text shown in a viewport can also
be changed.

When the Parallel projection option is ticked off, the Isometric perspective is
activated.

Figure 9.8 shows the two different perspective views on the same mesh in
ActranVI.
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Figure 9.8: Parallel perspective and Isometric perspective in ActranVI

9.3.3 Viewport contents

When a mesh is imported or created in ActranVI application where multiple
viewports are present, a pop-up appears to select the viewport(s) where the mesh
should be displayed. This is shown in Figure 9.9. In the pop-up window, the user
can also create a new viewport to place the mesh.

Figure 9.9: Selection viewport(s) to contain mesh

A PID or a Domain can be displayed in a viewport via the drag’n’drop operation.
Figure 9.10 shows the drag’n’drop operation to display a PID in a viewport.
Figure 9.11 shows the drag’n’drop operation to display a Domain in a viewport.
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Figure 9.10: Associate a PID with a viewport via drag’n’drop

Figure 9.11: Associate a Domain with a viewport via drag’n’drop

In order to remove a PID or a Domain from a viewport, one can select the item to
be removed from a specific viewport in the visual tree and use the Delete key or
the Remove function in the right click menu (Figure 9.12).
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Figure 9.12: Remove a PID form a viewport

9.3.4 Exploded View

The exploded view function allows to visualize all element sets of the viewport
separetely. The exploded view is creating by translating the element sets in the
following way: the distance from the point defined by the Origin parameter and
an element set is projected on each global axis and multiplied by the scale factor
corresponding to this axis. Furthermore, the "Group by domain" option allows to
create an exploded view relative to the domains instead of the elements sets.

9.4 Remarks and Further Reading

• The maximum number of viewports supported in ActranVI is 4;

• The cameras of different viewports can be synchronized individually in the
Visual tree (refer to Section 10.8.1).
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ActranVI Data Trees

The data tree panel is the left part of the ActranVI interface (Figure 10.1).The
data tree panel is made of five main trees:

• Topologies tree;

• Material tree;

• Table tree;

• Analysis tree;

• Visual tree.

The optional trees are not shown by default. They can be activated via the
settings.
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Figure 10.1: The Date Tree Panel in ActranVI

10.1 Data Tree Node

A data tree node (or item) is represented as a line in the data tree panel. It can be
a topology, a material, an analysis, or a flow field under a finite fluid component,
etc. A node can contain several levels of children nodes. Figure 10.2 shows an
example of the data tree nodes.
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Figure 10.2: The date tree nodes

10.1.1 Data Tree Node Visibility

A set of three icons appears on the left side of any node that may be displayed
in the render window (Figure 10.3). Clicking on the first icon modifies the
transparency of the related finite elements which changes from semi-transparent
(default, icon’s color is light-blue) to opaque (icon turns dark-blue) to fully-
transparent or hidden (icon turns white) then back to semi-transparent. The
transparency state is applied to the selected data tree node but also to all related
nodes. Right-clicking on it will allow to directly set the transparency state and
set the opacity value..
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The second graphical icon controls the display of the element edges. Clicking on
this icon will cycle between three options: surface only, wireframe only, surface
and wireframe. Right-clicking will allow to directly set the option.

The third graphical icon may be used to change the color of the related objects.

Figure 10.3: Graphical icons controlling the display of any node of a graph

Figure 10.4: Graphical icons options

Figure 10.5: Use of the graphical icons options

Click here to see a video example.

10.1.2 Data Tree Node Right Click Menu

Right-clicking on a data tree draws a menu. The menu shows all the func-
tions/operations related to this node (Figure 10.6). The most commonly used
functions/operations are:

• Expand all: expand fully the node and all its children nodes;

• Collapse all: fold fully the node;

• Remove: delete the node;
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• Duplicate: duplicate the node in its parent node;

• Properties...: access to the property window of the node.

Figure 10.6: Right click menu of a data tree node

The entire graphical tree can be expanded and collapsed at once by using the
shortcuts ’CTRL +’ and ’CTRL -’ respectively. The ’CTRL’ and ’+/-’ buttons need
to be pressed together after clicking on the graphical tree.

10.1.3 Data Tree Node Drag’n’Drop

Some of the data tree nodes can be drag-and-dropped to other data tree nodes.
The drag’n’drop can also be used to associate items located in different panels.
To drag’n’drop item 1 to item 2, the operation is performed using the mouse, in
three steps:

• left click on the item 1;

• hold the left button of the mouse while displacing item 1 towards item 2;

• release the left button when item 1 arrives over item 2

Figure 10.7 illustrates the drag’n’drop of a domain into the scope of a component.
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Figure 10.7: A drag’n’drop operation

Figure 10.8 illustrates the drag’n’drop of a coupling surface into a BC_MESH.

Figure 10.8: A drag’n’drop operation
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Click here to see a video example.

An alternative to the drag’n’drop is the Scope selector. Refer to Section 10.2.8 for
more information.

10.1.4 Data Tree Sub-Panel

The data tree sub-panel allows the user to focus on a particular data tree node. It
is a container for all the children data tree nodes of a selected data tree node.

The data tree sub-panel is a window below the main data tree panel. It is hidden
as ActranVI starts. In order to use this sub-panel, the user needs to use the
mouse to bring up the separation bar between the two panels (Figure 10.9).

Figure 10.9: Use mouse to show the data tree sub-panel

The user can then drag’n’drop a data tree node from the main data tree panel to
the sub-panel. When this is done, all the children of that node are shown in the
sub-panel. This is shown in Figure 10.10
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Figure 10.10: Use sub-panel to focus on a data tree node

As shown in Figure 10.10, the visualization of the same node in the main panel
and in the sub-panel can be different. The user can develop (unfold) the node in
the sub-panel while keeping the same node folded in the main panel.

The contents of the node in the two panels are always synchronized.

Click here to see a video example.

10.1.5 Remarks and Further Reading

• The drag’n’drop operation is not the only possibility to associate a domain
with the scope of a component. This can also be done via the scope selector
(Section 10.2.8);

• The drag’n’drop operation involving two non-associable items has no effect;

• The drag’n’drop operation can be performed between the main data tree
panel and the data tree sub-panel.
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10.2 Property Window

The property window shows all the properties related to a data tree node. To
access the property window, one can double left-click on the node, or right-click
and choose "Properties...", as shown in Figure 10.11.

Figure 10.11: Two methods to access to the property window of a data tree node

Figure 10.12: Example of a property window
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The property window can be edited. The data entered in the property window
are used to build the Actran analysis.

10.2.1 Mandatory data

The mandatory data entries required by the property window is marked by a *
sign. The optional entries are not marked by the star sign (Figure 10.13).

Figure 10.13: Mandatory and optional data entries

10.2.2 Help and default value

Place the mouse on the ? sign, a text appears to explain how to enter the data
value. Take the FLOW entry for example (Figure 10.14), the ? sign indicates that
the user must enter a real number or the AUTO keyword.

Figure 10.14: Help icon and Default value icon

Below are some complementary explanations on the ? sign text.

• A list: a set of values included between brackets. The values must be
separated by commas. The dimension of the list is the number of values in
the list. For example, a list of dimension 2 can be [2,5], a list of dimension 3
can be [1,1,10];

• A list (unbounded) of lists: this can be a single list or multiple lists separated
by commas. For example: [1,1,10], [16,2,40], [100],[200] is a list of four lists.
The four lists are of dimensions 3, 3, 1 and 1 respectively;

• A complex number is entered the following way: A+Bj , where A and B are
the real part and imaginary part of the complex number;
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• A Table + id entry: the data entered can refer to a TABLE. This is done
by entering, for example: TABLE 5, where 5 is the ID of the TABLE in the
ActranVI session

Next to the ? icon, a default value icon appears for all the data lines having a
default value. Click on this icon will set the default value for the data entry line.

10.2.3 Toggle down selection and child node creation/edition

Some lines of the property window are edited via the toggle down selection list
(Figure 10.15).

Figure 10.15: Toggle down selection

Sometimes the selected item becomes a child of the current data tree node. In this
case, two other icons appear on the right of the toggle down list (Figure 10.15).
The first icon is used to show/edit the property window of the selected item; the
second icon is used to create a new item.

10.2.4 Value and Field entry

Some data lines can be defined by a value or by a field (Figure 10.16). A value
is entered by the user. The value is defined without any spatial variation. The
field entry must refer to a pre-defined field. A field defines a spatial variation
of the quantity. Refer to the Actran User’s Guide Section 11.9 of Volume 2 for
more information on the usage of fields. The definition of field in ActranVI is
presented in Section 10.6.11.

Figure 10.16: Value/Field selection for a data entry line
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10.2.5 File chooser

A file chooser in a property window is used to select one or several files. An
example of file chooser is shown in Figure 10.17. The selected file(s) can be
exported in the main analysis file as INCLUDE_FILE(s) or RESULT_FILE(s).

Different methods are available to display and export the selected file(s):

• If the file chooser button is activated by left-click, the full path and the name
of the selected file are displayed. The path relative to the main analysis file
is exported in the Actran input file;

• If the file chooser is activated by right-click, only the file’s name is displayed
(not the path). Only the filename is exported in the Actran input file.

Figure 10.17: File chooser

10.2.6 Shortcut icons

The shortcut icons appear on the top of the property windows (Figure 10.18).
These shortcut icons carry the same functions as the functions in the right click
menu of a data tree node.
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Figure 10.18: Shortcut icons

Placing the mouse on the short icon, a short description of the function appears.

10.2.7 Add and remove a data line sub-entry

In some property windows, multiple entries of a same type can be defined.
Figure 10.19 shows these type of entries, indicated by a couple of "+" and "-" signs
or simply a "+" sign.

Figure 10.19: Entries relying on sub-entries

In order to add a sub-entry, the user should click on the "+" sign of the primary
entre. This is shown in Figure 10.20.

Figure 10.20: Add a sub-entries

In order to remove a sub-entry, the user should first select the sub-entry using
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mouse left click, and then remove the sub-entry using the "-" sign, as shown in
Figure 10.21.

Figure 10.21: Remove a sub-entries using "-" sign

In some properties windows, the "-" sign is not available for removing the entries.
In this case, one needs to use the Delete key after selecting the entry, as shown in
Figure 10.22.

Figure 10.22: Remove a sub-entries using Delete key

10.2.8 Scope Selector

In the data tree panel, to associate a data tree node with another data tree node
is a regular operation. Examples of such an operation are: associating a PID with
a domain, or associating a domain with a component, or in general associating
data tree node 1 with data tree node 2. When such an association is done by
putting node 1 into the scope of node 2, the scope selector of node 2 can be used
to facilitate the association.

The scope selector appears in the property window of a data tree node, as shown
in Figure 10.23.
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Figure 10.23: A scope selector in the property window of a component

A scope selector contains 4 parts, shown in Figure 10.24. These 4 parts are:

• Available items for the scope: all the entities acceptable by the scope are
listed;

• Selection check-box: check-box is used to select the desired items for the
scope;

• Dimension filter: visibility filter acting on the dimensions of the listed items
in the scope selector;

• Selection tools: the selection tools help to select/unselect one or multiple
items. During the selection, one can use the left mouse button and the Ctrl
key to choose multiple items in the scope selector. This is explained in
Figure 10.25.
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Figure 10.24: Four parts in a scope selector
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Figure 10.25: Selection tools of a scope selector

The selection in the scope selector of a data tree node is always synchronized
with the content in the scope of that node. This is shown in Figure 10.26.

Figure 10.26: Synchronization between the scope selector and the scope
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10.2.9 Remarks and Further Reading

• When a data tree node is created, its property window is popped-up.
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10.3 Topologies Tree

The Topologies tree is a container of all the topologies imported and/or created
in ActranVI. A topology contains:

• Information of the finite elements mesh;

• Information of the Actran Domains.

10.3.1 Topology import

In ActranVI, the user can import an external mesh file, an Actran .dat file or
an Actran .edat file. The import can be done through the menu.

File→ Import mesh ... → format

As the selected file is imported, the user can choose to load (or not) the mesh
through a popup window (Figure 10.27) and options related to the format.

Figure 10.27: Popup window for loading the mesh information

When the mesh is imported, it appears in ActranVI as a topology.

If the mesh is not loaded, only the reference to the imported mesh file is shown
in the topology property. The mesh is not displayed under the topology, nor in
the render window. In order to load the mesh, the user can use the right click
menu of the topology and select "Load", as shown in Figure 10.28.
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Figure 10.28: Load mesh of a topology

If the "Display mesh" option is selected at topology import. The full mesh
information is loaded in the topology. This is shown in Figure 10.29.

Figure 10.29: A topology in the data tree

As shown in Figure 10.29, a Topology has a Mesh node and a Domains node. The
different entities of the mesh are grouped together according to their PID. The
names of the PID Domain’s can be read from comments in a BDF mesh file or a
CDB mesh file depending on the meshing tools used to generate the files.

10.3.2 Creating topology

Some types of topologies can also be directly created in ActranVI. A new
topology can be creating when using the Meshing tools or when field points are
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created (Section 13.3.5).

10.3.3 PID domain

The PID domains (or simply PID’s) appear in the Mesh node of a Topology.
When a topology is imported from a mesh file (BDF file, CDB file, or UNV file,
etc.), the PID’s are automatically generated. A distinct PID is created for each
distinguishable part of the mesh, for example by "Property" in a .bdf file, or by
an "Element type" in a .cdb file.

Each PID has three attributes:

• Dimension: 0D, 1D, 2D or 3D;

• Interpolation order: linear or quadratic;

• PID number: alphanumerical characters.

The dimension and the PID number attributes cannot be modified. The interpola-
tion order can be modified using the re-interpolation function.

According to the three attributes, the PID’s can be organized in several ways.
The default organization method is to group the PID’s, first, based on their
dimensions, secondly, based on their interpolation level and finally based on their
PID numbers. Other organizations method can be selected using the right click
menu of the topology and choose Organize PIDs. This is shown in Figure 10.30.

Figure 10.30: Different options for organizing the PID’s
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A PID can be removed using the right click menu of the PID and the remove
function, or using the Delete key.

The "Auto create domain" function in the right click menu of a PID allows creating
a domain that contains this PID.

10.3.4 Domains

The Domains node of a topology is a container of all the domains. A domain
contains one or multiple PID’s. Figure 10.31 shows a topology with different
domains under it.

Figure 10.31: Different domains under a topology

In order to place the PID’s into a domain, the user can perform a drag’n’drop of
the PID’s into the domain, or use the scope selector of the domain to choose the
PID’s.

The "Add new domain" function in the right click menu of the Domains node
allows for creating a new empty domain.

The "Auto create domains" function in the right click menu of the Topology node
allows for creating one domain for each PID in the topology.

An "All" domain is always automatically defined under a topology. This domain
takes all the PID’s under the mesh node of the topology.

In the property window of a domain (Figure 10.32), its PID’s are shown as
selected items in the scope selector. If the domain is used in a component or in a
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boundary condition, the component or the boundary condition is indicated in
the "Used in" field.

Figure 10.32: Property window of a Domain

10.3.5 Fields and related operations

Each PID includes several fields. At least, it should include coordinate and
external node and element numbering. Additional fields can be included by
importing results from external result files or when importing an analysis. Fields
are characterized by their quantity type (which is referred to from the post-
processing), their realisations and their number of components (size of the results,
scalar or vector quantities), the number of values and the results interpolation
(linear, discontinuous, ...). Fields can be used both in pre-processing, to support
spatially-varying quantities or in post-processing to support results and allow
mathematical operations between results.

Figure 10.33 shows the different options that can be applied on fields.

• A Field Viewer can be added to the field to edit or post-process the field.
This is discussed in the next subsection.

• The field can be duplicated to perform mathematical operations. When
duplicating, its size, quantity type or even the default values of the field
can be modified. More information can be found in the next subsection.
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• The field and it’s supporting domain can be exported in a dedicated NFF
database.

• The field can be removed, except for coordinates or external numbering
fields.

• The reference to the field can be copied inside the console, or its content
printed inside the console as well.

• The properties of the field, describing its quantity type, number of realisa-
tions, components or values and the interpolation type can be accessed.

Figure 10.33: Available options for fields

Field duplication
To create new fields for pre- or post-processing, it is usually easier to duplicate
an existing field and its related characteristics. For post-processing for instance, a
new field can be made to perform mathematical operations (the difference of two
existing fields). The duplicate Field option allows to perform such operation, as
shown in Figure 10.34. The following options are available:

• The name and the quantity of the new field can be selected. By default,
the name of the existing field is chosen, followed by a _copy, and the
quantity is kept. When the quantity of the original field is COORDINATE or
EXTERNAL_NUMBERING, it is set to USER_DEFINED.

• The field properties such as the continuous or discontinuous shape, the
interpolation or the value type (integer, real or complex) can be chosen. If
the required operation is not valid, the new values will be set to 0.

• A default new Field Value can replace the existing values of the field by the
provided constant value. By default, the field values are duplicated.

146



ActranVI Data Trees

• The number of components and the number of realizations of the field can
be modified. In most cases, the original values will be replaced by 0.

• When a field quantity if present in multiple PIDs (a displacement field
imported over a complex structure for instance), the Duplicate All option
allows to duplicate all the fields having an identical quantity at once.

The obtained new field can be used for pre- or post-processing purposes. Editing a
particular field is then usually performed using the Actran API, in which a direct
access to the field quantities is provided using the regular python expression, as
shown in Figure 10.35. More information on the API support of the duplicate
field can be found in the API documentation.

Figure 10.34: Duplicating existing fields

Figure 10.35: Usage of additional fields for post-processing

Field edition and visualization
To visualize or locally modify a Field, the Field Viewer can be created. It can
directly be created on a Field as shown in the Field options in Figure 10.33. The
content of the Field Viewer is shown in Figure 10.36.

• The realization (frequency, time and loadcase) of the field can be selected.
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• Either all components of the field can be visualized, or only one.

• The Values Histogram allows to visualize the results of a particular compo-
nent over the selected filtered values, for post-processing only.

• Both nodes or elements ids restrictions or additional filters on values can
be added, to visualize a subset of results of interest. For instance, all nodes
having a displacement greater than a particular quantity can be visualized.

• Based on the restrictions on both nodes or elements ids and on the filters,
the results are shown on the right hand panel. Different of operations can
be done on such results:

– A subset of nodes or elements can be selected by the user, and picked
inside the 3D render window to visualize their location.

– The values can directly be edited inside this window. Multiple entries
can be modified at once. When those value changes are to be effective,
the save value change button confirms those changes. The Revert
value changes allows to come back to the original state.

– The selected restricted list can easily be saved as a csv file.

Please note all of these options are accessible through API, allowing to automate
post-processing and to automatically select or identify particular nodes or ele-
ments based on a filter. Also, since fields can directly be accessed through the
API, large mathematical operations on fields are usually easier to be performed
through scripting. More information can be found in the API documentation.

Figure 10.36: Visualization of edition of fields
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10.3.6 Properties of a topology

In the property window of a topology (Figure 10.37), the following properties are
available:

• Name: the name of a topology is shown in the topology node;

• ID: this is a numerical ID. A topology should have a unique ID;

• File and Format: if the topology is imported from a external file, these
attributes are the file name and the file’s format. If the domain is created in
VI, these two attributes are None and ACTRAN;

• Model dimension: this attribute informs the user about the number of
coordinate dimensions the topology has. The dimension of the topology
can be changed by the user through this parameter or by using the dedicated
"Set model dimension to" button. The setting of the parameter allows to
create meshes for 2D and 2D axi-symmetric models. When the model
dimension is changed to 2D from 3D the Z coordinate is discarded.

• Model dimension to force at import: this option can be used to specify the
dimension of the topology to be considered at import.

• Length Unit and Mass Unit: the Lenght Unit is a scale factor applied on the
dimension of the topology. The Mass Unit is a scale factor applied on the
mass of the topology. For more information, refer to Actran User’s Guide,
Section 5.6 of Volume 2;

• Mesh tolerance : this option can be used to set the distance tolerance
between two points. Below that value, the two points will be considered to
be the same (default value is set to 0.0001);
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Figure 10.37: Topology property window

10.3.7 Topology export

An entire topology can be exported to a mesh file or to an Actran EDAT file.
This is done via the "Export mesh" function located in the right-click menu of the
topology.

The following export formats are available for all types of topologies:

• NFF with fields;

• NFF without fields;

• BDF;

• UNV;

• DAT;

• EDAT.

For the export in NFF format, it can be either chosen to export loaded fiels with
the NFF database (NFF with fields) or to export without fields (NFF without
fields).

For the export in EDAT format, different types of the EDAT topology can be
proposed:
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• If the topology is created by reading a mesh file or by importing a DAT
analysis, the topology has the attributes "File" and "Format" in its property
window, as shown in Figure 10.37. In this case, the topology can be exported
using EDAT explicit format (choose Actran option in the format selection
popup, as shown in Figure 10.38), to NFF format (choose NFF option) or as a
redirection to an external file (choose FILE option);

• If the topology is created in ActranVI, it does not have the "File" attribute.
In this case, it can only be exported using EDAT or NFF explicit format;

• If the topology is in boxpro format, it can be exported using boxpro for-
mat (choose boxpro option in the format selection popup, as shown in
Figure 10.39), to NFF type (choose NFF option) or using EDAT explicit format
(choose Actran option).

Figure 10.38: Topology output format selection - FILE, ACTRAN, NFF

Figure 10.39: Topology output format selection - BOXPRO, ACTRAN, NFF

For more information about the different formats of EDAT please refer to Actran

User’s Guide, Section 5.6 of Volume 2.

10.3.8 Auto Color Feature

The Auto Color feature allows automatically coloring the different PID domains
contained in a topology. This feature is accessed by right-clicking on the topology
(Figure 10.40).
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Figure 10.40: Set auto colors

10.3.9 Modify dimension

If a topology is assumed to be 2D, this can be directly set through the right-
clicking menu on the topology (Figure 10.40).

10.3.10 Renumber elements and nodes

When performing many mesh operations on a particular model, the identification
number of nodes and elements can become quite important. In order to compress
these, a renumbering option is accessible through the right-clicking menu on the
topology (Figure 10.40).

10.3.11 Re-interpolation

The re-interpolation function can be accessed in the right click menu of a topology.
Linear mesh can be converted to quadratic and vice-versa.
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10.3.12 boxpro Topology

In ActranVI, a boxpro topology can be imported, created, edited and exported.
The syntax of the boxpro topology can be found in the Actran User’s Guide,
Section 5.6 of Volume 2.

A boxpro topology contained in an Actran input file (EDAT format) can be
imported into ActranVI through the menu:

File→ Import mesh ... → EDAT

In order to create a new boxpro topology in ActranVI, right-click on the Topolo-
gies node and select "Create new boxpro topology...". (shown in Figure 10.41).

Figure 10.41: Create a boxpro topology in ActranVI: 1, Creating the topology node

When a boxpro topology is created, one needs to edit the Graduation X, Y and Z
in the property window. These graduations values define the limits and the mesh
refinements of the boxpro topology. They correspond to the BEGIN X, BEGIN Y
and BEGIN Z data blocks in the boxpro topology described in the Actran User’s
Guide, Section 5.6 of Volume 2.

For example, Figure 10.42 defines a boxpro topology that covers a X range from
0 to 10, with an element size of 1; a Y range from -5.5 to 5.5, with an element size
of 0.1; a Z range from 0 to 10, with an element size of 2.
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Figure 10.42: Create a boxpro topology in ActranVI: 2, Edit the graduations

Once the graduations are defined, the user can create the boxpro domains,
through the "Add new domain" in right click menu of the Domains node.

Figure 10.43 shows the creation of a 3D linear domain. The domain is created
based on logical operation (add - remove) of one or several cubic regions. When
a region is "added" (region 1 in the example), the related elements (defined based
on the graduations) are allocated to that domain. When a region is "removed"
(region 2 in the example), the related elements are taken out of the domain.

The Range X, Y and Z define the 3 ranges of the region. If the range of a dimension
is left empty, the region takes the entire range defined in the graduation of that
dimension of the boxpro topology. If the range does not fall on the exact elements
positions defined by the graduations (in the example, Range Y of region 1: -0.3 ,
0.21 ), the elements generated will be those completely included in the defined
range.
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Figure 10.43: Create a boxpro topology in ActranVI: 3, Add a 3D domain

Figure 10.44, Figure 10.45 and Figure 10.46 show the examples of adding a 2D
domain, 1D domain and 0D domain, respectively.
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Figure 10.44: Create a boxpro topology in ActranVI: 4, Add a 2D domain
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Figure 10.45: Create a boxpro topology in ActranVI: 5, Add a 1D domain
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Figure 10.46: Create a boxpro topology in ActranVI: 4, Add a 0D domain

In the property window of a boxpro domain, the different entries are explained
below:

• Dimension: indicating the dimension of the boxpro domain;

• PID: if the boxpro domain is exported to a mesh, the domain will have this
ID number;

• Interpolation: the interpolation order of the domain, linear or quadratic;

• "Show complete Mesh" check-box: construction and display of the finite
element mesh. Otherwise, a box-like geometry defined by all regions is
displayed.
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A boxpro topology can be exported through the export topology operation. If
the EDAT format is selected for the export, the user can further select either the
boxpro format or the Actran format. With the boxpro format, the finite element
mesh is not explicitly exported; in the Actran format, the finite element mesh is
created and exported in the input file.

Refer to the Actran User’s Guide Section 5.6 of Volume 2 for more description
on the syntax of boxpro topology.
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10.4 Materials

In the Materials tree, the different types of valid Actran materials can be created,
imported and exported.

10.4.1 Create a material

The "Add new Material" function can be accessed through right-click of the
Materials node.

Figure 10.47 shows the list of materials available in Actran.

Figure 10.47: Materials available in Actran

When a material is created, its property window pops up.
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Figure 10.48: Property window of the Fluid material

Some entries in the material’s property window support both definition by Value
and definition by Field (refer to section Value/Field). The definition by Field can
be activated only when an analysis is created.

10.4.2 Import a material

The "Import Material" function can be accessed through right-click menu on
the Materials node. In particular a material can be imported from a library of
pre-defined materials located in the Actran installation folder.

10.4.3 Export a material

A material can also be exported to a text file. This is done through right-click on
the material, as shown in Figure 10.49.

Figure 10.49: Export a material

Click here to see a video example.

161



ActranVI Data Trees

10.4.4 Available Actran materials

The following types of material are available in Actran

• Fluid: refer to Actran User’s Guide, Section 7.8 of Volume 2;

• Perfect gas: refer to Actran User’s Guide, Section 7.16 of Volume 2;

• Water: refer to Actran User’s Guide, Section 7.26 of Volume 2;

• Isotropic solid (Young-Poisson, Lame): refer to Actran User’s Guide,
Section 7.9 of Volume 2;

• Transverse isotropic: refer to Actran User’s Guide, Section 7.24 of Volume
2;

• Orthotropic: refer to Actran User’s Guide, Section 7.15 of Volume 2;

• Poroelastic (Young-Poisson, Lame): refer to Actran User’s Guide, Sec-
tion 7.18 of Volume 2;

• Beam: refer to Actran User’s Guide, Section 7.4 of Volume 2;

• Stringer: refer to Actran User’s Guide, Section 7.22 of Volume 2;

• Spring: refer to Actran User’s Guide, Section 7.21 of Volume 2 ;

• Composite solid (External properties, Layers): refer to Actran User’s
Guide, Section 7.5 of Volume 2;

• Sheet: refer to Actran User’s Guide, Section 7.20 of Volume 2;

• External properties: refer to Actran User’s Guide, Section 7.27 of Volume
2.

• Perforation : refer to Actran User’s Guide, Section 7.17 of Volume 2;

• Voice Coil : refer to Actran User’s Guide, Section 7.25 of Volume 2;

• Piezoelectric Tetragonal : refer to Actran User’s Guide,Section 7.23 of
Volume 2 ;

• Piezoelectric Orthorombic : refer to Actran User’s Guide,Section ?? of
Volume 2 ;

• Piezoelectric Anisotropic : refer to Actran User’s Guide,Section 7.2 of
Volume 2
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10.4.5 Remarks and Further Reading

• In the Settings, the user can backup the material library data. This operation
is useful when upgrading to a new revision of Actran.
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10.5 Tables

In Actran TABLEs are used to define the frequency or time dependent quantities.

10.5.1 Import a Table

A TABLE written in the text file can be imported into ActranVI, through the
right-click menu of the Tables node, as shown in Figure 10.50.

Figure 10.50: Import a Table

Two types of table syntax are supported:

• TXT format: Includes direct TABLE data blocks inside an Actran format or
a simple text format (UTF-8). For a TABLE format, only a single table can be
specified per file, but can contain multiple columns at once. Below is an
example:

BEGIN TABLE 1
NAME My_table
3 2
110 1 3 5
120 2 4 6
END TABLE 1

Using standard text format, multiple columns can be added as well. The
syntax for complex numbers in this case can be similar to standard Actran

convention or Python convention 1 + 2.5e5, but cannot be mixed.

110 1 3 {0,5} 7 {0,9}
120 2 4 {0,6} 8 {0,10}

For both formats, two import modes are possible at import, and can be
selected before selecting the external file, as shown in Image 10.51:
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– Single column mode directly interprets the real or complex quantity
and provide this as a single table entry;

– Double columns mode generates complex numbers based on the real
part of two following columns.

On the provided text example, 5 tables are generated using the single import
mode:

TABLE 1 TABLE 2 TABLE 3 TABLE 4 TABLE 5
110 1+0j 110 3+0j 110 0+5j 110 0+5j 110 0+9j
120 2+0j 120 4+0j 120 0+6j 120 0+6j 120 0+10j

While 3 tables are generated using the double columns mode;

TABLE 1 TABLE 2 TABLE 3
110 1+3j 110 0+7j 110 0+0j
120 2+4j 120 0+8j 120 0+0j

Figure 10.51: Select the import mode of the table

• CSV format: This column formatted format can be imported from any other
software. Columns are separated by either commas or semicolons. No
complex numbers can be entered as is. To interpret complex numbers, the
double columns mode must be used.

10.5.2 Create a Table

In ActranVI, a Table can be created through right-click on the Tables node, as
shown in Figure 10.52. The Table can be edited in its property window, as shown
in Figure 10.53.
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Figure 10.52: Create a Table

Figure 10.53: Edit a Table

Multiple lines can be added or removed from a particular table, as well as
edited. A graphical support for the table is provided within the property window.
Depending on the type of interpolation (real-imaginary or amplitude phase), the
visualization of the table is adapted.

In addition, an analytical formulation can be specified for a table. By specifying
the analytical generation of the function in which either the frequency or time
corresponds to x, the table will be automatically filled for each computational
frequency or time.
The values already present in the table can also be referenced, by y. This will
overwrite the existing values.

10.5.3 Refer to a Table in an analysis

Figure 10.54 shows a Table (ID 1) referred by a fluid material. In practice, a table
can be referred to by either entering the TABLE 1 entry, or select a Table option
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and enter 1.

Figure 10.54: Table referred by a fluid material
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10.6 Actran Analysis

The Analysis tree is a container for all the parameters of Actran analysis.

Within the Actran preference of ActranVI, several types of analyses are avail-
able. They are:

• Direct frequency response;

• Modal frequency response;

• Time domain analysis;

• Green analysis;

• Pellicular analysis;

• Modal extraction;

• Compressible flow analysis;

• Incompressible flow analysis;

• Map flow analysis;

• External matrices analysis;

• EA analysis

• VSEA analysis

For the definition of these types of analysis, refer to Actran User’s Guide
Chapter 5 of Volume 1.

For Actran DGM the types of analysis are different, but the principles are the
same.

Three types of utility analyses are also available in Actran. More information
related to these utility analyses can be found in Section 10.7.

Figure 10.55 shows a Direct frequency analysis under the Analysis node in
ActranVI.
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Figure 10.55: A Direct frequency analysis

10.6.1 Analysis import

An Actran analysis can be imported from an analysis input file, through the
"File" Menu, shown in Figure 10.56.

Figure 10.56: Import an analysis through the "File" Menu
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10.6.2 Creating an analysis

An analysis can be created via the right-click menu of the Analysis node, as
shown in Figure 10.57.

Figure 10.57: Create an analysis

An analysis can also be created from the "File" Menu:

Create→ Analysis→ Choose analysis type

Click here to see a video example.

10.6.3 Analysis export

An analysis can be exported using the Actran DAT or EDAT file format. The
export function can be accessed in the right-click menu of the analysis. If the
analysis is exported to EDAT file, the topologies used in the analysis can be
exported to different EDAT topology types:

• If the topology is created by reading a mesh file or by importing a DAT
analysis, the topology has the attributes "File" and "Format" in its property
window, as shown in Figure 10.37. In this case, this topology can be exported
to EDAT explicit type (choose Actran option in the format selection popup,
as shown in Figure 10.59), to NFF type (choose NFF option) or to external
file type (choose FILE option);

• If the topology is created in ActranVI, it does not have the "File" attribute.
In this case, it can only be exported to EDAT or NFF explicit type;
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• If the topology is in boxpro format, it can be exported to EDAT boxpro

type (choose boxpro option in the format selection popup, as shown in
Figure 10.60), to NFF type (choose NFF option) or to explicit type (choose
Actran option).

Figure 10.58: Topology property window

Figure 10.59: Topology output format selection - FILE, ACTRAN, NFF

Figure 10.60: Topology output format selection - BOXPRO, ACTRAN, NFF
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For more information on the different formats of EDAT please refer to Actran

User’s Guide, Section 5.6 of Volume 2.

10.6.4 Active analysis

An analysis can be set as the active analysis. If only one analysis is available in
the analysis tree, this analysis is active by default. There can be only one active
analysis. An analysis must be set to active state before performing the following
operations:

• Create components, BC’s using the right-click menu of a Domain;

• Create field point and field mesh from the Toolbox;

• Validate.

The components, BC’s, field points created using the above methods will appear
in the active analysis.

To set an analysis to active, right-click on the analysis and choose "Set as active",
as shown Figure 10.61.

Figure 10.61: Set an analysis as active analysis

10.6.5 Load fields on an analysis

Fields are used in Actran to define space dependent numerical values. Fig-
ure 10.62 shows an example where the mean flow on the finite elements is
defined using a field.
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Figure 10.62: Space dependent value defined using field

When an Analysis is imported, if the "Display mesh" option has been selected
(refer to Section 10.3.1), all the FIELDs (refer to Actran User’s Guide, Section 11.9
of Volume 2) are automatically imported.

One can also load the FIELDs manually by the right-click menu of the Analysis.,
as shown in Figure 10.63.
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Figure 10.63: Load the Fields in the Analysis manually

10.6.6 Create/Edit Components

Components can be created via:

• the right-click menu of the Model Solution Sequence node;

• the right-click of the related Analysis;

• the shortcut icon in the property window of the Analysis.

A typical component is edited in three steps:

• Select a material;

• Edit the properties;

• Select the Domain(s) using the scope selector.

The above process is illustrated in Figure 10.64.
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Figure 10.64: Editing a typical component

The modal duct component has one specific feature allowing the automatic
detection of the geometric properties defining the duct. In the property window
(see Figure 10.65), four buttons can be used one after another. It is important to
push the buttons in the right order (from left to right) after having selected the
relevant domain in the scope selector. The three first buttons are used to define
the parameters whereas the last button can be used to reverse the direction of the
modal basis.
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Figure 10.65: Property window of modal duct

The following types of components have special visualization properties:

• Finite fluid in all frequency response analysis. A field representing the
local number of elements per wavelength can be created in order to check
the quality of the mesh. This can be done via the right-click menu of the
Finite fluid component (Figure 10.66). This field takes into account the local
refinement of the mesh (longest edge of each element), the local value of the
speed of sound including flow effect (the direction of the flow if a velocity
field is present), the maximal frequency used during the analysis and the
properties of the fluid. In order to produce this result, the user needs to:

1. Select a valid fluid material in the component;

2. Select a valid domain in the scope of the component;

3. Define a valid frequency range in the property window of the analysis.

Figure 10.67 shows the result of mesh quality (right map) in presence of
a mean flow (left map). In the presence of a mean flow, the local mach
number and recomputed static speed of sound can also be visualized.

• Infinite fluid: the infinite domain is represented by an ellipsoid. This
ellipsoid can be visualized in the render window. This is illustrated by
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Figure 10.68. If the infinite domain is covering a semi-infinite medium, a
particular semi-infinite representation is also shown indicating the far field
baffled corresponding to the domain.

• Beam component: for a beam component, the user can visualize its local
coordinate system, its offset of center of gravity and its shear offset. The
equivalent rectangular beam profile, calculated from its cross section inertia
values, can also be visualized. The different visualizations can be turned on
in the property window of the Beam component (Figure 10.69). The arrows
representing the local system and the equivalent rectangular beam profile
are shown on the beam elements in the render window (Figure 10.70). The
center of gravity offset and the shear offset are shown in Figure 10.71;

• Modal duct: In the property window of the modal duct component (Fig-
ure 10.65), one can configure the geometry and the modes of the modal
duct. By activating the "view geometry" flag, the geometry of the duct is
shown in the render window, illustrated in Figure 10.72.

Figure 10.66: Create mesh quality for acoustic mesh
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Figure 10.67: Mean flow - Mesh quality
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Figure 10.68: Ellipsoid representing the Infinite fluid domain
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Figure 10.69: Property window of Beam component: visualization

Figure 10.70: Beam visualization: local system and equivalent rectangular beam profile
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Figure 10.71: Beam visualization: center of gravity offset and shear offset

Figure 10.72: Modal duct’s geometry shown in the Render window

10.6.7 Boundary Conditions

Boundary conditions (BC’s) can be created via

• the right-click menu of the Model Solution Sequence node;

• the right-click menu of the Boundary conditions;

• the shortcut icon in the property window of the Analysis.

A typical BC can be edited in two steps:
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1. Edit the properties of the BC;
2. Select the Domain(s) using the scope selector.

The above process is illustrated in Figure 10.73.

Figure 10.73: Editing a typical BC

The following types of BC’s have special properties:

• The BC Mesh boundary condition does not have a scope selector, but a
Coupling Surface selector. One first needs to create the coupling surface(s)
and select the coupling surface(s) for the BC Mesh boundary condition.
This is illustrated in Figure 10.74;

• An acoustic source does not have a scope. The coordinates of its origin need
to be entered.
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Figure 10.74: Creating a BC Mesh boundary condition

Several BC’s can be visualized in the render window. These BC’s are:

• Acoustic sources, including cylindrical source, planar source and spherical
source. The visualization is controlled by a tick box in the source’s property
window. Figure 10.75 shows the visualization of an acoustic source;

• Displacement, Rotation, Point Load and Point Moment. The visualization
of these four BC’s are controlled by a tick box in the BC’s property window.
The visualization is in form of arrow, triangle or square areas. The size of
the visualization can be adjusted using the Scale Factor. Figure 10.76 shows
an example of displacement visualization.
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Figure 10.75: Visualization of a spherical acoustic source

Figure 10.76: Visualization of a displacement BC

10.6.8 Loadcases

A loadcase can be created, modified and deleted through the Loadcases node.
A loadcase is a combination of boundary conditions, duct modes, or acoustic
sources to excite the model.

In the property window of a loadcase, contribution factors can be defined for the
modes of a MODAL_BASIS (refer to Actran User’s Guide, Section 6.19 of Volume
2) or for the contributions of a BC_MESH (refer to Actran User’s Guide, Section 9.6
of Volume 2). This is illustrated in Figure 10.77.
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Figure 10.77: Define contribution factors in a loadcase

For more information about the loadcase, refer to Actran User’s Guide, Sec-
tion 11.12 of Volume 2.

10.6.9 Post-Processing

The post-processing requests can be created in the Postprocessing node, as shown
in Figure 10.78.

Figure 10.78: Post-processing requests

Available postprocessing requests are (some types of analysis do not have all the
postprocessing requests available):
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• Output FRF: defines the output parameters for the PLT file, as shown in
Figure 10.79. Refer to Section 6.3.10 in this User’s Guide and to Actran

User’s Guide Section 10.8 of Volume 2 for more information;

• Output Map: defines the output parameters of map results, as shown in Fig-
ure 10.80. Refer to Section 6.3.10 in this User’s Guide and to Actran User’s
Guide Section 10.9 of Volume 2, 10.15 of Volume 2 for more information;

• Field Map: defines the output parameters for field map results, as shown
in Figure 10.81. Refer to Section 6.3.10 in this User’s Guide and to Actran

User’s Guide Section 10.9 of Volume 2, 10.5 of Volume 2 for more informa-
tion.

Figure 10.79: Output FRF request
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Figure 10.80: Output map request

Figure 10.81: Output field map request

10.6.10 Solver

A solver can be defined via the right-click menu of the analysis, or via the right-
click menu of the solver. If the selected solver requires a sub-solver, this sub-solver
can be added using the right-click menu of the first solver or the related property
window. Figure 10.82 shows an example of the KRYLOVKRYLOV solver using a
MUMPSMUMPS sub-solver.
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Figure 10.82: Krylov solver and MUMPS sub-solver

Please refer to the Actran User’s Guide, Section 11.28 of Volume 2 for description
on the properties of a solver.

10.6.11 Field Data List

FIELDs are used in Actran to define spatially dependent quantities. Most
properties of component, materials, or BC’s can be defined using FIELDs.

Figure 10.83 shows an example where the mean flow to be accounted in a
convected analysis is defined using a FIELD.
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Figure 10.83: Space dependent value defined using field

The FIELDs are automatically loaded when an analysis is imported.

The user can also create a FIELD via the right-click menu of the Field Data List
(Figure 10.84).

Figure 10.84: Add a field
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An example of the property window of a FIELD is given in Figure 10.85.

Figure 10.85: Property window of a field

Figure 10.86 shows the field data value defined under the field. To access to
the field value, the user can right-click on the field data and choose "Edit Data"
(Figure 10.87).

Figure 10.86: Field with field value data

Figure 10.87: Access to the field data value

The field value data can be deleted using the right-click menu of the field data.

190



ActranVI Data Trees

Deleting the field value data is important when the user wants to re-define the
field value. When the field value data is defined, simply modifying the field’s
default value is not sufficient to re-define the field.

Refer to Load Field for more information on loading field in the analysis.

Refer to Actran User’s Guide, Section 11.9 of Volume 2 for description on the
properties of FIELD.

10.6.12 User Functions

Please refer to the Actran User’s Guide, Section 11.36 of Volume 2 for description
on the user function.

10.6.13 Local Axes and Transformation

The Local Axes and Transformation can be used to define local systems and
transformations. Please refer to the Actran User’s Guide, Section 11.15 of
Volume 2, 11.35 of Volume 2 for more information on the local system and
transformation.

10.6.14 Adaptivity Container

Please refer to the Actran User’s Guide, Section 11.1 of Volume 2, for more
information on the adaptivity container.

10.6.15 Model Reduction Container

Please refer to the Actran User’s Guide, Section 11.20 of Volume 2, for more
information on the model reduction container.
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10.7 Utility Analysis

Three types of utility analyses (as shown in Figure 10.88) can be created, imported
and exported in ActranVI. They are:

• Flow mesh model for a compressible flow analysis. Please refer to Actran

User’s Guide, Section 4.5 of Volume 2 for information on compressible flow
analysis;

• iCFD input file. Please refer to Actran User’s Guide, Section 51 of Volume
1 for information iCFD

• FWH input file. Please refer to Actran DGM User’s Guide for information
on FWH analysis.

Figure 10.88: Utility analyses in Actran

10.7.1 Remarks and Further Reading

• A flow mesh model can be imported into ActranVI using the menu File ->
Import Flow Mesh Analysis; an iCFD analysis and a FWH analysis can be
imported using the menu File -> Import Analysis.
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10.8 Visual

The Visual tree is a container of all the viewports in ActranVI.

Figure 10.89 shows an example of the visual tree, with 3 viewports.

Figure 10.89: The visual tree, containing 3 viewports

10.8.1 Synchronize viewport camera

The cameras of different viewports can be synchronized individually using
drag’n’drop, as shown in Figure 10.89. For exampe, the drag’n’drop of camera
2 to camera 3 synchronizes viewport 3 with viewport 2 (viewport 3 takes the
camera of viewport 2).

In order to de-synchronize the camera of a particular viewport, one can right-click
on the viewport and select "Reset Camera", as shown in Figure 10.90
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Figure 10.90: Reset camera to remove the camera synchronization

10.8.2 Remarks and Further Reading

• Refer to Section 9.3 for more information on the viewport.
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ActranVI Toolbox

The Toolbox, located below the Render window (Figure 11.1), is composed of
different tabs. It provides the following groups of functions and windows:

• Mesh creation/modification/information;

• Import and visualization of results;

• Actran analysis launcher;
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Figure 11.1: The Toolbox in ActranVI

11.1 "Mesh" tab

Six sub-tabs are available in the "Mesh" tab. They are: Meshing Tools, Measure,
Info, Mesh Quality, Projection and Partitions.

11.1.1 "Meshing Tools" sub-tab

The meshing tools can be used to create / modify / transform a mesh. For
detailed information regarding meshing tools, please refer to the Meshing tools
chapter 13.

11.1.2 "Measure" sub-tab

In the "Measure" tab, one can measure the distance between two nodes, the angle
formed by three nodes or the dimensions of a particular selection of pids.

1. When selecting 1 node, its coordinates are provided.

2. When selecting 2 nodes, the distance and associated vector is provided and
shown. This process is shown in figure 11.2. The vector information can
then be reversed (direction) or normalized to a unit length.

3. When selecting 3 nodes, the angle and associated normal vector is provided
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and shown. This process is shown in figure 11.3. A permutation of the 3
points can be performed to obtained the angle between the desired selection.
The vector can then be reversed in direction and normalized to a unit length.

4. When selecting one or more pid domains, the dimensions of the bounding
box is provided for each axis, including minimal, maximal coordinate and
local dimension. The geometrical center of the selection is provided as well
as the integrated volume, surface or length (for volume, surface or edge
elements) of the selection. This is shown in figure 11.4.

Figure 11.2: Measure distance between two nodes
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Figure 11.3: Measure angle formed by three nodes
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Figure 11.4: Dimensions of a selected PID

11.1.3 "Info" sub-tab

The "Info" sub-tab allow to show information regarding selected elements and
nodes.
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Figure 11.5: The "Info" sub-tab

The list is automatically updated with the current selection of elements and
nodes.

1. For nodes, the node identification number, coordinates, corresponding
topology and meshing domain is provided;

2. For elements, the element identification number, nodes, element types, di-
mension, interpolation, topology and PID Domain information is provided.

11.1.4 "Mesh quality" sub-tab

The Mesh quality tool provides the mesh stats and mesh quality information of the
selected PID domains. The information available is: Mesh stats (1), Intersections
(2), T junctions (3), Mesh criteria (4) and Mesh histogram (5) (Figure 11.6).
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Figure 11.6: Mesh quality information

1. Mesh stats
The Mesh stats tool shows the number of nodes of the selected PIDs in total
and in each dimension.

2. Intersections
The Intersections tool allows to check the intersection in one or multiple
2D PIDs. The number of intersected elements detected is reported in the
log. In the render window, these elements are highlighted in green color
(Figure 11.7).

Figure 11.7: Mesh quality - Intersection tool

3. T junctions
The T junctions tool allows to detect any junction in T (or also called T
branch) in different PIDs. The number of T junctions detected is reported
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visually in the graphical tool. In the render window, these elements are
highlighted in green color.

4. Mesh criteria filter
The Mesh criteria filter tool shows the number of elements exceed or under
a selected quality criterion threshold value. These elements are displayed
in bright green color in the render window (Figure 11.8).

Figure 11.8: Mesh quality - Mesh criteria filter tool

Mesh histogram

The Mesh histogram tool provides mesh quality information on the elements of
the selected PIDs based on the following criteria:

• Mean edge length

• Minimum edge length

• Maximum edge length

• Aspect ratio: ratio between maximum edge length and minimum edge
length of the element.

• Jacobian: ratio between maximum and minimum Jacobian determinants
calculated at the integration points of the element according to each type.
The number of integration points used, dependent on the element type and
its interpolation order, is listed in Table 11.1.4:

202



ActranVI Toolbox

Element Type Interpolation order Number of integration points
Triangle Linear 4
Triangle Quadratic 7

Quadrangle Linear 4
Quadrangle Quadratic 9
Tetrahedron Linear 5
Tetrahedron Quadratic 14
Pentahedron Linear 8
Pentahedron Quadratic 21
Hexahedron Linear 8
Hexahedron Quadratic 27

Pyramid Linear 8
Pyramid Quadratic 27

Table 11.1: Number of integration points for each element type

11.1.5 Projection Manager

The projection tool is used for controlling the parameters and the quality of
incompatible mesh projections. The projection manager tool can be used to check
the consistency of the projection parameters of an INTERFACE or a BC_MESH (refer
to Actran User’s Guide, Section 8.5 of Volume 2 and 9.6 of Volume 2). More
specifically, the projection manager:

• performs the localization and mapping process;

• enables the user to test projection options (tolerance parameters);

• provides the ratio of localized nodes by the total number of nodes to map;

• automatically displays mapping quality through Maps or Contours.

The projection manager is initialized by selecting the coupling surface(s) in the
PID Domains list 1 and in the PID Domains list 2. The Planar and Gap Tolerance
(Min and Max values) parameters must be also specified through the Mapping
Parameters section. The localization statistics are returned for each PID or domain
separately. If there is more than five values, a message will be appear ("To many
values to display"). This is shown in Figure 11.9:
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Figure 11.9: Projection tool interface

In each list, all the Topologies trees are presented. The Domains under the
Topology is also available for selection. All the PID’s of the Topology are presented
as well. This is illustrated in Figure 11.10:

Figure 11.10: Projection tool

The direction of the array defines the Mapping direction. The Mapping process
should not be confused with the Localization/Projection step. As shown in
Figure 11.11, the process used is a two steps procedure:

• Projection of the nodes from surface 1 to surface 2. A temporary mesh
is created based on surface 2. The normals to the nodes of surface 2 are
computed. Elements of the surface 2 are extruded (from -gap tol to +gap
tol) following the normal. The extruded elements are then scaled by a factor
to reach target node (tolerance = plane tol).

• Values are deduced on the projected nodes on the second surface. These
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values (e.g.: pressure) are interpolated from the value of the closest nodes
and the shape function of the elements. For Fluid/Structure coupling (or
BC_MESH), these values are then mapped on surface 1.

Figure 11.11: Projection Procedure

Example: To study the shell noise radiated by a muffler, an incompatible mesh is
created. An INTERFACE is used to couple the structure COUPLING_SURFACE (right
side of Figure 11.12) and the acoustic COUPLING_SURFACE (left side of Figure 11.12).
The acoustic COUPLING_SURFACE is coarser than the structure COUPLING_SURFACE
(Figure 11.12 and Figure 11.13).

Figure 11.12: Coupling surfaces. Left: acoustic, Right: structure
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Figure 11.13: Coupling quality index for 2 values of the extrusion parameters: 5mm and 1
cm

The values displayed in the color maps provide information on the quality of the
projection:

• Nodes having a value spread from 0 to 1 are mapped during the procedure.

• Nodes having a value above 1 are not mapped during the projection. The
projection must be considered as a binary operation : mapped or not
mapped.

• Nodes having a value close to 1 are the farthest from the projection surface.
The distance still remains within the tolerance. Nodes having a value close
to 0 are located at shorter distance to the projection surface.

11.1.6 Partitions

The "Partitions" tab allows to visualize and modify existing partitions of topolo-
gies. These partitions can be used for domain decomposition strategies or for
Virtual SEA substructuring.

• The Partition Map section allows to select a particular partition. The Show
and Clear buttons allow to visualize the considered partition. The groups
considered in the selected partition will also be visible in the Groups section.
Moreover, an option to apply group modifications on all partitions having
the same name can be selected.

• The Group section allows to modify the content of each group. In Actran,
one element can only be assigned to a single group for a given partition.

– New groups can be added;

– Selected elements can be assigned to a selected group;

– Elements belonging to a particular group can be selected;
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– Elements of a particular group can be shown;

– Elements can be removed from a selected group.

Figure 11.14: Partitions tool
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11.2 "Import results" tab

In order to visualize the results of a computation, two steps are needed. The first
step is to use the Import results tab to import the results from a results database.
The second step is to use the Display results tab to visualize these results.

Concerning the results import, two cases are discussed below:

• The results file is different from the mesh file. This is for example the case
where the mesh is in a BDF file and the results in a OP2 file. In this case,
one needs to first choose a mesh, then use the "Add File(s)" menu to add
the results on the mesh. After the results are added to the mesh, select the
desired quantity in the results and click on "Import Selection" to import the
results. This process is illustrated in Figure 11.15;

• The results file contains the mesh and is already loaded. This is for example
the case for an NFF database. In this case, the quantities available in the
database are already presented in the window. One only needs to select
the desired quantity and import it by clicking on "Import Selection". This
process is illustrated in Figure 11.16.

Figure 11.15: Import results: result file is different from the mesh file
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Figure 11.16: Import results: result file is the same as the mesh file

Results can also be imported on a single frequency or on a selected number of
frequencies. Figure 11.17 shows the related operations.

Figure 11.17: Import results: select results on certain frequency(ies) to import

When the results are imported on selected frequencies, a text ( imported ) appears
after the frequencies, illustrated in Figure 11.18.
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Figure 11.18: Import results: Imported results are indicated by a text

A loaded result file can be removed from the Database content. Figur 11.19
illustrates the process.

Figure 11.19: Import results: An imported result file can be removed in the Right Click
menu of the result file

The imported results appear under the mesh in the Topology tree. The results
can be removed by Remove in the right-click menu of the results. This is shown
in Figure 11.20
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Figure 11.20: Import results: Imported results are show under the Topology and can be
removed

If the results are not available for some nodes of a domain, the results of the
entire domain are not imported, except if the "Use default value if needed" option
is selected. This is illustrated in Figure 11.21.

Figure 11.21: Import results: specify default value

When importing results on a 2D shell domain modeled with composite material
(shell with multiple layers), one can choose to import the results on one of these
layers. This is done using the Laminate layer option, shown in Figure 11.22.

211



ActranVI Toolbox

Figure 11.22: Import results: specify the layer to import results for composite shell

In case the user imports a NASTRAN .OP2 file, two more options become
available. When the results contain stress/strain information, the option "Element
to Basic Coordinate System (stress/strain)" can be activated in order to change
the element coordinate system to the Basic one. When the results contain modal
information (dsiplacement/rotation), the option "Modes in Local Coordinate
System (displacement/rotation" can be activated to change the coordinate system
from Global to Local.

Figure 11.23: Import results: modify the coordinate system for NASTRAN files
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11.3 "Display results" tab

The Display results tab is used to display the results of a computation. Before
visualizing the results, the results must be imported using the Import results tab
(Section 11.2).

11.3.1 Visualization

The Visualization tab is used to plot and/or remove the results.

Figure 11.24 illustrates the process of plotting a scalar result (one dimension)
such as the pressure or the density.

Figure 11.24: Plot a scalar result

Figure 11.25 illustrates the process of plotting one component of a vector result
(multiple dimension) such as the intensity, the displacement or the velocity.
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Figure 11.25: Plot a component of a vector result

Five different visualization modules are available:

• The map module applies a color map of values on the mesh;

• The isosurfaces module computes surfaces of identical values and creates a
dedicated mesh for each value;

• The vectors module is used on vector quantities, and creates a colored
vector representing the value on each node of the mesh;

• The deform module is used on vector quantities, and modifies the mesh
according to the vector. Typically, displacement are shown using the deform
module to highlight the deformation;

• The directivity map module is applied on scalar quantities only, and com-
bines a map of the quantities based on the provided operator, with a
deformation of the surface mesh. This deformation is proportional to the
provided value, and is scaled between the provided or automatically com-
puted center of the directivity and the grid point. A second operator for
this deformation can be selected.

In the Advanced box, the user has access to advanced controls on the visualization
of the results:

• VP: choose the viewport(s) on which the results are displayed;

• Display in new module: when plotting a new result, the colored range of
the result is shown in a new bar;
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• Vector component: choose the component of a vector. If no component is
chosen, the modulus of the vector is plotted;

• Rotating mode: choose the rotating mode if available (only applicable to
rotating components). If no mode is chosen, the first available mode will be
displayed;

• Field restrictions: the user can choose the restrictions on the results. These
options are useful when the user wants to plot the results only on a particu-
lar topology or domain.

• For the directivity map, the center of the directivity is either manually
provided, or automatically computed. Baffle planes can be provided when
computed automatically. a particular operator for the deformation of the
directivity can be provided as well.

On the right part of the tab, the user can adjust parameters modifying the results
displayed on the render window:

• VP: to select which viewport is impacted by the change of the parameters

• Phase VP: to modify the phase at which the results is plotted. As Actran

is producing complex results, one can display the results with a specific
phase shift. Slide bar can be used or the value can be directly indicated in
the dedicated entry field.

• First result checkbox : by checking this option, ActranVI plots the results
for the first available frequency (or time step).

• Frequency selector : user can select the frequency at which the results
must be plotted. ActranVI proposes the frequencies having been imported
using the Import results tab.

• Time selector : user can select the time step at which the results must be
plotted. ActranVI proposes the time steps having been imported using
the Import results tab.

• Static selector : user can select the static id at which the results must be
plotted. ActranVI proposes the static id having been imported using the
Import results tab.

• Loadcase id selector : Actran solver features multiple loadcase simulations
see Section 11.22 of Volume 2. At each frequency, the selected quantity is
available for all the different loadcases defined in the analysis. User can
display the quantity for a specific load case by using the loadcase id selector.
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This is illustrated in Figure 11.26.

Figure 11.26: Adjust the results parameters

11.3.2 Properties

In the Properties tab, the properties of the results visualization can be changed.
Figure 11.27 and Figure 11.28 show the available properties for a map module
and for the vector module, respectively.

Below are explanations of several common properties:

• Custom range: allow user specifying the range of the colorbar. If the box
is not checked, an automatic range is applied based on minimum and
maximum value available on the domains;

• Log scale: use log scale intervals for the colorbar;

• Centered scale : set the colorbar values centered around zero

• Map values before color interpolation: when plotting a colored map, inter-
polate the value in the elements according to the values on the elements’
nodes. If the option is not activated, the above operation is not performed;
the color in the elements is interpolated according to color on the elements’
nodes;

• When deactivating the mapping of the values, a particular color above and
below the provided range can be specified;
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• The Formatting of the numbering, as well as the number of labels and
colors of the colorbar can be chosen individually;

• Type allows to choose the type of colormap to use. Several types are
available (jet, blue white red, seismic, spectral, viridis, plasma, inferno,
magma, rainbow, cubehelix).

• The Geometry argument provides the scale and position of the colorbar.
When moving or modifying this latest manually, the Geometry argument is
automatically adapted;

For the map operator, an integration tool over the frequencies, time values or
loadcases is available. When integrating over frequency or time, 3 options can be
activated: integration, sum or mean value. For loadcases, only a sum or mean
value can be computed. Depending on the provided operator and number of
quantities, for obtained integrated solution becomes:

• For a real operator:√∫
(q1.real2 + q2.real2 + q3.real2)d f (11.1)

where q1, q2, q3 represents the different components of the vector. For a
scalar value, q2 and q3 are equal to 0.

• For an imaginary operator:√∫
(q1.imag2 + q2.imag2 + q3.imag2)d f (11.2)

• For a norm operator:√∫
(q1.real2 + q2.real2 + q3.real2) + (q1.imag2 + q2.imag2 + q3.imag2)d f

(11.3)

• For a dB operator:

10∗ log10(
∫

(q1.real2 + q2.real2 + q3.real2) + (q1.imag2 + q2.imag2 + q3.imag2)

p2
re f

d f )

(11.4)
where pre f corresponds to the reference pressure.

• For a dBA operator:

10∗ log10(
∫

((q1.real2 + q2.real2 + q3.real2) + (q1.imag2 + q2.imag2 + q3.imag2)) ∗ A2

p2
re f

d f )

(11.5)
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The different options modify the above the expressions as follows:

• Using the Sum option replaces the integration by a sum over the frequencies,
time or loadcase values:

√√√√ N

∑
i=1

(q1.real2 + q2.real2 + q3.real2) (11.6)

• Using the Mean option replaces the integration by a discrete sum divided
by the number of frequencies, time or loadcases :

√√√√ 1
N
∗

N

∑
i=1

(q1.real2 + q2.real2 + q3.real2) (11.7)

Particular properties for the isosurfaces module:

• Number of isosurfaces: Specifies the number of intermediate isosurfaces.
By default, the isosurfaces corresponding to the min and max value are not
accounted.

Particular properties for the vector module:

• Scale factor: the scale factor of the vector arrow;

• Scale vectors: the length of the arrow representing a vector is proportional
to the modulus of the vector.
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Figure 11.27: Properties of a map module

Figure 11.28: Properties of a vector module

Particular properties for the deform module:

• Scale factor mode: Specifies the scale factor mode which can be absolute
(multiplication of the quantity with this constant factor) or relative to the
maximum of the quantity.

• Scale factor: A real, positive number which will define the size of the scaling

• Undeformed wire mesh: Toggle to show the undeformed wire mesh
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• Undeformed surface mesh: Toggle to show the underlying undeformed
surface

Figure 11.29: Properties of a deform module

11.3.3 Cutplane

The Cutplane tab is used to create cutplanes on the results and enable the user to
inspect results inside the mesh.

In order to create a cutplane in the Cutplane tab (Figure 11.30), the user first
selects the result to cut, through the combination of four parameters. When
clicking on "Apply", a cutplane is created.

To improve the visualization of the mesh after a cutplane operation, one may
need to adjust the visibility in the data tree panel in order to have a desired
visibility of the mesh.
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Figure 11.30: Create a cutplane

Once the cutplane is created, its properties can be modified in the Properties tab,
as shown in Figure 11.31.

Figure 11.31: Properties of cutplane

11.3.4 Animation

The animation tab is used to create an animation of the results. The animation
can be saved in a video file or in a set of image files. The animation tab is shown
in Figure 11.32.
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Figure 11.32: Animation tab in Display results
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11.4 "Run" tab

In the Run tab, an analysis in ActranVI can be launched or validated. Fig-
ure 11.33 shows the content of the Run tab.

Figure 11.33: Run tab to launch an analysis

The Analysis toggle allows to select the analysis to be launched using the launcher.
The command line options allows to specify particular commands to be used. The
memory and parallelism sections allow to easily specify the dedicated amount of
memory for the computation or to select the parallel options.

Alternatively, a Validate function allows to run the computation in test mode to
verify the validity of the analysis. The following validation options are available
in the Validate modes list:

• light: only builds the model (without testing the solver operation);

• adaptivity: builds the model and runs the solver (without factorization)
only for the first frequency. For cases with mesh adaptivity, all mesh
iterators are tested with their corresponding first frequencies;

• full: runs the full case (all frequencies, solver without factorization), creates
empty results (*.plt, nff) and a report.pdf

It is also possible to run a validation of an existing analysis in the command
prompt through the --test option. Please refer to Section ?? of Volume 1 for
further information.

11.4.1 Remarks and Further Reading

• The exported analysis file in the EDAT format. It is
named: analysis_type.yyyy.mm.dd-hh.mm.ss.edat. For example:
"Direct_Frequency_Response_2020.01.28-11.14.10.edat";

• The export of the analysis is recorded in the session; the launch of the
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analysis is not recorded in the session.
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11.5 Console and Info frame

The console and info frame (Figure 11.34) can be shown by clicking on the button
located on the bottom left corner of ActranVI

The session script is automatically printed in the console tab . The user can also
type the API commands in order to execute functions from the Console.

Information related to the application is printed in the Info tab

Figure 11.34: Console tab

11.5.1 Remarks and Further Reading

• Please refer to Chapter 27 and 29 for more information related to the session
and to API.

• When reporting a problem to the Hexagon support team (see Section 3.2
for the contact information), please attach the information content in your
Email.
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11.6 BC_MESH split utility

The BC_MESH split utility can be used to automatically create BC_MESH bound-
ary conditions, in order to compute the contribution to the acoustic radiation
from specific structure areas of the original BC_MESH. The split functions can be
accessed by right-clicking on a BC_MESH boundary condition (Figure 11.35)

Figure 11.35: The three functions of the BC_MESH split utility

Three functions are available :

• Split by structure mesh PIDs: the structure mesh PIDs are retrieved from
the specified BC_MESH mesh file. Each structure mesh PID is set as a
source PID in a new BC_MESH.

• Split by coupling surface PIDs: all the PIDs included in the scope of the
BC_MESH coupling surface are identified. A coupling surface is created
based on each one of those PIDs and this coupling surface is used in a new
BC_MESH

• Auto-split: performs the partition of the coupling surface according to the
projection of the different structure PIDs and the creation of the related
COUPLING_SURFACE datablocks. This option is equivalent to setting
SPLITTING_METHOD to AUTO in radact

All the other parameters from the original BC_MESH are preserved in the
BC_MESH boundary conditions resulting from the split. A loadcase is created
for each BC_MESH (except for the original BC_MESH if it already has a related
loadcase). In case of an id collision with an existing loadcase or BC_MESH,
a pop-up allows the user to abort the operation or automatically change the
loadcase or BC_MESH id. In case the user chooses to change the id, the loadcase
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and BC_MESH ids will no longer correspond to the original structure or coupling
surface PIDs.

11.7 BC_MESH mode contribution utility

The BC_MESH mode contribtuion utility can be used to automatically create a
BC_MESH calculation where each mode radiates indepentently according to the
modal partecipation factors output by the hybrid frequency response that has
been previously run. Multiple loadcases will be generated automatically and
each of them represents a contribution for each mode. (Figure 11.36)

Figure 11.36: Mode contribution utility of the BC_MESH
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11.8 Poles Fitting utility - DGM Porous Materials

The Fitting Poles tool can be used to compute the damper factors, gains and poles
used to fit an equivalent Miki porous material in Actran DGM. It is available in
the Tools tab

Figure 11.37: Fitting Poles tool inside Tools tab ribbon

The tool will compute the damper factors, gains and poles based on the following
input parameters:

• Frequency range for fitting

• Static mean pressure and density in the equivalent fluid material

• Constant heat pressure and volume in the equivalent fluid material

• Target flow resistivity of the Miki material

The damper factors, gains and poles can then be obtained by the utility and
copied to a pair of Analytic Tables (DGM Treatment) and then referenced in an
appropriate porous DGM material. The user can check the accuracy of the fit
using the P factors and V factors comparison graphs integrated in the tool.
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Figure 11.38: Poles Fitting tool - Miki Model

11.9 Poles Fitting utility - DGM Surface Conditions

The Fitting Poles tool can also compute the gains, poles and mass, stiffness
and damping factors for expressing multi-frequency impedance, admittance and
transfer admittance boundary conditions in Actran DGM. As input, the iterative
"Table" or “Acoustic Liner” fitting model requires the following:

• A frequency table as the fitting target if “Table” model is used
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• Liner layer materials description if “Acoustic Liner” model is used

• Number of poles to be used in the fitting algorithm

• The activation or exclusion of mass, stiffness and damping terms in the fit
formulation

• Frequency range for fitting visualization purposes

Once the inputs have been provided, iterations are computed with the utility
until a satisfactory fit is achieved. The computed parameters may then be copied
to an Multipole Table (DGM Treatment) to be referenced in an appropriate DGM
boundary condition or transfer component.
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Figure 11.39: Poles Fitting tool - Table Model
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Figures/vi_toolbox/Poles_Fitting_AL_model.png

Figure 11.40: Poles Fitting tool - Acoustic Liner Model
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Twelve

Selection Tools

12.1 Selection Handling

For selecting entities inside the render window, the four following selection
modes are available:

• PID (element set) selection mode

• Element selection mode

• Node selection mode

• SubElement selection mode

Selection mode icons can be found on the icon bar at the bottom right of the
render window, as depicted in figure 12.1.

Figure 12.1: Four selection modes are available. From top to bottom: PID, Element, Node
and subelement

233



Selection Tools

The default selection mode when opening ActranVI is the PID selection mode.
The four selection modes are detailed in the following sections.

12.1.1 PID (element set) selection mode

1. Element sets can be selected by left clicking on the element set name in
the data tree, whichever selection mode is the active one. (Ctrl + left click)
allow for multiple element sets selection in the data tree

2. Element sets can also be selected by picking (Ctrl + left click) in the render
window. The PID selection mode should be the active one

3. The selected element sets are colored in red in the data tree and in the
render window. The selection is synchronized between the data tree and
the render window

4. Turning off the visibility of an element set from the data tree removes this
element set from the current selection (if the element set was in the current
selection). If the current selection contains other element sets, these remain
selected

Figure 12.2: PID (element set) selection mode. The PID selection mode icon is selected

12.1.2 Element selection mode

1. Elements can be selected by picking (Ctrl + left click) in the render window.
The element selection mode should be the active one

2. The selected elements are respectively colored in orange, green, light blue
or pink for 3D, 2D, 1D, or 0D dimension elements
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3. Turning off the visibility of an element set from the data tree removes every
element of this element set from the current selection (if these elements were
in the current selection). If the current selection contains other elements
belonging to other element sets, these remain selected

Figure 12.3: Element selection mode. The element selection mode icon is selected

12.1.3 Node selection mode

1. Nodes can be selected by picking (Ctrl + left click) in the render window.
The node selection mode should be the active one

2. The selected nodes are colored in blue

3. Turning off the visibility of an element set from the data tree removes
every node of this element set from the current selection (if these nodes
were in the current selection). If the current selection contains other nodes
belonging to other element sets, these remain selected
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Figure 12.4: Node selection mode. The node selection mode icon is selected

12.1.4 SubElement selection mode

The SubElements selection allows to create new surface or edge elements based
on free faces or free edges of surface or volume elements. This can be used to
quickly generate a surface to specify a boundary condition for instance.

1. Free surface or edge elements can be selected by picking (Ctrl + left click)
in the render window. The subelement selection mode should be the active
one

2. The selected new elements are colored in blue

3. Any modification in selection mode unselects the current selection

4. The current selection can be used to create a new element set from the
selection panel
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Figure 12.5: SubElement selection mode.

12.2 Picking options panel

The picking options panel contains various options related to the selection, and is
located on the right side of the data tree panel (Figure 12.6). This panel is hidden
when ActranVI is started. The user can show it using Mesh→ Picking Options
→ Open Picking Options Panel, or by using the toggle button "Open Picking
Options Panel" in the icon bar in the right side of the render window.

Figure 12.6: Selection tools

The content of the picking options panel changes according to the active selection
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mode. A part of the options are shared between several selection modes while
other options are only available for a particular selection mode, as described in
the following sections.

12.2.1 Tools shared by PID and element selection modes

The "PIDs & Elements visibility" tools are common to PID and element selection
modes. These tools can be used to hide/show elements of one (or multiple)
elements set(s) that are on the current selection.

Figure 12.7: PIDs & Elements visibility

From left to right:

• Show all elements : restore the visibility of all hidden elements

• Save current elements display state

• Restore previously saved elements display state

• Inverse shown/hidden elements

• Hide selected elements : hide elements of the current selection (selected
through PID or element selection)

• Show only selected elements : show only elements of the current selection
(selected through PID or element selection)

• Show user normals on selected 2D PIDs (selected through PID selection)

The "PIDs & Elements selection" tools are also common to PID and element
selection modes. These tools can be used to operate on the PIDs and the elements
of the current selection (not on the nodes of the current selection).
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Figure 12.8: PIDs & Elements selection

From left to right:

• Clear the selection : removes the PIDs and elements from the current
selection

• Save current selection : saves the PIDs and elements of the current selection

• Restore saved selection : replaces the current selection by previously saved
PID and elements (warning : the current selection is lost)

• Inverse selection : replaces the current selection by the unselected PID and
elements

12.2.2 PID selection options

In this section, the options specific to the PID selection mode are detailed.

Figure 12.9: PID selection options

1. Dimension restriction : only element sets with specified dimension(s) can
be selected
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2. Selection by name : if an element set of the specified topology contains the
string specified in the name field, it is added to the current selection

3. Selection from selected PIDs: Adds every element of the selected PIDs to
the element selection

12.2.3 Element selection options

Some options are specific to the element selection mode.

Figure 12.10: Element selection options

1. Dimension restriction : only elements of specified dimension(s) can be
selected

2. With the "Include partially selected" option activated, the area selection will
also add to the current selection elements that are partially contained in the
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selection area (partially means elements that contain at least one node in
the selection area)

3. With the "Include connected option" activated, the selection will add all
element(s) that are connected to the selected element(s) with an angle
smaller than the "Angle threshold" parameter

4. Selection by IDs : if some elements of the specified topology correspond
to the specified element ID(s), these elements are added to the current
selection

5. Selection from selected PIDs : adds to the current selection every element
contained in the PIDs of the current selection

6. Get FRF from node selected: If results are loaded on a mesh and an element
is selected, this tool can be used to obtain the value of the loaded field at
the selected element location

12.2.4 Node selection options

Some options are specific to the node selection mode.
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Figure 12.11: Node selection options

1. Dimension restriction : only nodes belonging to elements of specified
dimension(s) can be selected

2. Selection by IDs : if some nodes of the specified topology correspond to the
specified node ID(s), these nodes are added to the current selection

3. Selection by coordinates: the node closest to the specified location (coordi-
nates) is added to the current selection

4. Selection from selected elements: adds to the current selection every nodes
contained in the elements of the current selection

5. Create PID from nodes selected: Create one 0D element set based on the
current node selection
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6. Get FRF from node selected: If results are loaded on a mesh and a node is
selected, this tool can be used to obtain the value of the loaded field at the
selected node location

12.2.5 SubElements selection options

Some options are specific to the subelements selection mode.

Figure 12.12: Subelements selection options

1. Dimension restriction : only free faces or edges located on surface or volume
elements can be selected

2. With the "Include partially selected" option activated, the area selection will
also add to the current selection elements that are partially contained in the
selection area (partially means elements that contain at least one node in
the selection area)

3. With the "Include connected option" activated, the selection will add all
free surface element(s) that are connected to the selected element(s) with an
angle smaller than the "Angle threshold" parameter

Finally, the current selection can be used to generate a new element set.
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ActranVI Meshing tools

13.1 Meshing tools general information

13.1.1 General organisation

Meshing tools can be found in the Mesh→ Meshing Tools tab of the ActranVI
toolbox.

Meshing tools are spread over 5 categories (Figure 13.1):

• Creation: The Creation category regroups meshing tools to create simple
shape meshes

• Edit: The Edit category regroups meshing tools to edit existing meshes

• Surface: The Surface category regroups meshing tools to manipulate surface
meshes

• Volume: The Volume category regroups meshing tools to create volume
meshes

• Transform: The Transform category regroups meshing tools to apply geo-
metric transformations
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Figure 13.1: Meshing tool global view

When a meshing tool is selected, its parameter panel is displayed (Figure 13.2). It
contains:

• The "Back" and "Change tool..." buttons to switch to another meshing tool

• The tool parameters

• A Preview frame where you can find options regarding the interactive
preview

• A Save frame where you can find options regarding the final output mesh

Figure 13.2: Box meshing tool panel

An interactive preview is available for most meshing tools in ActranVI (Fig-
ure 13.3). This feature allows to see the mesh created by the meshing tool in the
viewport whithout modifying the Topology. The interactive preview is updated
each time a parameter is changed.

1. Activate the interactive preview
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2. Switch the interactive preview mesh between opaque or transparent mode

3. Switch whether the original mesh should be hidden or not (not available
for all meshing tools)

Figure 13.3: Preview frame

13.1.2 Selection for meshing tools

Only element sets (also called PID domains in ActranVI) can be used as input for
meshing tools functions (Figure 13.4). For more information regarding the PID
selection mode, please refer to the PID selection mode section:

1. Element sets can be selected by left clicking in the graphical tree

2. Element sets can also be selected by picking (ctrl + left click) in the render
window while the PID selection mode is selected.

3. The selected element sets are colored in red in the graphical tree and in the
render window

4. The element sets dimension information (0D, 1D, 2D or 3D) is available in
the graphical tree

Figure 13.4: Element set selection for meshing tools
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To perform meshing operations only on a part of an element set, this part should
be selected and placed in a new element set using the PID Assignation toolbox
(Figure 13.5) of the Move or Copy function.

1. Select the Element selection mode

2. Tick the "Include connected" option (optional)

3. Select a part of an existing element set in the viewport (Ctrl+left mouse
button click)

4. Under the Mesh / Meshing Tools tab, go to the Move/Copy function and
select Move elements into new PID and specify the name of the new element
set

5. Click on "Create PIDs" to create a new element set

6. Meshing operations can be done on this new element set

Figure 13.5: Input mesh manipulation for meshing tool input

13.1.3 ActranVI meshing tools workflow

The typical workflow for ActranVI meshing tools is the following
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Figure 13.6: Typical workflow for ActranVI meshing tools

1. If the function requires input element set(s), the input element set(s) is (are)
selected

2. Go to the meshing function

3. Adjust the parameters

4. Activate the interactive preview and observe the created mesh. Parameters
can be adjusted to improve the mesh quality

5. Create the mesh

13.2 Key concepts

13.2.1 Feature Angle

The Feature Angle is the angle above which an edge is considered as a Feature
Edge by meshing operations. Feature Edges are edges which geometry is kept
during meshing operations.
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Figure 13.7: Determination of Feature Edges depending on the specified Feature Angle

13.2.2 Gradation

The Gradation is the rate at which element size can grow on a mesh. Values
for the Gradation parameter goes from 1 (excluded) to infinity. Having a small
gradation generally improves the mesh quality (aspect ratio of created elements).

Figure 13.8: Surface mesh creation depending on the specified gradation

Remark. Gradation also applies for 3D mesh (Volume mesh, Radiation)

13.2.3 Soft / Hard edge

In ActranVI, an edge can be considered as soft or hard when being processed by
a meshing tool
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• If considered soft, the geometry of the edge is kept but this edge may be
re-meshed

• If considered hard, the geometry of the edges is kept as well as all nodes
located on this edge

Figure 13.9: Influence of considering edges soft or hard for remesh operation

13.3 Creation tools

13.3.1 The Box function

The Box function creates a box surface element set, containing quadrangles or
triangles elements.

The position and orientation relative to the global coordinate system is set through
Corner position and Rotation angle parameters.

Dimensions of the box and target element size is set using Element size and
Dimensions parameters.
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Figure 13.10: Box surface definition using the Box function

Remark. The rotation specified through the Rotation angle parameter is
done around the corner defined through the Corner position parameter.

Remark. Specifying one dimension to 0 allows to create a 2D plate (made
of quadrangles or triangles elements)

13.3.2 The Structured Mesh function

The Structured Mesh function creates either:

• A 3D structured box element set

• A 2D plate element set if one direction of the Size parameter is equal to
zero

• A 1D line element set if two directions of the Size parameter are equal to
zero

• A 0D point element set if the three directions of the Size parameter are
equal to zero

The position and orientation relative to the global coordinate system is set through
Corner position and Rotation angle parameters.

Dimensions of the box and element size on each of the directions is set using
Subdivisions and Size parameters.
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Figure 13.11: Structured mesh definition using the Structured Mesh function

13.3.3 The Circle function

Two types of geometries are available within the Circle function: Circle or Ellipse
description.

Within the Circle description, the user must only specify one single radius
corresponding to the circle radius. In the Ellipse description, first and second
radius (also called major and minor radius) of the ellipse should be entered. By
default, the first radius corresponds to the size of the ellipse in the X direction
and the second radius in the Y direction.
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Figure 13.12: Ellipse Definition

In both descriptions, the user can create either:

• A 1D circle/ellipse element set when Angle is 360 and Fill is None

• A 1D arc (of circle/ellipse) element set when Angle is < 360 and Fill is None

• A 2D disk/ellipse element set when Angle is 360 and Fill is "quad", "tria"
or "structured"

• A 2D sector (of circle/ellipse) element set when Angle is < 360 and Fill is
"quad", "tria" or "structured"

The position and orientation relative to the global coordinate system is set through
Center position and Rotation angle parameters.

The target element size is set through the Element size parameter.

Figure 13.13: Circle, Disk, Sector and Arc definition using the Circle function

Remark. By default the circle/arc/disk/sector is created on the XY plane.
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13.3.4 The Ellipsoid function

The Ellipsoid function creates a 2D full, half, quarter or eighth ellipsoid element
set containing triangles and/or quadrangles elements.

The position and orientation relative to the global coordinate system is set through
Center position and Rotation angle parameters.

The dimensions along the three principal axes are defined through the Dimensions
parameter.

The Baffles parameter triggers the creation of the mesh on the baffles

Figure 13.14: Ellipsoid definition using the Ellipsoid function

13.3.5 The Points function

The Points tool is used to create 0D nodes that can be used as field points for the
analysis. Four methods are available, they are:

• Cartesian method: to create a straight line of field points, as shown in
Figure 13.15 ;

• Polar method: to create a circular arc of field points, as shown in Fig-
ure 13.16;

• Custom method: to create field point(s) with user given coordinates;

• Field points from file: to create field points from a text file containing points
ID and coordinates;

• Cloud method: to create an ellipsoid or a box cloud composed of field
points by specifying the number of layer of points inside the cloud and the
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number of points by layer. The cloud dimensions are set with the same
methods than the Ellipsoid and the Box functions.

Figure 13.15: Creating field points using Cartesian method

Figure 13.16: Creating field points using Polar method
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The created domain can either just be used in other meshing tools, or be added
directly to the current analysis. Selecting "Field points" or "Microphones" asso-
ciates the created Domain into the scope of the "Field Points" or "Microphones"
of the active analysis.

For more information on the field points, please refer to Actran User’s Guide,
Seciton 10.4 of Volume 2.

13.4 Edit tools

13.4.1 Delete function

The Delete function simply allows to delete a selection of elements or PIDs.

13.4.2 Split function

The Split function divides the selection:

• by connection, into coherent convex parts. In addition, T junctions within
the element selection can be split as well.

• by size (number of elements), into multiple PID domains.

– across input PIDs is selected: all PIDs with the same dimension are
merged into 1 PID before splitting. As the results, a created PID can
contain elements from several input PIDs.

– across input PIDs is not selected: the split is performed separately
for each PIDs. A new PID contains only the elements from one input
PID.

13.4.3 Move or Copy function

The Move or Copy function contains a set of tools to manipulate a selection of
elements or PIDs belonging to a single topology. For all operations, one can select
to copy or move the selection using the following options:

• Into a new PID, in which all elements are merged. In this case, all elements
should belong to the same dimension and interpolation;

• Into new PIDs, where input elements are kept separated by their input
identification;

• Into an existing PID. In this case, all elements should belong to the same
dimension and interpolation, which should be the same as the existing PID;

• Into a new or existing topology.
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When copying a selection of elements or PIDs, they can be converted directly to a
0D PID by activating the corresponding option.

13.4.4 The Merge nodes function

The Merge nodes function merges nodes of input PID domains if the distance
between the nodes is smaller than the Distance parameter.

Figure 13.17: Merge nodes separated by a small distance using the Merge nodes function

If the Merge nodes function leads elements to collapse, these elements are deleted

Figure 13.18: Collapsed element are deleted after using the Merge nodes function

The Merge nodes function allows to discard unwanted duplicated nodes. Dupli-
cated nodes can be detected using the Check for duplicated nodes option of the
topology.
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Figure 13.19: Combined use of Check for duplicated nodes and Merge nodes function to
merge duplicated nodes

13.4.5 The Reinterpolate function

The Reinterpolate function changes the interpolation of the input elements to
Linear or Quadratic depending on the specified target interpolation

Figure 13.20: Use of the Reinterpolate function to change the interpolation order of an
element set
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13.5 Edge tools

13.5.1 The Edges function

The Edges function creates a 1D element set containing bar elements. The output
mesh consists of the original edges linked with new edges.

The Connection Type controls the element size on the new edges:

• Direct : the new edges contains only one element

• Custom edge size : the element size on the new edges is equal to the
specified Element size parameter

• Auto edge size : the element size on the new edges is driven by the size of
the elements from which the junction points belong to and the Gradation
parameter

In addition, the Sort by node ID option allows to follow the external numbering
rather than the closest distance to connect by edged.

The algorithm accepts either 0D or 1D entities. When handling 1D entities as
input, the algorithm will try to close edge loops. When providing 0D entities, the
provided 1D elements will not be closed. This is then used to connect 2 or more
points together, following their external numbering or distance.

The algorithm detects every available junction points and links it to the closest
other junction point:

Figure 13.21: Create 1D elements to close an edge using the Edges function

13.5.2 The Spider function

The Spider function creates a 1D element set containing bar elements which all
connect each individual node provided to a central node, generating a spider
element. These spider elements can directly be used a mean constrain or rigid
body elements.

The master node of the spider element can be chosen:
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• Center: Default behavior. The master node is generated at the geometrical
center of all selected nodes or PIDs.

• Position: The geometrical position of the master node is explicitly defined
by the user.

• Id: A Node Id can be provided as master node, which will directly link the
spider element with this latest.

Figure 13.22: Different options of master node for the Spider tool

13.5.3 The Remesh edges function

The Remesh edges function allows to remesh existing 1D PIDS while keeping
grids attached to other PIDs as fixed. This can be used to refine or coarsen
existing 1D PIDS while keeping the shape in case of corners and chamfers. Four
options are available:

• The Element size is the maximum edge size the function should return.

• The Feature angle defines the angle between edges in the original mesh
above which the grid will be assumed to be fixed. The feature angle might
not be respected in the output mesh.

• The Minimum feature size specifies a length below which edges will not be
considered as a feature. This insures not to account for tiny elements. By
default, this is set to 0.

• The Chordal distance is the maximum distance with respect to the original
mesh, which can enable local refinements of the meshes in order to insure
curvatures are correctly respected.
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Figure 13.23: Remeshing of existing edges accounting for feature edge and chordal distance,
with local refinement

13.6 Surface tools

13.6.1 The Fill Holes function

The Fill Holes function allows to fill holes in 3D or closed 2D element sets. The
created 2D element set contains the triangles elements that fill the detected holes.
Holes detection is controlled by a maximum diameter parameter and a feature
edge parameter.

Holes with a diameter bigger than Max Hole Diameter won’t be filled.

Figure 13.24: Fill holes: The Max hole diameter parameter

The Feature Angle parameter controls which edges can define a hole. If the
element edge angle is higher than the Feature Angle value, then it can define a
hole.

262



ActranVI Meshing tools

Figure 13.25: Fill holes: The Feature angle parameter

The Mode parameter controls the way the holes will be filled:

• Fast : fills the holes using the fewest elements possible

• Boundaries : fills the holes with the same element size as the holes bound-
aries elements

• Custom : fills the holes with a target element size driven by the Element
size parameter

Remark. If a 2D surface contains openings, the Fill Holes function may
fill these openings but is not always able to detect and fill them. To fill
openings on a 2D surface, the Surface mesh function should be preferred.

13.6.2 The Exterior Shrinkwrap function

The Exterior Shrinkwrap function creates a 2D element set that wraps the input
element sets.

The element size is driven by the Shrink element size parameter.

The distance between the shrinkwrap surface and the input mesh is set by the
Distance parameter.
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Figure 13.26: Use of the Exterior Shrinkwrap function to obtain a closed surface around a
part

Remark. When the Distance parameter is set to 0, the smallest possible
distance (Topology mesh tolerance) will be used.

13.6.3 The Interior Shrinkwrap function

The Interior Shrinkwrap function creates 2D element sets that wrap the interior
of input 2D and 3D element sets. If the input selection contains 3D element sets
the skin of these element sets will be considered.

The element size is driven by the Shrink element size parameter.

The distance between the shrinkwrap surface and the input mesh is set by the
Distance parameter.

Figure 13.27: Use of the Interior Shrinkwrap function to obtain a closed surface inside a
part

Remark. When the Distance parameter is set to 0, the smallest possible
distance (Topology mesh tolerance) will be used.

The Minimum Cavity Volume parameter is used to prevent the Interior
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Shrinkwrap function from outputting unwanted small cavities. All cavities
with a volume smaller than the specified value will be discarded

Figure 13.28: Use of the minimal cavity volume parameter to filter the output of the
Interior Shrinkwrap function

Remark. The volume of each detected cavity is not computed on the final
mesh output by the function. Some small differences in volume can therefore
be observed between the value entered for the parameter and the volume of
the created cavity

13.6.4 The Surface mesh function

The Surface mesh function creates a 2D element set based on a set of edges. If 2D
element sets are provided as input, the skin of these surfaces will be used

The Surface fill method parameter allows to choose the desired algorithm to
create the surface mesh:

• Fast (Default) algorithm will perform a simple tessellation

• Fitted will apply a Mesh on Mesh on top of the Fast tessellation. The
Element size parameter drives the target element size of the create mesh

• Planar will use a surface filling algorithm with gradation control providing
better mesh quality but only works to create planar surface. The Element
size parameter drives the target element size of the create mesh and the
Gradation factor parameter controls how fast element size can grow on the
created mesh
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Figure 13.29: Surface mesh filling methods

The Group by edge loop parameter drives the way the Surface mesh considers
the input mesh when it contains several edge loops:

• If the Group by edge loop parameter is not activated, the Surface mesh
function will create one surface between all edge loops. If the Planar
fill method is selected the median plane is calculated and the edges are
connected to this plane

• If the Group by edge loop parameter is activated, each edge loop is filled
independently

Figure 13.30: Surface mesh: The Group by edge loop parameter

If every edge loop is on the same plane and one edge loop includes the others,
the Surface mesh function with planar method creates a surface between the edge
loops if the Group by edge loop parameter is not activated
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Figure 13.31: Surface mesh: Creating a surface between several edge loops

If the input mesh does not contain closed loops, an implicit Edges operation is
performed to close the edge loop.

13.6.5 The Mesh on Mesh function

The Mesh on Mesh function re-meshes the 2D input element(s) set(s) using the
Element size and Element type parameters.

The user has the choice between two meshing methods:

• "Classic" method. This method is used in previous Actran versions as well.

• “Flexible” method. This is proposed as an alternative to the classic meshing
tool. It is advised when handling intersections due to the remeshing of
very close surfaces and models with a high number of degrees of freedom.
Using the “flexible” method, an additional parameter can be defined. This
is the chordal distance parameter, a relative value expressed as a percentage
of the element size. This parameter multiplied by the element size defines
the maximum distance of the new mesh from the original one.
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Figure 13.32: Mesh on Mesh: Chordal distance

All parameters presented below are available for both methods.

When the Auto feature recognition is activated, the Angle defeaturing parameter
controls which edges will be kept. If the element edge angle is higher than
the Angle defeaturing value, then the edge will be kept by the Mesh on Mesh
function.

Figure 13.33: Mesh on Mesh: The Angle defeaturing parameter

The Free edges parameter controls how the Mesh on Mesh function will remesh
the free edges:

• If "Hard" is selected, the nodes of the free edges are kept in the new mesh.

• If "Soft" is selected, only the geometry of the free edge is kept.

Remark. If nodes are connected to element sets that are not contained in
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the input selection, the nodes are kept regardless the Free edges parameter
definition.

Figure 13.34: Mesh on Mesh: The Free edges parameter

Inner interfaces parameter controls how the interfaces between the several element
sets selected will be handled.

• If "Hard" is selected, the nodes and edges length at the interfaces are
untouched. No intermediate points are created on the interfaces edges. The
Mesh on Mesh output will keep input element sets separated.

• If "Soft" is selected, only the geometry of the edges at the interfaces is
kept. This means the edges are remeshed (new points) to match the target
Element size parameter. The Mesh on Mesh output will keep input element
sets separated.

• If "Merge" is selected, interfaces between element sets in input selection are
not taken into account. The Mesh on Mesh output will contain only one
element set.

Figure 13.35: Mesh on Mesh: The Inner interfaces parameter
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13.6.6 The Convexhull function

The Convexhull function creates a 2D element set corresponding to the convex
envelope of all input element sets. The created surface is located at the minimal
distance Distance from any input element set.

One or more baffle planes can be defined using the Baffle planes parameter: the
created mesh will be bounded by these planes, still remaining a convex surface.

Baffle planes parameter X, Y and Z values (x,y,z) correspond to the X=x, Y=y and
Z=z planes.

Figure 13.36: Use of the Convexhull function to create a convex surface around a gearbox

13.6.7 The Skin function

The Skin function extracts the skin of the input element sets:

• If the input mesh is 3D, a 2D element set is created

• If the input mesh is a non-closed 2D element set, a 1D element set is created

• If the input mesh is a non-closed 1D element set, a 0D element set is created
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Figure 13.37: Skin: Output mesh depending on input mesh dimension

Interfaces parameter controls how the interfaces between the several element sets
selected will be hanlded.

• If "supress" is selected, the inner interfaces are removed from output mesh.

• If "only" is selected, only the inner interfaces are kept in the output mesh.

• If "keep" is selected, skin around both input element sets is completely kept.

Figure 13.38: Skin: Output mesh depending on interfaces parameter
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13.6.8 The Quads to Triangles function

This function creates a 2D mesh containing only triangle elements with the same
interpolation order than its input meshes. The output mesh consists in splitting
all the quadrangles elements from the input meshes.

Figure 13.39: Split quadrangle elements to triangle elements on a 2D ellipsoid

Quadrangle elements are split on their shortest diagonal. This provides the best
aspect ratio for the created triangle elements.

Remark. As the Volume mesh function can only be used on element sets
containing only triangle elements, the Quads to Triangles function is often
used before performing a Volume mesh.

13.6.9 The Flip Normals function

The Flip Normals function allows to reverse or regularize the normals of 2D PIDs
(or 1D PIDs in 2D topology) selected through PID selection. Three options are
available:

• Inverse option: the normals of selected 2D PIDs (or 1D PIDs in 2D topology)
are flipped to the opposite direction.

• Inside/Outside options: the normals of closed 2D PIDs (or 1D PIDs in
2D topology) are set to be consistently pointing inward/outward. For
non-closed surface(s), these options are used to regularize the normals.

272



ActranVI Meshing tools

Figure 13.40: a) The normals are reversed. b) The normals are regularized

13.6.10 The Intersection function

The Intersection function enables to identify and create the edges that are at
the intersection of different surfaces. ´The user can choose between two input
methods: PID or stored selection. Default method is the PID selection that will
perfom the intersection between two or multiple 2D PIDs. The stored selection
method allows to intersect portion of 2D mesh that were previously selected by
the user. The PIDs/selections have to belong to the same topology.

Figure 13.41: Intersection tool with PID selection
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Figure 13.42: Intersection preview

13.7 Volume tools

13.7.1 The Volume mesh function

This function creates one 3D mesh from one or several 2D closed input element
sets. The output mesh can consist of tetrahedral, hexahedral and pyramid
elements with the same interpolation order than the input mesh(es).

The output mesh element size is driven by the Element size parameter and the
Gradation factor parameter. Without the All Cavities option, only one 3D mesh is
generated and it is expected the provided surfaces should define a closed surface
with or without interior closed surfaces. With the All Cavities option activated,
all possible volume definitions will be accounted for and meshed individually. A
separate 3D volume mesh will be provided for all individual volume detected.
An example of this method is provided in Figure 13.44.

• If Hexacore method is not activated, the volume mesh generated will be
filled with tetrahedral elements. There can be pyramid elements in the
transition zone if the input surface mesh contains quadrangular elements.

• If Hexacore method is activated, the volume mesh generated will be filled
with Cartesian hexahedral elements (aligned with global coordinates system
or with the provided orientation vector) in the inside and blended with
tetrahedral/pyramid elements in the transition zone to the input surfaces.
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Figure 13.43: Use of the Volume mesh function to create a 3D mesh between two ellipsoids

Figure 13.44: Handling of multiple cavities in the Volume mesh tool

13.7.2 The Extrude function

The Extrude function creates a mesh by extruding the input element set(s).

If the input selection contains 2D elements sets, the Extrude tool outputs a 3D
element set corresponding to the extruded volume and one (or two) 2D element
set(s) corresponding to the extruded surface (and the side surface if the input
element sets have free edges).

If the input selection contains 1D elements sets, the Extrude tool outputs a 2D
element set corresponding to the extruded surface and one (or two) 1D element
set(s) corresponding to the extruded edge (and the side edge if the input element
is not a closed edge).
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Figure 13.45: Extrude: Output mesh depending on input mesh dimension

The extrusion is done following normal vectors. These vectors can be computed
using the different methods below:

• Vertex normal (only available for 2D elements sets input in 3D topologies
and 1D elements sets input in 2D topologies): the normal vector of each
node is computed based on the normal vectors of surrounding elements.
One or more baffle planes can be defined: the normals of nodes on the
baffle planes is then modified to match the plane orientation.

• User defined normal: the user defines a normal vector by its three compo-
nents (X,Y,Z), which will be the same for all nodes.

• From center: the user defines a center by its three coordinates (X,Y,Z) : the
normal for each point is defined by the direction between the center and
the node.

Figure 13.46: Extrude: Output mesh depending on normal method used

13.7.3 The Layers function

The Layers function creates a mesh by extruding the input element set(s), but
reconstructs the elements when facing self-intersections and insures a correct
element size is produced.

The input selection must contain 2D elements sets, the Layers tool outputs a 3D
element set corresponding to the extruded volume and one (or two) 2D element
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set(s) corresponding to the extruded surface (and the side surface if the input
element sets have free edges).

The extrusion parameters are identical to the Extrude meshing tool. The internal
element size can be select as follows

• Free: Chosen by default, the extrusion size will be made as defined and the
reconstruction of the elements will have no restrictions in element size.

• Input surface: The local element size of the provided surface will be taken
to insure all extruded layers and reconstructed parts corresponds to this
element size.

• User defined: Provided element size, both for the extrusion and the recon-
struction.

13.7.4 The Revolve function

The Revolve function creates a mesh by revolving the input element set(s).

The revolve total angle is driven by the Angle parameter, and the rotation axis is
defined by the Rotation axis origin and Rotation axis vector parameters.

The number of layers is driven by the Steps parameter.

Figure 13.47: Examples of usage for the Revolve function

If the Revolve function is applied with Angle = 360 and the surface located at the
end of the rotation coincide with the input mesh, all nodes located at the input
mesh location are not duplicated. The created mesh is therefore not cut at the
input mesh location.

If nodes are located on the rotation axis they are not duplicated by the Revolve
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function.

Figure 13.48: Nodes located on the rotation axis or duplicated nodes are merged

13.7.5 The Radiation function

The Radiation function is an "all-in-one" function very useful for automatic mesh
generation of acoustic radiation problems. This tool consists in the combination
of 4 meshing tools: the Convex Hull, the Mesh On Mesh, the Surface mesh, and
the Volume mesh. It works in three steps:

• First a convex hull surface mesh is generated at the distance specified
through the Volume thickness parameter. One or more baffle planes can
be defined along X, Y, or Z direction : the created surface mesh is then
bounded by these planes, still remaining a convex surface.

• The previously created surface is then remeshed by a Mesh On Mesh
operation. The surface element size is driven by the Element size parameter.

• If baffle planes were defined, the baffles are created using a Plane from edge
operation. The surface element size is driven by the Element size parameter.

• A 3D mesh is created by a Volume mesh operation performed between
element sets in input mesh and the convex mesh surface generated by the
previous steps. The size of the tetra elements is driven by the Element size
and the Gradation factor parameters

This meshing tool creates a 2D mesh corresponding to the convex surface and a
3D mesh corresponding to the volume generated by the Volume mesh operation.
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If one or more baffles are defined, 2D meshes corresponding to these baffle
surfaces are also created.

The output 2D mesh contains only triangular elements and the output 3D mesh
is made up of tetrahedral/hexahedral/pyramid elements, with the same interpo-
lation order as its input mesh(es).

Remark. If the input mesh is a closed 2D element set, baffle planes cannot
intersect the input element set. If the input mesh is an open 2D element set,
the free edges must be located on the baffle planes.

Figure 13.49: Use of the Radiation fonction on a closed 2D surface mesh with one baffle

Figure 13.50: Use of the Radiation function on an open 2D surface mesh with two baffles
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13.8 Transform tools

13.8.1 The Translate function

The Translate function is used to copy or move input element sets by applying a
translation.

The translation operation is done along a vector defined by the Vector and (Scale)
Factor parameters.

If the Replace input PIDs is activated, the input element sets are moved. If not,
they are copied.

Figure 13.51: Use of the Translate function on a cube mesh

If some element sets in the input mesh share nodes with PID domains not
contained in the input mesh, the Move nodes at interfaces parameter specifies if
theses nodes should be moved (ticked) or remain fixed (unticked)

Figure 13.52: Transform tools: the Move nodes at interfaces parameter
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13.8.2 The Rotation function

The Rotation function rotates the input meshes using one of the two methods
below:

• Rotation around the coordinate system centered on the Origin with angles
Rotation angles (in degrees). The rotation sequence is executed in the same
order than the coordinate system (X then Y then Z)

• Rotation around a user-defined axis, defined by the Origin and Rotation
axes parameters. The rotation angle is specified through the Rotation angle
parameter

Figure 13.53: Use of the Rotation function on a cube mesh

Remark. For Replace input PIDs and Move nodes at interfaces parameters
please refer to function Translate.

13.8.3 The Scale function

The Scale function scales all element sets in input. The scaling is done by
translating the nodes of all the input element sets in the following way: the
distance from the point defined by the Origin parameter and a particular node
is projected on each global axis and multiplied by the Scale factor component
corresponding to this axis.
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Figure 13.54: Scale function usage

Remark. For Replace input PIDs and Move nodes at interfaces parameters
please refer to function Translate.

13.8.4 The Mirror function

The Mirror function creates symmetric mesh with respect to a symmetry plane.

The symmetry plane is defined by three points (Point 1, Point 2 and Point 3
parameters).

All nodes located exactly on the symmetry plane are not duplicated, therefore
the input and output element sets are fully connected on the symmetry plane.

If the Merge mirror with input parameter is activated the created mirror mesh
will be placed in the same PID as the input mesh.

Figure 13.55: Use of the Mirror function to create a full model from a symmetrical model
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13.8.5 The Align function

The Align function projects all the nodes of the input element sets on a plane.
This plane is defined by three points (Point 1, Point 2, Point 3 parameters).

Figure 13.56: Align the face of a cube to a plan using the Align function

Remark. For Replace input PIDs and Move nodes at interfaces parameters
please refer to function Translate.

13.9 Other tools

13.9.1 Extract Blade Tool

The Extract blade is a specific ActranVI meshing tool for automatic extraction
of profiles from a blade surface mesh. It is only available in a Potential Flow
analysis data tree, where a Blade component, as well as its profiles are created
during the extraction procedure. It works by setting specific cut planes along
the blade mesh to create closed profiles. A visual representation can be seen in
Figure 13.57.

The Extract blade tool can be accessed by double clicking on the Extract Blade
icon located on the data tree of Potential Flow Analysis. A new property window
will pop up, as shown in Figure 13.58, with the following options:

• Topology: Selection of topology containing the input blade mesh. Only 2D
meshes are supported for this tool

• Origin: center of the angular section (extraction surface enclosure) which
must be equivalent to the center of the blade to be created.

• Rotation Axis: Axis of blade rotation
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Figure 13.57: Representative scheme explaining the Extract blade tool. (a) Imported blade
mesh (or CAD) in ActranVI. (b) Setting the blade and cut plane parameters for extracting
the profiles. (c) Blade component automatically created with extracted profiles.

Figure 13.58: Extract blade window.

• Transverse Axis: Axis along the blade length

• Radius Offset: radial position offset of the cut plane with respect to
Origin

• Radial Positions: radial positions of the cut planes along the transverse
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axis where profiles will be created

• Height Section: height of the cut plane at each radial position

• Angle Centers: angular position of the cut plane center point on the
azimuthal direction of the rotor

• Angular Section: angular section of the cut plane with respect to Origin

• Twist angles: twist angles (or pitch) at each cut plane. Please check figure
?? for a more detailed explanation about this parameter.

• Number of subcuts: number of sub cut planes created between each pair
of cut plane

• Resolution: number of nodes to define extracted profile resolution on the
cut planes

• More:

– Bend angles: bend angles (or rake) at each cut plane. Please check
figure ?? for a more detailed explanation about this parameter.

– Roll angles: roll angles (or screw) at each cut plane. Please check
figure ?? for a more detailed explanation about this parameter.

• Visualization: activate real-time visualization of the axis and cut planes
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Fourteen

ActranVI Unit Systems

14.1 Introduction

Since Actran 2020, unit systems are fully supported within the solver and the
graphical user interface. This feature includes:

• The display of the unit of any parameter inside ActranVI;

• The capability to convert in one click a complete analysis (or one of its
ingredients) from one unit system to another;

• The ability to handle seamlessly modal components, topologies, materials, ...
defined in different unit systems.

The following sections aim at detailing the different points mentioned above.

14.2 Unit system levels

Before going further, it is mandatory to understand that three different unit
system levels exist in Actran:

1. The ActranVI unit system;

2. The analysis unit system;

3. Local unit systems in some ingredients of the analysis (modal components,
topologies, materials, ...).
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The following unit systems are available at each level:

• SI: Meter - Kilogram - Second (default value);

• MMKG: Millimeter - Kilogram - Second;

• MT: Meter - Ton - Second;

• MMT: Millimeter - Ton - Second;

• INLB: Inch - Pound-force - Second;

• FTLB: Foot - Pound-force - Second.

14.2.1 ActranVI unit system

The first level corresponds to the ActranVI unit system. It is set in the Settings
of the application and is used for two aspects.

On the one hand, it defines the unit system of the visualization, that is to say the
length unit of the render window (viewports) and of the "Measure", "Info" and
"Mesh quality" tabs (see Figure 14.1). Note that the application needs to be closed
and re-opened to function properly after a change in the unit system setting.

Figure 14.1: The ActranVI unit system determines the visualization length unit
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On the other hand, the ActranVI unit system is used as a default value to
initialize the unit system of any new analysis, topology, material or table created
within the application. In addition, when importing an analysis created by a
version of Actran older than the 2020 release, its unit system will be taken as
the one of the application. A warning message (see Figure 14.2) is displayed on
screen in this situation.

Figure 14.2: The ActranVI unit system is used if no unit system information is available
in the input file

14.2.2 Analysis unit system

The second level is the analysis unit system. Most importantly, this is the unit
system in which the computation is run. The unit system of a new analysis
created in ActranVI is initialized following the application unit system. At
any moment, the unit system of an analysis can be changed in the header of its
property window (see Figure 14.3).

Figure 14.3: The analysis unit system can be found in its property window

Remark. Although it is not mandatory, it makes sense to use ActranVI
in the same unit system as the analyses that are usually dealt with. The
usage of the unit system feature in the graphical user interface is thereby
more natural.

In the Actran input file, the analysis unit system is defined in the PARAMETER
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datablock. Two cases can be distinguished when importing an analysis:

• A specific unit system is defined in the PARAMETER datablock: it unambigu-
ously defines the analysis unit system;

• No unit system information is available in the PARAMETER datablock: the
unit system of the imported analysis is set to the ActranVI unit system.

From the solver point of view, the analysis unit system is the one in which the
computation is performed. Therefore:

• Prior to the computation, the solver will automatically convert the properties
of modal components, topologies, materials, ... from their local unit system
(see below) to the analysis unit system;

• All the output results (FRF, maps, ...) will be expressed in the analysis unit
system.

14.2.3 Local unit systems

For some ingredients of the analysis, the user has now the possibility to define
unit systems at a third level, namely as local unit systems. These can be different
from the analysis unit system. The list of entities supporting a local unit system
is given below:

• TOPOLOGY ;

• MATERIAL ;

• TABLE ;

• FIELD ;

• BC_MESH ;

• MODAL_ELASTIC , MODAL_ACOUSTIC , VISCOTHERMAL_MODAL_ACOUSTIC and
SUPERELEMENT_DMIGOP2 .

In ActranVI, the initial local unit system of a newly created entity depends on
its nature:

• For new fields, modal components, superelements and BC Mesh boundary
conditions: the local unit system is inherited from the analysis unit system;
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• For new topologies, materials and tables (which do not refer to an analysis):
the local unit system is set to the ActranVI unit system.

As for the analysis unit system, a local unit system can be changed at any moment
in the header of the property window (see Figure 14.4).

Figure 14.4: The local unit system can be found in the property window of its entity

When interpreting an Actran input file, local unit systems that are not explicitely
specified (using the appropriate keyword) are supposed to be the same as the
analysis unit system.

14.3 Unit display

The units of any property having a physical dimension are displayed in the
property window of any analysis, component, boundary condition, ... These units
are expressed in the analysis unit system, or in the local unit system when it
exists.

In the example of Figure 14.5, the units are displayed in MMT for the fluid material
(local unit system), but the thickness of the thin shell component is displayed in
SI (no local unit system, hence unit system of the analysis).

Figure 14.5: Display of units
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14.4 Unit conversion

14.4.1 In ActranVI

All unit systems presented in the previous sections can be changed by the user
in a single click, using tools available in the property windows of analyses and
entities supporting local unit systems. When changing a unit system, the user
can choose whether physical properties will be converted or not. The following
examples illustrate the two possibilities.

Let us take a fluid material for which the speed of sound is set to 340000 and
the fluid density to 1.225e−12 (see Figure 14.6). These values correspond to air
properties expressed in MMT. However, the local unit system of the fluid material
is initially defined as SI. To reach a consistent state, the user needs to switch the
unit system from SI to MMT without conversion of the fluid properties. This is
done by simply changing the local unit system in the property window. The fluid
material is finally defined in MMT with consistent properties.

Figure 14.6: Unit system change without conversion of properties

Remarks
• If the unit system change is performed on the analysis, it will only impact

the components, boundary conditions, ... which do not have a local unit
system.

• The fluid material expressed in MMT can be referred in an analysis defined
in SI. The conversion of fluid material properties will be performed auto-
matically within the solver.

Let us now imagine that the fluid material is properly defined in MMT, but that
the user wants to have it expressed in another unit system (see Figure 14.7). In
this case, one needs to switch the unit system and to convert the properties of
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the material. This is done by using the unit conversion tool accessible through
a button in the property window. This tool performs the complete operation
at once. After the desired target unit system has been specified, the local unit
system of the material is adjusted and its properties are automatically converted.

Figure 14.7: Unit system change with conversion of properties

Remarks
• The unit conversion does not have any impact on external files.

• If the unit conversion is performed on the analysis, it will only impact the
components, boundary conditions, ... which do not have a local unit system.

• The modal components, superelements and fields do not have the unit
conversion tool. Indeed, they do not have properties with a physical
dimension that would need to be converted.

A tool is available in ActranVI to change many unit systems at once. The layout
of this Global unit system change tool is shown in Figure 14.8.

The tool can change the unit systems of either or all of the followings:

• all topologies,

• all materials,

• all tables and/or

• any analyses

with or without automatic conversion of their properties.
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Figure 14.8: Layout of the Global unit system change tool

Remarks
• For analyses, the change is applied to all children, including those with a

local unit system.

• The conversion does not have any effects on fields, the array in tables, and
external files.

14.4.2 In the solver

When local unit systems different from the analysis unit system are detected in
an input file, the solver will convert automatically the related properties from the
local unit systems to the analysis unit system, before running the computation. It
is therefore now possible to define an analysis in SI containing:

• a topology expressed in MMKG;

• a Finite Fluid component referring to a fluid material expressed in INLB;

• a Modal Elastic expressed in MMT;

• a Porous UP component referring to a poro-elastic material expressed in MT;

• ...
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This analysis can be exported in an Actran input file and run as is, without any
effort from the user.

14.5 Compatibility with the keywords LENGTH_UNIT
and MASS_UNIT

In versions of Actran older than the 2020 release, local unit systems already
existed for topologies, modal components and BC Mesh boundary conditions.
They were then handled in terms of LENGTH_UNIT and MASS_UNIT keywords.
While backward compatibility is ensured, these keywords will be replaced by the
UNIT_SYSTEM keyword from Actran 2020 onwards.

When importing an analysis containing LENGTH_UNIT and MASS_UNIT key-
words, ActranVI will adapt the local unit system of the topologies, modal
components or boundary conditions accordingly. For instance let us imagine
that we import in ActranVI set in SI (in the settings) an analysis without unit
system information in the PARAMETER datablock, but containing a modal elastic
component with LENGTH_UNIT = 0.001 and MASS_UNIT = 1000. In this situa-
tion, the analysis unit system will first be set to SI. Then, the LENGTH_UNIT
and MASS_UNIT will be interpreted with respect to this analysis unit system,
leading to the local unit system MMT for the modal elastic component.

If the LENGTH_UNIT and MASS_UNIT values cannot be matched to a supported
unit system, a clear warning message will be displayed on screen at the import
of the analysis (see Figure 14.9). In that situation, the user should first check
that the unit system set for the analysis is correct. If not, the appropriate unit
system information should be added in the PARAMETER datablock of the input file,
to ensure that the analysis unit system is determined with no dependence on the
application setting. If the problem persists even with the correct analysis unit
system, we advise the user to adapt manually the topology dimensions using for
instance the "Scale" meshing tool.

Figure 14.9: Error message displayed when no matching is found between old
LENGTH_UNIT and MASS_UNIT keywords and a currently supported unit system
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Fifteen

ActranVI Material
Encryption

15.1 Introduction

Since Actran 2023, it is possible to encrypt materials so that users can exchange
material data to run simulations but without giving access to material properties
considered as industrial secrets. Two possible workflows can be followed inside
ActranVI:

• Encrypt a material used inside the analysis;

• Export a material in an encrypted format. This material can be used
afterwards in an analysis.

In both cases, material encryption is handled through the Graphical User Interface.
Also, encryption settings play an important role in restricting the access to the
encrypted material.

Please note that encryption operation is not reversible.

In the following sections, we will detail the different points mentioned above.

15.2 Encryption settings

Before starting any material encryption, the user should pay attention to the
settings used for it. In ActranVI settings panel, users have the possibility to
define the three following parameters (as shown in 15.1:
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Figure 15.1: Encryption settings

• Encryption private key: this is the key that allows the usage of the
encrypted material. By default, a random key is generated;

• Target ceid(s): this is the Customer Entitlement ID (CEID). The CEID
is very important to target only the user(s) that will be able to use the
encrypted material. Only a single CEID can be specified. It is also possible
to use the keyword (current) that is equal to specify the CEID of the user
that is performing the encryption and the keyword all that entitles every
user. By default, it is set to all;
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• Key expiration date: This allows to specify the limitation in time of the
encrypted file. The default value is set to none (no expiration in time). If
requested, the expiration date should be introduced in the following format
dd/mm/yyyy.

15.3 Encrypt a material used inside the analysis

One workflow is to encrypt one or multiple materials that are used in an Actran
analysis.

Once the settings are specified, the user can encrypt the material as follows:

• Go in the contextual tab of the material in the ribbon and use the encryption
button;

Figure 15.2: Encrypt material in the material contextual tab

• Right click on the material in the datatree and select Encrypt Material;

Figure 15.3: Encrypt material in the right click menu datatree

Both ways are equivalent. Once the material is encrypted in the interface, it is
not possible to retrieve the original properties. An encrypted material can be
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distinguished from the others since its icon in the datatree is superimposed by a
lock.

Figure 15.4: Encrypted material in the datatree

15.4 Export a material in an encrypted format

Materials can be encrypted independently from a specific analysis. In this case,
the workflow consists in exporting all materials by right-clicking on "Materials"
and choose the encrypted format Actran *.edat or *.dat and *.bdfe. Note that it is
not possible to export (and encrypt) a single material only ; all materials should
be exported at once.

Figure 15.5: Encryption at the export

Material properties will still be visible in ActranVI.

15.5 Limitations

Encrypted material is supported only for fluid, solid and porous materials.
Materials referring to table properties cannot be exported in *.bdfe file format.
Users can specify only one target ceid at the time.
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Sixteen

PLTViewer Overview

16.1 Introduction

The PLTViewer is the dedicated post-processing utility to visualize Actran and
experimental frequency response functions (FRF). It contains various operators
(such as dB, TL indicator, NR indicator,...) which allows computing, plot, compare
and export a wide range of quantities.

The main components of the PLTViewer User Interface are listed below and
displayed in Figure 16.1:

1. Menu: The menu gives access to main functionalities;

2. Data Tree: The data tree contains all imported quantities from PLT, UNV,
TXT, CSV, Actran WAV, MDF and Punch files. Please refer to Chapter 18
for more details

3. Function Panel: This panel is used to define the functions that are plotted
in the figures. These XY functions usually refer to results available in
the Data Tree Content (using certain operators), and respect the Python
syntax. Built-in functions are also available. Please refer to Chapter 19 for
more details;

4. Render Window: The render window (refer to Chapter 20 for more details)
manages the visualization of the frequency response functions defined in
the Function Panel. It contains 3 panels:

(a) Figure Panel: Different figures can be created to display the requested
quantities.
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(b) Curve Panel: The curve panel allows editing and controling the visual-
ization of the different curves present in one figure.

(c) Figure Properties Panel: The properties of the figures can be modified
in this panel.

Figure 16.1: Global layout of the PLTViewer.

16.2 Launching the PLTViewer

Multiple ways for launching the PLTViewer are available:

1. The PLTViewer can immediately be accessed from ActranVI through the
toolbar (Tools→PLTViewer).

2. PLTViewer can be launched from the prompt by typing the command:

actran -u PLTViewer [-n|--no_graphics] [-x|--execute]...
[-i|--import_file] [-b|--background]
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where

-n,--no_graphics : PLTViewer will be launched without rendering win-
dow (batch mode);

-b,--background : PLTViewer will be launched in background mode
(graphics mode but the application window is minimized in taskbar);

-x,--execute= : the execution of the specified PLTViewer script will be
performed;

-i,--import_file= : the specified result file will be imported.

3. For Windows user, the PLTViewer can be launched using the shortcut
created during installation in Start menu.

On Windows, a result file can also be opened by right-clicking the .plt file.

Trace files and session files are systematically created and contains respec-
tively all software information and the different operation performed within
the PLTViewer. The session file can be re-used for several purposes, as explained
in Chapter 27.
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PLTViewer Menu

The main menu bar is located at the top of the PLTViewer application. Different
menus are available:

• File;

• Figure;

• Utilities;

• Help.

17.1 "File" menu

The File menu of PLTViewer allows performing global actions. These actions are
gathered in three groups:

1. Load or export session files (Section 17.1.1)

2. Import results (Section 17.1.2)

3. Export results (Section 17.1.3)

4. Modify the PLTViewer settings (Section 17.1.4)
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Figure 17.1: Menu of the PLTViewer.

17.1.1 Scripting and Session Files

Like for ActranVI, an API (Application programming interface) is available for
PLTViewer in order to write and read PLTViewer commands in a session file.
When opening the PLTViewer, a session file is automatically created. Such file
can, for instance, be used for:

• Re-launching PLTViewer in the latest state;

• Retrieving a stable status of the PLTViewer when a crash appears (by
suppressing different lines for instance);

• Re-using a post-processing procedure on a different set of results;

• Automating the post processing operations of Actran PLT files.

The current script file is automatically indented with the commands operated
within the PLTViewer, written in the python format (www.python.org). Every
available command within the PLTViewer can be accessed through this API.
More information about the Sessions and API of PLTViewer can be found in
Chapters 30 and 27.

17.1.2 Importing Results in PLTViewer

The PLTViewer supports the following results file:

• PLT (Actran result file);
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• TXT (ASCII column files);

• CSV (Comma Separated Values files);

• UNV (IDEAS Universal; data block type 58);

• WAVE (Actran wave files);

• PUNCH (Nastran PUNCH files);

• XYPUNCH (Nastran XYPUNCH files);

• HDF5 (Nastran HDF5 files);

• MDF (Adams files).

When importing a PLT file, a plt set is created and its content is displayed in the
data tree panel (see Section 18). The leaves of the tree are vectors of data and can
be used to create functions.

Text files with columns formatted data (see below) can also be imported.

0 5.02e-6 5.4
1 4.52e-6 3
2 5.21e-6 6

17.1.3 Exporting Results in PLTViewer

Functions that are present within a figure may be exported in ASCII column
format (TXT) or comma separted values format (CSV). This allows exporting
post-processed results. Exporting results may only be done if the different curves
present within the figure have a X vector of the same length.

17.1.4 Settings

In the settings of the PLTViewer, the General tab (see Figure 17.2) can be accessed
to:

• Select a folder containing all the scripts that you may have written for spe-
cific post-processing operations. These scripts are loaded with PLTViewer

and are therefore available in the python console.

• Choose either or not you want a confirmation for several actions (clear all,
...).
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• Choose to overwrite or not the session file created the last time you opened
PLTViewer. If this option is unchecked, a unique session file is created
each time you launch the application.

Figure 17.2: PLTViewer Settings: General

In the Default properties tab (Figure 17.3) , various default properties related to
the curve plotting can be set.
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Figure 17.3: PLTViewer Settings: Default properties

17.1.5 Remarks and Further Reading

• The plt2audio utility allows generating Actran wave files (please refer to
Section 58.13 of Volume 1);

• The format of the Actran .plt results file is described in Section 12.5 of
Volume 1;

• The plt_get utility allows post-processing the Actran .plt file into column
files (see Section 58.1 of Volume 1);

• More information about the API of PLTViewer can be found in Chapter 30.
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Eighteen

PLTViewer Data Trees

18.1 Introduction

The data tree contains all quantities imported from PLT, UNV, TXT, CSV, Actran

WAV, MDF and Punch files. Each imported file is represented as an individual
set that can be renamed or removed. When the data is imported from a file, the
results are automatically parsed and subdivided in different sections, depending
on the type of imported file.

In general, the PLTViewer access arrays of results (with respect to the time or the
frequency) for generating functions and plots.

18.2 Content of the Data Tree

The data tree lists all the imported result files, and parses it depending on their
type. In general, one can distinguish Actran result file and general ASCII
column result files.

For each indicator that is accessible, the number of values is shown in Figure 18.1.
One must distinguish vector (1 column) results from matrix (multiple column).
The vectors and the matrix data can be distinguished by looking at the icon
(see Figure 18.2). Vectors can be used to define X or Y axes of the functions,
while matrices or tables are more specifically used for either averaging and/or
enveloping operators (Section 19.3) or the WATERFALLViewer.

18.2.1 Import of Actran result files

The Actran results file contains different arrays, representing different local
(at points) or global quantities (on domains or surfaces) for every loadcases.
These are ordered in a tree within the PLTViewer that is the exact graphical
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Figure 18.1: Indicator length.

Figure 18.2: Vector and Table quantity.

representation of the content of the PLT file. One can thus distinguish different
sections in the tree:

• DOMAIN : storing all global quantities related to the different components
such as acoustic, structure domains.

• MODAL_BASIS : storing global quantities related to a modal surface.

• MODE : storing global quantities related to a specific mode of a modal basis.

• POINT : storing local quantities related to a field point.

• NODE : storing local quantities related to a storage node.

• SURFACE : storing global quantities related to a control or coupling surface.

• INTERFACE : storing global quantities related to an interface.

• AUTO_POSTPRO : storing quantities related to an automatic postprocessing.

For sections such a NODE or a POINT, the points coordinates are also available. For
a MODE, the modal orders (e.g. radial and azimuthal) and the cut-off frequency
are displayed.
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Each section may contain multiple leaves (different components or points). These
leaves may gather different quantities depending on their nature. Section 12.6
of Volume 1 provides the definition of all the available indicators. For Actran

result files, one main indicator that is always present is the frequency (or time)
range of the different objects. The entire PLT tree can be expanded and collapsed
at once by using the shortcuts ’control+’ and ’control-’ respectively. The ’control’
and ’+/-’ buttons need to be pressed together after clicking on the PLT tree.

Figure 18.3 show an example of the quantities available in an Actran result file.

Moreover, the unit system in which the set has been evaluated is provided along
the set information. This unit system is used when evaluating dB operators.

Figure 18.3: Data Tree of an ACTRAN file.

18.2.2 Import of ASCII column files (TXT or CSV)

The supported format for text files being column files, each column is interpreted
as being a vector. The number of the different columns corresponds to the
appearance of the column in the result file.

Figure 18.4: Data Tree of an txt file.
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18.2.3 Import of modal deformation files (MDF)

Actran supports the import of MDF files (Modal Deformation File) generated
by Adams multi-body dynamics software. They are usually generated in the
frame of an Adams analysis including flexible bodies. The MDF file contains one
participation factor per mode and per time step. These participation factors are
used in combination with an MNF file (Modal Neutral File) to represent the field
of vibration of the flexible body. The vibration quantity can be expressed as struc-
tural displacement, velocity or acceleration. The MDF file contains participation
factors enabling to retrieve each of them:

• Displacement participation factor is stored in LOADCASE 0

• Velocity participation factor is stored in LOADCASE 1

• Acceleration participation factor is stored in LOADCASE 2

If the velocity and acceleration participation factors are not exported in the
MDFfile, loadcases 1 and 2 are filled with null values.

Figure 18.5: Data Tree of an MDF file.

18.3 Reverse Set

The results contained in Actran results file are sorted by frequency or time.
This means that usually, one frequency or time array is present in every object
present within the PLT file. When dealing with an important amount of objects
of the same type (typically, a list of nodes or field points), it may be interesting
(typically when one is interested in a directivity plot) to obtain the results sorted
by identification number of the object, and not by frequency.

By right-clicking on a result file (See Figure 18.6), a reverse set can be created.
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Figure 18.6: Data Tree of an txt file.

As indicated in Figure 18.7, the different results present in the new set are ordered
by frequencies, while each vector depends on the identification number of the
object.

Figure 18.7: Data Tree of a txt file.

18.4 PLT Merge

When multiple Actran simulations are performed separately to cover a large
frequency range, the plt_merge utility allows merging multiple PLT files. Please
refer to Section 58.6 of Volume 1 for furthers information. This merging operation
can also be performed directly in PLTViewer.

Select at least two imported PLT sets by pressing the SHIFT key. By right-clicking
on one of the selected sets (See Figure 18.8), the "merge sets" command is
initialized. This function provides the following arguments:

• Merged set title : specifies the title of the merged PLT file;

• Tolerance : adjusts the frequency or time tolerance. If the difference
between two frequencies available on two different files is lower than
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this tolerance, the results from the last file overwrite previously available
information except if the "force average" checkbox is selected (see below).

• Axisymmetric order : allows to merge PLT files with different axisymmet-
ric orders;

• Load case offset for duct modes : allows to specify the offset to be ap-
plied on the loadcases corresponding to the different duct mode excitations
when merging PLTfiles from different axisymmetric orders;

• Force average : allows to trigger the averaging of duplicated quantities
when the same frequencies/loadcases are present in different PLT files.
Mean quantities (averaged over a surface or a volume) are unaffected by
this option and are always averaged;

• Ids Only : allows to merge results for DOMAIN, SURFACE and INTERFACE
data blocks that have the same identifier;

• Discard nonconverged modes : allows to discard non converged modes.

Figure 18.8: Data Tree of sets to be merged.

18.5 Generate Audio File

PLTViewer is able to convert an acoustic pressure frequency (or time) response in
an audio file in the *.wav format. For frequency cases, the resampling resolution
(df) is automatically defined based on the finest resolution between Length and
input file df (with a minimum tolerance of df = 0.001Hz). After resampling, an
Inverse Fourier Transform (IFT) is applied in the spectrum to create the audio
file.
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Select a fluid pressure quantity from one available data set. By right-clicking
on it (See Figure 18.9), the Convert to audio command can be selected. The
dialog window changes according to the data set. In case of *.plt files, the dialog
window can be seen in Figure 18.9). When using input data from *.txt files,
another options are available with respect to the type of data, as shown in Figure
18.10).

Figure 18.9: One-click audio conversion of pressure data from *.plt input.

Figure 18.10: One-click audio conversion of pressure data from .txt input.

The following options are available:

• Spectrum type: Choose the type of sound spectrum to be created from the
selected data set during the resampling procedure:
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– Tonal: This option does not apply any interpolation. At the resam-
pling procedure, the pressure values (amplitude and phase) are set to
approximations of the frequencies provided in the input file, based
on the resampling resolution. For the remaining frequencies (within
the audio range), zero amplitude and phase values are set (See Figure
18.11). In order to avoid audio clicks in the output, a fade-in/fade-out
with within a time interval of 10% the output audio Length is applied.

– Broadband: This option applies an interpolation between input data
points during the resampling procedure. The linearly interpolated
values are pressure amplitude and phase (See Figure 18.11). Through
the convert_to_audio API, there is the option to apply a random
phase in the broadband spectrum type, same as the --random_phase
option shown in Section 58.13 of Volume 1. In order to keep the
impact sound feature generated by Broadband type, the fade-in/fade-
out (same as the Tonal type) is only applied when using random
phase.

Figure 18.11: Example of spectrum types after resampling of an input frequency data with 2Hz
resolution. Interpolation is applied on Broadband spectrum type.

• Output name: output audio file name;

• Open in media player: the .wav file can be automatically loaded and
played using an audio player installed on the working machine;

• Max level in dB: .wav file has a dynamic range limited by its 16bits en-
coding resolution. Signal above this max level are clipped. A signal below
the max level minus the dynamic range is ignored. The reference pressure
is the one set in PLTViewerṪhe default condition is an automatic procedure
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which normalizes the output audio with a value of -1dB from the maximum
peak.

• Length: output .wav file duration in seconds. The resolution will be defined
based on a comparison between the input resolution and the Length value
which is set (highest resolution is taken considering a tolerance of df =
0.001Hz)

The audio generation can also be executed by Actran through the command line
using the plt2audio utility. Please refer to the plt2audio function Section 58.13
of Volume 1 for further information.

18.6 Convolution

PLTViewer is able to convolve an acoustic pressure frequency response with an
existing audio file (*.wav). Pressure results inside an available data set (fp in
*.plt or columns in *.txt), can be used as transfer function to be considered in a
convolution. By right-clicking on the data set (See Figure 18.12), the Convolution
function can be selected. The following options are available:

• Input file: select an input *.wav file as source audio.

• Output file: set the name of the output *.wav file for the convolved audio.

• Reference pressure: reference pressure value for the transfer function.

• Left extrapolation value: Describes the extrapolation of the transfer
function before its smallest defined frequency. The following extrapolation
options are available:

– pass: edge extrapolation to reference pressure value

– equal: edge extrapolation to pressure value of smallest frequency

– cut: extrapolates the edge to zero.

• Right extrapolation value: Describes the transfer function extrapolation
after the value of its highest defined frequency. The extrapolation op-
tions are the same as the one shown above for Left extrapolation value,
however it is applied at the edge above the input frequency range.

• Max level in dB: .wav file has a dynamic range limited by its 16bits en-
coding resolution. Signal above this max level are clipped. Signal below the
max level minus the dynamic range is ignored.
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Figure 18.12: One-click Convolution application..

Figure 18.13: Example of a transfer function using different right extrapolation options. The
reference pressure is considered as being 1Pa..

The convolution can also be executed by Actran through the command line using
the plt2audio utility. Please refer to the --convolution option of plt2audio

function Section 58.13 of Volume 1 for further information.

18.7 Plot Power Balance

PLTViewer is able to directly compute the balance of dissipated power within
the model’s components.

In order to compute and plot the power balance from the imported set, right-click
on the set node and click on "Plot Power Balance" (See Figure 18.14).
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Figure 18.14: One-click plot power balance.

18.8 Write PLT set

PLTViewer is able to export an imported set from the following input formats
(PLT, UNV, XYPCH, HDF, MDF and Punch files) into PLT format. This capabil-
ity can also be used on merged sets or reversed sets.

In order to export the imported set into PLT format, right-click on the set node
and click on "Write PLT file" (See Figure 18.15).

Figure 18.15: Export set into PLT format.

18.9 Apply functions to the imported data

A large set of mathematical functions can be applied to the different available
quantities (vectors). This is achieved by drag and dropping the quantity within a
quantity container and is extensively described in Chapter 19.

In addition, shortcuts to built-in functions and plots can be accessed by right-
clicking on the selected quantity and selecting the desired operator (See fig-
ure 18.16). The quantity will be used as the Y data vector, while either the
frequency, time or Id will be used for the X data vector.
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Figure 18.16: One-click function creation.

18.10 Change unit system of a PLT set

It is possible to change the associated unit system of a PLT set. Note that it does
not involve unit conversion, only the reference values are set correctly according
to the assigned unit system. Figure 18.17 shows how to change the unit system
of PLT a set.

Figure 18.17: Change unit system of a PLT set.
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PLTViewer Function Panel

19.1 Introduction

In order to plot curves from the imported data on the figures, functions must
first be created. A function relates an X data vector with a Y data vector of same
length. The X vector usually corresponds to the frequency (or time) and the Y
vector is constructed from mathematical expressions applied to one result (or
several) computed by Actran.

19.2 Function Definition

A function in the PLTViewer is an XY function relating two different data vectors
of the same length. This means that one function should always have two arrays
provided of same length (see Figure 19.1).

Figure 19.1: Mandatory equal length of the data vectors.

When using data from a result file, the different needed vectors (representing
a quantity) can be placed within the X or Y data vector edition box. In order
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to support the quantity in the edition, a quantity container (grey data box) can
be added at any time within each data vector (see Figure 19.2). When drag and
dropping a specific quantity in this quantity container, the name of the selected
quantity appears and is contained in the vector (see Figure 19.3).

Figure 19.2: Data box supporting an result quantity.

Figure 19.3: Assigning a quantity.

The language used for the data vector edition is the Python language
(www.python.org). The mathematical python package used is Numpy
(www.numpy.org). This means that various mathematical operations are available
within the data vector edition box.

For instance : 20 log(
√

Quantity12+Quantity12

2∗10e−5 )

becomes (see Figure 19.4):. p 20*log10(sqrt(array1**2+array2**2)/2e-5)

In addition, predefined operators on arrays are also available. For more informa-
tion, please refer to Section 19.3.
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Figure 19.4: Editing a data vector.

Different functions can be created within the PLTViewer, and may be plotted or
not in different figures. The list of defined functions is placed below the data
vector definition boxes, as shown in figure 19.5. When selecting a function, the X
and Y data vectors are updated to the selected function. Clicking on the "new"
button allows duplicating the currently selected function, but does not create a
curve.

Figure 19.5: Using different functions.

The up-to-date status indicator for each frequency allows controlling whether the
function is plotted in a figure, or has been modified since the last plot command.
When modifying a data vector of a specific function, the status is disabled, while
it may be refreshed by clicking on the "plot/update" button (see figure 19.6).
Note that there is no direct relation between the up-to-date status of a function
and the visibility of a related curve.
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Figure 19.6: Up-to-date status of different functions.

19.3 Built-in functions

A set of built-in operators is available and can be used in the PLTViewer (see
Figure 19.7).

Figure 19.7: Predefined operators for the PLTViewer.

The list of the different operators that are available and their definition is provided
in Table 19.1. For dB operators, the reference pressure or power is specified inside
the settings, and are set by default to 2e− 5Pa and 1e− 12W. These values are
adapted with respect to the unit system of the set, if this latest is available.
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Operator Arguments Description
AMPLITUDE array sqrt(array.real ∗ ∗2 + array.imag ∗ ∗2)
PHASE array arctan2(a.imag, a.real)

NR
incident, transmit-
ted

10 ∗ log10(incident.real/transmitted.real)

TL
incident, transmit-
ted

10 ∗ log10(incident.real/transmitted.real)

REAL array array.real
IMAG array array.imag

dB_Pressure array
20 ∗ log10(sqrt(array.real ∗ ∗2 + array.imag ∗
∗2)/p_re f )

dB_Power array 10 ∗ log10(array.real/power_re f )

dBA_Pressure array
20 ∗ log10(sqrt(array.real ∗ ∗2 + array.imag ∗
∗2)/p_re f ) + A f ilter

dBA_Power array 10 ∗ log10(array.real/power_re f ) + A f ilter

dBB_Pressure array
20 ∗ log10(sqrt(array.real ∗ ∗2 + array.imag ∗
∗2)/p_re f ) + B f ilter

dBB_Power array 10 ∗ log10(array.real/power_re f ) + B f ilter

dBC_Pressure array
20 ∗ log10(sqrt(array.real ∗ ∗2 + array.imag ∗
∗2)/p_re f ) + C f ilter

dBC_Power array 10 ∗ log10(array.real/power_re f ) + C f ilter

dBD_Pressure array
20 ∗ log10(sqrt(array.real ∗ ∗2 + array.imag ∗
∗2)/p_re f ) + D f ilter

dBD_Power array 10 ∗ log10(array.real/power_re f ) + D f ilter
Afilter freq 20 ∗ log10(A/A1000)
Bfilter freq 20 ∗ log10(B/B1000)
Cfilter freq 20 ∗ log10(C/C1000)
Dfilter freq 20 ∗ log10(D/D1000)
MEAN operator(array(lc)) sum(operator(array(lc)))/lc
PSD operator(array(lc)) linear object: sum((array(lc)) ∗ ∗2)/lc,

quadraticobject : sum(operator(array(lc)))/lc]

ENV operator(array(lc)) [min(operator(array(lc))),
max(operator(array(lc)))]

MENV operator(array(lc))
Computes an envelope of all possible mean val-
ues computed using lc-1

STD operator(array(lc))
[MEAN(array) − (sqrt(MEAN(array ∗
∗2) − MEAN(array)/2)), MEAN(array) +
(sqrt(MEAN(array ∗ ∗2)−MEAN(array)/2))]

CONFIDENCE operator(array(lc))
Compute confidence intervals insuring 5% of the
results are below the interval, while 5% of the
results are above the interval.

VECTOR_NORM a1, (a2), (a3)
sqrt(a1.real ∗ ∗2 + a1.imag ∗ ∗2 + a2.real ∗ ∗2 +
a2.imag ∗ ∗2 + a3.real ∗ ∗2 + a3.imag ∗ ∗2)

ISO-3744 power
level

field_points
Compute the power level based on field point
pressure results following the ISO norm 3744,
see below

FORCE_TYPE array,type,[ref]
Modify/specify the array type: ’l’ = linear, ’q’ =
quadratic, ’dB’ = dB for Pressure, ’f’ = frequency)

HIGHLIGHT_FREQUENCIESnone
Creates vertical lines highlighting the particular
frequencies provided in x

Table 19.1: PLTViewer build-in operators
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where:

• A = ((12200 ∗ ∗2) ∗ ( f req ∗ ∗4))/(( f req ∗ ∗2 + 20.6 ∗ ∗2) ∗ ( f req ∗ ∗2 +
12200 ∗ ∗2) ∗ ( f req ∗ ∗2 + 107.7 ∗ ∗2) ∗ ∗0.5 ∗ ( f req ∗ ∗2 + 737.9 ∗ ∗2) ∗ ∗0.5)

• A1000 = ((12200 ∗ ∗2) ∗ (1000 ∗ ∗4))/((1000 ∗ ∗2 + 20.6 ∗ ∗2) ∗ (1000 ∗ ∗2 +
12200 ∗ ∗2) ∗ (1000 ∗ ∗2 + 107.7 ∗ ∗2) ∗ ∗0.5 ∗ (1000 ∗ ∗2 + 737.9 ∗ ∗2) ∗ ∗0.5)

• B = ((12200∗ ∗2) ∗ ( f req ∗ ∗3))/(( f req ∗ ∗2+ 20.6∗ ∗2) ∗ ( f req ∗ ∗2+ 12200∗
∗2) ∗ ( f req ∗ ∗2 + 158.5 ∗ ∗2) ∗ ∗0.5)

• B1000 = ((12200 ∗ ∗2) ∗ (1000 ∗ ∗3))/((1000 ∗ ∗2 + 20.6 ∗ ∗2) ∗ (1000 ∗ ∗2 +
12200 ∗ ∗2) ∗ (1000 ∗ ∗2 + 158.5 ∗ ∗2) ∗ ∗0.5)

• C = ((12200 ∗ ∗2) ∗ ( f req ∗ ∗2))/(( f req ∗ ∗2 + 20.6 ∗ ∗2) ∗ ( f req ∗ ∗2 +
12200 ∗ ∗2))

• C1000 = ((12200 ∗ ∗2) ∗ (1000 ∗ ∗2))/((1000 ∗ ∗2 + 20.6 ∗ ∗2) ∗ (1000 ∗ ∗2 +
12200 ∗ ∗2))

• D = ( f req ∗ (((1037918.48 − f req ∗ ∗2) ∗ ∗2 + (1080768.16 ∗ f req ∗
∗2))/((9837328 − f req ∗ ∗2) ∗ ∗2 + (11723776 ∗ f req ∗ ∗2))) ∗
∗0.5)/(6.8966888496476e − 5 ∗ (( f req ∗ ∗2 + 79919.29) ∗ ( f req ∗ ∗2 +
1345600)) ∗ ∗0.5)

• D1000 = (1000 ∗ (((1037918.48 − 1000 ∗ ∗2) ∗ ∗2 + (1080768.16 ∗
1000 ∗ ∗2))/((9837328 − 1000 ∗ ∗2) ∗ ∗2 + (11723776 ∗ 1000 ∗ ∗2))) ∗
∗0.5)/(6.8966888496476e − 5 ∗ ((1000 ∗ ∗2 + 79919.29) ∗ (1000 ∗ ∗2 +
1345600)) ∗ ∗0.5)

• ISO3744 = 20∗ log(
√

∑( f luid_pressure ∗ ∗2)/num_points/
√

2/re f _db_pressure)+
10 ∗ log(sur f ace_area ∗ length_unit)

19.4 Octave operators

PLTViewer is able to compute and display data in narrow band (default), but
also in octave/mean octave, 1/3th octave/mean octave, 1/6th octave/mean octave,
1/12th octave/mean octave and 1/24th octave/mean octave bands. These bands
can be either the exact octave bands or one-third octave bands including non-
fractional numbers, or the conventional rounded numbers due to the ISO standard.
This can be set in the PLTViewer Settings window, tab Default properties, Octave
and 3rd octave band convention.

This section explicits the octave formulations used in PLTViewer. Since they
depend on the nature of the data, the following section introduces first the
different function data type available in PLTViewer.
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19.4.1 Function data types and dB reference

Any plotted function in PLTViewer has a type, characterizing the nature of
its underlying data. Depending on this function data type, the corresponding
octave/mean octave data will be computed in a different way. The different data
type available in PLTViewer are :

• f : undefined data type, no type can be associated to the function data. This
is for instance the case when the user is creating a function from text file
imported data, or when the X Data and Y Data vectors are lists directly
provided by the user. In these scenarios, an undefined type is associated to
the data since PLTViewer is not able to know the exact nature of the data ,

• l : linear data type. Fluid pressure (fp) (in [Pa] units), fluid potential (fpo),
fluid velocity (fv), solid displacements (su) and rotations (sr), forces and
moments, are associated to linear data type ,

• q : quadratic data type. Any quadratic indicator, typically intensities or
power indicators, as fluid intensity (fi), radiated power (rP) or incident
powers (iP), PSD indicators, square indicators, are associated to quadratic
data type ,

• dB : function data is expressed in decibels [dB] scale (logarithmic scale).
Any dB operators, such as dB_pressure, dB_power, ... applied on Y Data
vector will lead to a function with underlying dB data type ,

• TL : function data corresponds to a Transmission Loss (or Noise Reduction)
indicator. TL and NR operators applied on Y Data vector will lead to a
function with underlying TL data type.

In addition to the function data type, there is also a dB reference associated to
function data. This parameter is only useful when the data type is dB. In such a
case, PLTViewer has to determine if the data is linear dB data (dB_pressure) or
quadratic dB data (dB_power), because the dB reference is not the same for these
two different types of data. Let’s consider the general expression for converting
pressure quantity to dB units :

pdB = 20log

(
p

pre f

)
(19.1)

In the above expression, pre f is a given reference level. dB reference level for
pressure is 2.10−5 (this is the default dB reference of any function created in
PLTViewer. Those values can be changed in PLTViewerSettings window), while
dB reference level for power is 1.10−12.
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Important remark : in PLTViewer, the pressure is used instead of the ef-
fective pressure in the dB expression (pe f f = p/

√
2)

The function data type can be set at the creation of the function by the user.
The FORCE_TYPE operator applied to Y Data Vector allows for setting plt_type
parameter (function data type) and db_ref (function dB reference). For instance,
for creating a function using simple Python lists, the following Y Data Vector

FORCE_TYPE([1, 2, 3, 4, 5], plt_type = ”dB”, db_re f = ”1e− 12”) (19.2)

will tag the created function’s data as dB (plt_type = ”dB”) quadratic
(db_re f = ”1e− 12”) data.
NB : the db_re f parameter should be provided as a string, in the format
[0− 9]e[+−][0− 9].

Remark : when handling reverse data, X Data vector does not correspond to
frequencies but to Ids (of microphones for instance). If we want to display
results using a particular operator which depends on the frequency (as a dBA
operator for instance), it is necessary to specify explicitly the xarray argument to
the operator. For instance, if the corresponding frequency is 600Hz, we would
consider:

dBA_pressure(set1.POINT1[”600.0”]. f ield[” f p”].lc[1], xarray = [600]) (19.3)

19.4.2 Octave formulations in PLTViewer

A sound level in a particular frequency band of octave or 1/3th octave bands is
obtained by computing the total acoustic energy of the signal inside this particular
frequency band. Such energy is computed using an integration operation on the
acoustic energy, which is a quadratic value, over the considered frequency band :

Lq[ fmin , fmax ] =
∫ fmax

fmin

q2d f (19.4)

The displayed result is a histogram plot, representing these energy values for each
of the bands as a bar. By extension, band-averaged signals are generally obtained
by integrating quadratic values over frequency bands. To do so, PLTViewer

applies different recipies depending on the type of data. The integration operation
will be performed for each type, the only difference will be a data-conversion
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operation (or not) before and after the integration procedure. Four different
scenarios are possible :

• Data type is f : octave operations are not allowed on undefined data
type. An error message will be displayed, inviting the user to first use
FORCE_TYPE operator to assign the right type to the data ,

• Data type is l or q : no data-conversion will be performed, the integration
operation will be performed directly on the data :

〈q〉i =
∫ fmaxi

fmini

qd f (19.5)

where:

– q is the quantity

– i is the octave band id

– fmini and fmaxi are respectively the minimum and maximum frequency
of the octave band i

• Data type is dB :

– A pressure quantity is expressed in dB units as :

pdB = 10log

(
p2

p2
re f

)
(19.6)

where:

* p is the pressure amplitude

* pre f is the reference pressure

– A power quantity is expressed in dB units as :

WdB = 10log

(
W

Wre f

)
(19.7)

where:

* W is the power

* Wre f is the reference power
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The octave band quantity is computed as follows :

〈XdB〉i = 10log
(∫ fmaxi

fmini

10
XdB
10 d f

)
(19.8)

where X is p or W.

– When X is a pressure, using the Eq. (19.6), the expression becomes :

〈pdB〉i = 10log

(∫ fmaxi

fmini

p2

p2
re f

d f

)
(19.9)

– When X is a power, using the Eq. (19.7), the expression becomes :

〈WdB〉i = 10log

(∫ fmaxi

fmini

W
Wre f

d f

)
(19.10)

• Data type is TL : the transmission loss is defined as :

TL = 10log
(

Win
Wtr

)
(19.11)

where:

– Win is the incident power

– Wtr is the transmitted power

The octave band quantity is computed as follows (using Eq. (19.11)) :

〈TL〉i = 10log
(∫ fmaxi

fmini

10
−TL

10 d f
)

(19.12)

= −10log

 ∫ fmaxi
fmini

Wtrd f∫ fmaxi
fmini

Wind f

 (19.13)

= −10log
(
〈Wtr〉i
〈Win〉i

)
(19.14)

This definition is equivalent to the following one only if the incident power
is assumed constant (Win = cte):

〈TL〉i = 10log
(

Win
〈Wtr〉i

)
= 10log

(
〈Win〉i
〈Wtr〉i

)
(19.15)

Import remark : as indicated above, functions with l or q data type will be
simply integrated, without any pre- or post-operation on the data. This does
not correspond to the definition of octave band value as stated by Eq. (19.4). To
ensure the use of the proper definition, the data should be converted first to dB
units, and tagged with dB data type using FORCE_TYPE operator by the user.
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19.4.3 Mean octave formulations in PLTViewer

In mean octave computation, the integrated value is simply divided by the size
of the frequency band, so that the energy is represented by the surface of the
bar and comparison with narrow band results is easier. Note that for TL data
types, since the integration operation is done separately on the numerator and the
denominator of the ratio Win

Wtr
, the division by the frequency band size simplifies

to 1. All other operations are exactly the same as for octave band computation.

Reconsidering the four different possible scenarios from the previous sub-section,
but this time focusing on pressure and power quantities instead of general
quantity q :

• Data type is f : octave operations are not allowed on undefined data
type. An error message will be displayed, inviting the user to first use
FORCE_TYPE operator to assign the right type to the data ,

• Data type is l or q : no data-conversion will be performed, the integration
operation will be performed directly on the data :

〈q〉i =
1

fmaxi − fmini

∫ fmaxi

fmini

qd f (19.16)

where:

– q is the quantity

– i is the octave band id

– fmini and fmaxi are respectively the minimum and maximum frequency
of the octave band i

• Data type is dB :

– A pressure quantity is expressed in dB units as :

pdB = 10log

(
p2

p2
re f

)
(19.17)

where:

* p is the pressure amplitude

* pre f is the reference pressure
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– A power quantity is expressed in dB units as :

WdB = 10log

(
W

Wre f

)
(19.18)

where:

* W is the power

* Wre f is the reference power

The mean octave band quantity is computed as follows :

〈XdB〉i = 10log
(

1
fmaxi − fmini

∫ fmaxi

fmini

10
XdB
10 d f

)
(19.19)

where X is p or W.

– When X is a pressure, using the Eq. (19.17), the expression becomes :

〈pdB〉i = 10log

(
1

fmaxi − fmini

∫ fmaxi

fmini

p2

p2
re f

d f

)
(19.20)

– When X is a power, using the Eq. (19.18), the expression becomes :

〈WdB〉i = 10log

(
1

fmaxi − fmini

∫ fmaxi

fmini

W
Wre f

d f

)
(19.21)

• Data type is TL : the transmission loss is defined as :

TL = 10log
(

Win
Wtr

)
(19.22)

where:

– Win is the incident power

– Wtr is the transmitted power

The mean octave band quantity is computed as follows (using Eq. (19.22)) :

〈TL〉i = −10log
(∫ fmaxi

fmini

10
−TL

10 d f
)

(19.23)

= −10log
(∫ fmaxi

fmini

Wtr

Win
d f
)

(19.24)

= −10log
(〈

Wtr

Win

〉
i

)
(19.25)
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As TL is an adimensional quantity, there is no division by the frequency
band remaining.
This definition is equivalent to the following one only if the incident power
is assumed constant (Win = cte):

〈TL〉i = 10log
(

Win
〈Wtr〉i

)
= 10log

(
〈Win〉i
〈Wtr〉i

)
(19.26)

From the previous relations, it should be noted that for TL data type the
mean octave quantities are equivalent to the octave quantities.
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Twenty

PLTViewer Render Window

20.1 Introduction

The render Window is used to plot the functions defined in the function panel.
This panel is organized in 3 sub-panels:

• Figure panel;

• Figure Properties panel;

• Curve panel.

Figure 20.1: Visualization of the render window.
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20.2 Handling functions to plot

To plot a function from the function panel (see Section 19), the plot/update
button should be clicked. A new curve is then added within the current active
figure (see Figure 20.2).

Figure 20.2: Creation of a curve from the function panel.

When a function is modified within the function panel, the corresponding curve
is updated within the current active figure. A same function can be present in
different figures at the same time.

20.3 Curves

Each curve that is present within the current active figure is represented by a line
in the curve panel while different parameters can be modified.

For each curve, the corresponding function is indicated, and various options can
be edited:

• The visualization of the curve can be disabled or enabled;

• Curve position (modify curve position in the legend);

• Line type (solid, dashed, dotted, mix);

• Line color;

• A marker can be added;

• Marker color;

• Marker step;
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Figure 20.3: Properties of different curves.

• Curve opacity;

• Curve thickness;

• Curve label;

• Octave filters;

• Interpolation of non computed values;

• Tonal signal;

• Smoothing;

• Discard 0 values

Some curves properties are described hereunder.

20.3.1 Octave Filters

The octave filters allow visualizing the plotted functions in narrow band, octave
band, 1/3rd octave band, 1/6th octave band, 1/12th octave band and 1/24th
octave band. These filters allow considering a tonal signal (filters octave, 1/3
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octave, 1/6 octave, 1/12 octave and 1/24 octave) or a continuous signal (fil-
ters mean octave, mean 1/3 octave, mean 1/6 octave, mean 1/12 octave and
mean 1/24 octave).

The filters octave, 1/3 octave, 1/6 octave, 1/12 octave and 1/24 octave in-
tegrates the narrow band curve respectively on each octave band, 1/3rd octave
band, 1/6th octave band, 1/12th octave band and 1/24th octave band.

The filters mean octave, mean 1/3 octave, mean 1/6 octave, mean 1/12
octave and mean 1/24 octave also integrate the narrow band curve but then
divide the result by the frequency bandwidth of each band.

These filters are available for most of the functions even if the integration method
depends on the quantity type:

• linear and quadratic (i.e. amplitude of pressure, real part of radiated power)
functions are simply integrated;

• dB and TL functions are translated to a linear or quadratic formulation first,
then integrated and finally translated back to dB scale. The integration is
thus performed upstream of the dB scale adjustment. Please refer to the
Section 20.5) for further details;

• others arbitrary functions tagged as f (undefined) is not plotted and a
message informing the user pops up.

The PLT functions are automatically tagged (l for linear, q for quadratic, dB for dB
units) according to the quantity type. All others unknown functions are tagged f.
A special function FORCE_TYPE allows to manually tag a function. Please refer
to the Section 20.5) for further details.

20.3.2 Discard Value Function

If the PLT file contains zero values at some frequencies (e.g.: multiple load
computation), activation of the discard 0 option forces PLTViewer to skip those
datapoints while plotting the curve. Similarly, NaN values available in the PLT
file can be discarded using discard NaN option.

20.3.3 Tonal Function

When working with tonal signals, only discrete values at some isolated frequen-
cies are available. Instead of computing the octave (or 1/3 octave) integration
in the regular way (and so interpolating between data points), the activation of
the tonal option makes the assumption of null values between discrete data
points and transforms the integral of p2 into a sum.
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20.3.4 Smoothing

The smoothing function is used to obtain a smooth curve when working with
octave bands, 1/3rd octave bands, 1/6th octave bands, 1/12th octave bands or
1/24th octave bands. Ticking this box changes the usual rectangular shape of an
octave band to an averaged narrow curve. Instead of having a constant value
in-between each frequency band boundaries, the smoothing function plots this
value at the central frequency of each band.

20.3.5 Discard 0

The Discard 0 option should be used to automatically filter points that have 0
value on the Y axis. It has no effect on envelope curves.

20.4 Figures

The PLTViewer allows plotting various results on different figures. By default,
one figure is always created at the start of the PLTViewer. Additional figures
might be created using the menu tab (see Figure 20.4). When creating a new
figure, it may be empty (select the new button) or a duplicate of the current
selected figure (use the Duplicate current button).

Figure 20.4: Menu tab for creating new figures

Toggling between the different figures is made by selecting the header of the
desired figures (see Figure 20.5). The curve panel and figure properties being in-
dependent for all figures, these are updated following the active figure. Removing
a figure is made by clicking on the red cross on its header.

Figure 20.5: Toggling between various figures

Below each figure, the control bar (see Figure 20.6) is used to perform the
following operations (ordered according to the buttons from left to right in the
control bar):
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• home : zoom out to fit all curves data in the figure.

• save the figure in various image file format such as png or eps (see Fig-
ure 20.7).

• copy to clipboard allows to perform a snapshot of the displayed figure

• export allows to output figure quantities in txt of csv formats

Figure 20.6: Figure Control Bar

Figure 20.7: Figure Save option

To pan the view, press the middle mouse button and drag. To zoom the view, roll
the wheel mouse button. To zoom the view on a selection, press the right mouse
button and draw a rectangle. More help is available from the Help->Controls
menu.

In addition, each figure has various options which may be edited independently:

• Labels for each axis and a main title;

• The limits of the X and Y axis can be edited or reset; Additionally, each axis
can be shown in log scale or using a polar plot;

• Grids might be added to the figure. For log scales, additional grids can be
added;

• The location of the legend;

• Font size and color within the figure (main title and axis labels);

• Clean the annotations on the figure;
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• Global indicators can be displayed. These quantities are relative to the
selected curve.

Figure 20.8: Figure properties

20.4.1 Polar plots

Polar plots are often used when requiring the visualization of the acoustic
directivity. Its usage is usually combined with the usage of reverse sets (see
Section 18.3). The limits of the X axis is automatically set from 0 to 360 in order to
visualize polar coordinates. It is then required either to adapt the X data vector,
or to have an angular identification of field points. In the following example
(Figure 20.9), an array of 360 field points is placed around a radiating quadripole
radiating in free field. By computing a reverse set and visualizing the results in
polar coordinates, the directivity of the source is plot.
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Figure 20.9: Polar plots on a quadripole

20.4.2 Phasor plots

Phasor plot are used to compare the contributions of different microphones,
panels, ... This is particularly interesting to detect phase opposition and therefore
constructive or destructive interference. The phasor plot can be displayed based
on both classical sets (frequency arrays) or by using the reverse set capability (see
Section 18.3). The limits of the X axis is automatically set from 0 to 360 in order
to represent a complex diagram.

Figure 20.10: Phasor plot

The length of the drawn line represents the amplitude of the quantity, while its
orientation in the diagram represents the phase.
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To use phasor plot with complex values, no operator should be defined in the Y
data vector, as illustrated below.

Figure 20.11: Complex values

Note that the phasor plot can also accept quantities specified within AMPLITUDE
or dB operator, but as these operators provide a real value at the end, the plot
will display a horizontal line of length equals to the output value, and a phase
equals to 0.

20.4.3 Bar Charts

Bar charts plots are available when dealing with 1/x octave band results.
They allow to visualize results using bar charts instead of solid curves. This
visualization is commonly used in the acoustics’ world. When activating this
option, the curves already displayed in the figure are automatically converted
into bar charts. The bar width can be adjusted using an appropriate parameter.
Several bar charts can be illustrated together in the same figure.

Note that this plot type option is not supported when dealing with multiple
types of 1/x bands on the same figure.

In the following example (Figure 20.12), the sound pressure level for two different
microphones is illustrated in third octave band using bar charts representation.
The experimental results, defined on a different frequency range, are also dis-
played. The octave center frequencies are displayed on the x axis, and annotations
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are added at different locations to directly access to the bar chart values.

Figure 20.12: Bar Charts Plot

20.4.4 Frequency-wide Indicators

Frequency-wide indicators are defined to quantify the noise level of a sound
source on a specific range of frequency. Among them, the Overall Sound Level
(OSL) is widely used to provide one unique value based on the whole frequency
content (see Figure 20.13). This sub-section presents the following indicators :

• OSL

• Integral

• Mean value (Integral / (fmin - fmax))

• RwCCtr

• Max X

• Min Y

• RMS

• RMS PSD

• Loudness
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• Sharpness

The OSL acronym stands for Overall Sound Level. This generic formulation can
be used with either pressure or power quantities.

According to the quantity type involved the OSL becomes:

• OSPL (Overall Sound Pressure Level) for a dB_pressure function;

• OASPL (Overall A-weighted Sound Pressure Level) for a dBA_pressure func-
tion;

• OSWL (Overall Sound Power Level) for a dB_power function;

• OASWL (Overall A-weighted Sound Power Level) for a dBA_power function;

• etc ...

The OSPL indicator is computed as:

OSLdB = 20 log

√∫ fmax
fmin

p2d f

pre f
(20.1)

whereas the OSWL indicator is given by:

OSLdB = 10 log

∫ fmax
fmin

Wd f

Wre f
(20.2)

The OSL and OASL are only available for data expressed using dB scale. A
warning message is prompted in the legend if this assumption is not fulfilled
(e.g.: OSL : no dB units). If other curves involving dB scaled data are already
displayed on the figure, the OSL is correctly displayed for them.

349



PLTViewer Render Window

Figure 20.13: OSPL / Integral / Mean Value plots

Alternatively, the RMS, also known as root mean square value, is also widely
used. The computation of the RMS value differs depending on the nature of the
provided curve. If the curve is provided in dB units, as for the OSL indicator, the
RMS is computed as:

RMSdB = 20 log

√ ∫ fmax
fmin

p2d f

( fmax− fmin)

pre f
(20.3)

For a linear quantity V, the RMS indicator is computed as:

RMSV =

√
1

fmax − fmin

∫ fmax

fmin

V2( f )d f (20.4)

while for a quadratic quantity:

RMSV =
1

fmax − fmin

∫ fmax

fmin

V( f )d f (20.5)

which is equal to the computed mean value indicator.

The second root mean square value, named RMS_PSD differs for the computation
of quadratic quantities:
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RMSV =

√∫ fmax

fmin

V( f )d f (20.6)

Loudness and sharpness are the psychoacoustic parameters enabling to analyse
the sound quality with regard to the perception of human ear.

Loudness describes the magnitude of an auditory sensation. The loudness in
Actran is calculated according to DIN 45631 (ISO 532B) standards (Zwicker
model) for stationary sound and measured in sone. A loudness of 1 sone is
equivalent to a sine tone of the frequency 1kHz presented at level of 40dB. Sones
are linear quantities, so a doubled loudness on the loudness scale corresponds to
a doubled sone value.

The total loudness N is computed as the integral of the specific loudness N′,
measured in sone/bark, over the critical bands (subdivision of audible frequency
range into Bark scale ranging from 0 to 24 Bark). The values of specific loudness
are evaluated from third octave band levels as function of critical band rate in
Bark.

N =
∫ 24Bark

0
N′dz (20.7)

where z is the critical band rate (measured in Bark).

Sharpness is a measure of the high frequency content of a sound. It is increased
by adding higher frequency content, and decreased by adding lower frequency
content. The unit of sharpness is acum. A narrow band noise one critical band
wide centered on 1kHz having a level of 60dB produces the sharpness of 1 acum.
In Actran the sharpness is calculated with the weighting function g(z) employed
by Zwicker E. and Fastl H., ’Psychoacoustics: Facts and Models (Springer 1990)’.

S = 0.11

∫ 24Bark
0 N′g(z)dz∫ 24Bark

0 N′dz
(20.8)

All these frequency-wide indicators can be exported in a text file using the buttons
Export Selected Indicators and Export All Indicators .
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Figure 20.14: Export OSL

20.5 Remarks and Further Reading

Arrays of data can be of the following types in PLTViewer :

1. linear such as the pressure, displacement, ...

2. quadratic such as the radiated power, dissipated power, ...

3. dB or logarithmic such as dB pressure, dB power, ...

4. TL for transmission loss index

5. arbitrary when the data is computed based on a mathematical expression
introduced in PLTViewer

Internally, each function is tagged with one of these types. This tag is used
to post-process the data such as octave bands plots. The dB tag contains one
additional information about the reference chosen in the logarithmic expression.

One can manually define the type of a function using the following function:

FORCE_TYPE(data,type,[ref])

where data is the data array related to the tag to be changed, type is the plt_type
(l: linear; q: quadratic, dB: 10*log_10(x), TL: 10*log_10(1/x), f: arbitrary function,
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unknown behavior for a correct integration), ref is the reference value for dB
scale (optional).

PLT imported values are tagged (l, q, dB or f) according to their designation.
However, multi-columns quantities imported from TXT file are tagged l (linear)
by default. It is the responsibility of the user to use the FORCE_TYPE operator
if, for instance, the imported values rely on a dB scale. A typical example is
highlighted underneath Figure 20.15.

Figure 20.15: Modification of the data type from an experimental .txt results file

TL quantity is correctly integrated (octave and 1/3 octave) as long as inci-
dent/incoming power/intensity is constant (which is most of the time). If it is not
the case, the results are incorrect and no warning is issued (as it is undetectable
using the tag formalism).
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Twenty One

PLTViewer Sound Quality
Metrics

21.1 Introduction

The human ear is receptive to sound frequency, level and duration, and the
combination of these properties with the human ear’s characteristics allow to
define perception models. Sound Quality metrics specifically allow a linear repre-
sentation of human hearing perception. They are defined during psychoacoustic
studies that establish a correlation between our ear operation and the feeling
a sound convey. In Actran 5 sound quality metrics are available to analyze
stationary and time-varying signals:

• Bark scale;

• Loudness (ISO 532B);

• Sharpness (DIN 45692);

• Roughness (Daniel and Weber);

• Tonality (ECMA 74);

• Speech Intelligibility Index (ANSI S3.5);
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21.2 Bark scale

The human ear is receptive to sounds from 20Hz to 20kHz, but the frequency
detection accuracy is variable along this range: the higher two sounds are, the
less the human ear is able to distinguish them. For instance, an ontologically
normal listener can detect the difference between 450 Hz and 500 Hz, but not
between 6000 Hz and 6050 Hz.
Thus, some frequency bands are defined so that two frequencies in the same band
can not be distinguished. The Bark scale includes 24 "critical bands" on which
an equal distance corresponds to an equal frequency perception. This scale is
frequently used to present psychoacoustic results since it is a human-coherent
representation of the frequency axis.

Figure 21.1: 24 critical bands with increasing width.

21.3 Loudness (ISO 532B)

Loudness describes the magnitude of an auditory sensation. The loudness in
Actran is calculated according to ISO 532B standard following the Zwicker
model measured in sone. A loudness of 1 sone is equivalent to a sine tone of
the frequency 1kHz presented at level of 40dB. Sones are linear quantities, so a
doubled loudness on the loudness scale corresponds to a doubled sone value,
that is to say a sound perceived as twice louder.
The total loudness N is computed as the integral of the specific loudness N′

measured in sone/bark, over the Bark scale. The values of specific loudness are
evaluated from third octave band levels as function of critical band rate z in Bark.

N =
∫ 24Bark

0
N′dz (21.1)

21.4 Sharpness (DIN 45692)

Sharpness is a measure of the high frequency content of a sound. It is increased
by adding higher frequency content, and decreased by adding lower frequency
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content. The unit of sharpness is acum. A narrow band noise one critical band
wide centered on 1kHz having a level of 60dB produces the sharpness of 1
acum. In Actran the sharpness is calculated according to DIN 45692 standard.
It consists of a specific loudness weighting employing Zwicker E. and Fastl H.
weighting function g(z).

S = 0.11

∫ 24Bark
0 N′g(z)dz∫ 24Bark

0 N′dz
(21.2)

21.5 Roughness (Daniel and Weber)

Roughness is an indicator of the modulation degree in a sound. Modulation is a
magnitude or frequency periodic variation of the signal along time. Roughness
combines the modulation frequency, the modulation index and the carrier fre-
quency to define 47 specific values along the Bark scale that are then summed to
get the global value.

R = 0.25
47

∑
i=1

R′i (21.3)

Its unit is the asper, 1 asper corresponding to a 60 dB 1 kHz sine modulated at 70
Hz. Above 300 variations per second, the human ear is no longer able to detect
the modulation phenomenon. The computation available in Actran relies on
Daniel and Weber model, described in Psychoacoustical roughness: implementation
of an optimized model, Acustica acta.acustica published in 1997.

21.6 Tone-to-Noise Ratio / Prominence Ratio (ECMA 74)

A sound composed of a single frequency is called a tone. Sounds can be either
pure tones or complex sounds composed of multiple tones. Tone-to-Noise Ra-
tio (TNR) and Prominence Ratio (PR) are two tonality models describing the
prominence of tonal components in a sound. Their computations follow the
same principle with a spectrum analysis detecting peaks to be compared with
the smoothed spectrum.

∆LTNR = Lpeak − 10log(100.1Lpeak band − 100.1Lpeak ) + ε

∆LPR = 10log(100.1Lpeak band)− 10log[0.5(100.1Llower band + 100.1Lupper band)](21.4)

According to ECMA 74, TNR can prove to be more accurate for multiple tones in
adjacent critical bands, for example when strong harmonics exist. PR can be more
effective for multiple tones within the same critical band and is more readily
automated to handle such cases. Along with the TNR and PR value comes a
prominence indicator, a tone being considered as prominent if its dB level is
sufficiently higher than the smoothed spectrum, depending on its frequency.
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21.7 Speech Intelligibility Index (ANSI S3.5)

The Speech Intelligibility Index (SII) measures how well a speech is comprehensi-
ble under a variety of adverse listening conditions. The computation method has
been standardized in ANSI S3.5 (1997). It is computed from measurements or esti-
mates of speech spectrum level, noise spectrum level, and from psychoacoustical
measurements or estimates of hearing threshold level. By measuring the speech-
to-noise ratio in each contributing frequency band Ai and weighting the results
with an importance function Ii, the intelligibility of a speech communication
system can be predicted.

SII =
n

∑
i=1

Ii Ai (21.5)
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Twenty Two

WATERFALLViewer Overview

22.1 Introduction

The WATERFALLViewer is the graphical tool to display Actran results under
the form of waterfall diagram.

The main components of the WATERFALLViewer User Interface are listed below
(see Figure 22.2):

1. Menu: Menu gives access to the main functionalities of the
WATERFALLViewer tool.

2. Data Tree Panel: Every imported PLT, UNV, MDF, Punch or TXT file is
parsed and subdivided by its different quantities. The data tree panel shows
the different available quantities by results type/loadcase;

3. Function Panel: Every diagram is defined by a function. These X-Y-Z
functions can refer to results available in the Data Tree Panel (using cer-
tain operators), and respect the Python syntax. Built-in functions are also
available. Please refer to Chapter 25 for more details;

4. Render Window: WATERFALLViewer is designed to create waterfall dia-
grams. Each diagram is defined based on a three variables function defined
in the Function panel. 2D-curves can be defined based on the waterfall
diagram by cutting it vertically or horizontally. Please refer to Chapter 26
for more details.
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Figure 22.1: Global layout of the Waterfall Viewer.

22.2 Launching the WATERFALLViewer

Multiple ways are available for launching the WATERFALLViewer

1. The WATERFALLViewer can immediately be accessed from ActranVI
through the toolbar (Tools→PLTViewer).

Figure 22.2: Launching WaterfallViewer from ACTRAN VI.
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2. WATERFALLViewer can be launched from the prompt by typing the com-
mand:

actran -u WaterfallViewer [-n|--no_render] [-x|--execute]...
[-i|--import_file] [-b|--background]

where

-n,--no_render : WATERFALLViewer will be launched without render-
ing window (batch mode);

-b,--background : WATERFALLViewer will be launched in background
mode;

-x,--execute= : the execution of the specified WATERFALLViewer script
will be performed;

-i,--import_file= : the specified result file will be imported.

3. On Windows, the WATERFALLViewer can be launched by double-clicking
on the shortcut located in the START menu.

Trace files and session files are systematically created and contains respec-
tively all software information and the different operation performed within
the WATERFALLViewer. The session file can be re-used as explained in Chap-
ter 27.
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Twenty Three

WATERFALLViewer Menu

23.1 "File" menu

The File menu of WATERFALLViewer allows performing global actions. These
actions are gathered in four groups:

1. Load or Export session file (see Section 23.1.1)

2. Import results (see Section 23.1.2)

3. Export waterfall data to TXT or CSV files (see Section 23.1.3)

4. Modify the WATERFALLViewer settings (see Section 23.1.4)

Figure 23.1: Menu of the Waterfall Viewer.
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23.1.1 Scripting and Session Files

Like for ActranVI an API (Application Programmer Interface) is available for
WATERFALLViewer in order to write and read WATERFALLViewer commands
in a session file. When opening the WATERFALLViewer, a session file is auto-
matically created. Such file can for instance be used for:

• Re-launching WATERFALLViewer in the latest state;

• Retrieving a stable status of the WATERFALLViewer when a crash appears
(by suppressing different lines for instance);

• Re-using a post-processing procedure on a different set of results;

• Automating the post-processing operations in an industrialization phase of
Actran.

The current script file is automatically indented with the operated commands
within the WATERFALLViewer, written in the python format (www.python.org).
Every available command within the WATERFALLViewer can be accessed
through this API. The different available functions and options are described in
Section 27.

23.1.2 Importing Results in WATERFALLViewer

The WATERFALLViewer supports the following results file:

• PLT (Actran result file);

• TXT (ASCII column files)

• UNV (IDEAS Universal; data block type 58)

• Punch (Nastran punch file).

When importing a plt file, a plt set is created and shows all its content in the data
tree panel (see Section 24). The leaves of the tree are vectors of data and can be
used to create functions.

Text files with columns formatted data (see below) can also be imported.

0 5.02e-6 5.4
1 4.52e-6 3
2 5.21e-6 6
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23.1.3 Exporting Results from WATERFALLViewer

This option allows to export the data of the visible waterfall diagram to TXT or
CSV files. Three files are generated :

1. filename_x.txt contains x coordinates of the waterfall diagram

2. filename_y.txt contains y coordinates of the waterfall diagram

3. filename.txt contains the matrix of all values associated to (x,y) coordinates

23.1.4 Settings

The general settings of WATERFALLViewer can be access in order to:

• Select a folder containing all the user’s scripts written for specific post-
processing operations.

• Choose either or not a confirmation is required for several actions (clear all,
...).

• Choose to overwrite or not the session file created the last time you opened
WATERFALLViewer. If this option is unchecked, a unique session file is
created each time you launch the application.

Figure 23.2: General Settings of the Waterfall Viewer.
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Default properties as the reference value for dB plots or general font sizes and
colors can also be modified to fulfill the needs of the user.

Figure 23.3: Default Properties of the Waterfall Viewer.

23.2 "Tools" menu

The WATERFALLViewer includes different dedicated tools:

1. A tool to compute MAC correlations between modal extractions and or
measurements (see Section 23.2.1)

2. A tool to evaluate participation factor of a structural modal basis based on
measurements (see Section 23.2.2)

3. A tool to automatically generate cuts corresponding to different engine
orders (see Section 23.2.3)

4. A tool to display aocusitc results as Spectrogram plot (see Section ??)

5. A tool to combine acoustic results with realistic excitations provided in time
domain (see Section 23.2.5)

6. A tool to convert RPM based modal participation factors to Order-based
modal participation factors (see Section 23.2.6)

7. A tool to evaluate engine sources based on measurements and recombine
these with transfer functions (see Section 23.2.7)
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Figure 23.4: Tools Menu of the Waterfall Viewer.

23.2.1 MAC Correlation

The Modal Assurance Criterion correlation (or MAC correlation) is a criterion
used to compare the shape of structural modes.

This feature could interest all our customers that use Actran , Nastran or
experiment measurements for structural analysis in order to:

• Compare modal extractions

• Validate the models

• Optimize the designs

It can be considered as a really useful, advanced feature to post-process the modal
results.

Description of the MAC
The Modal Assurance Criterion (MAC) is a direct and objective comparison of
specific dynamic properties measured vs measured, measured vs predicted or
predicted vs predicted. In this case, a modal comparison is considered.

The MAC correlation is computed as follows:

MAC(A, X) =

∣∣∣∣∣ n
∑

j=1
(ψX)j(ψA)

∗
j

∣∣∣∣∣
2

(
n
∑

j=1
(ψX)j(ψX)

∗
j

)
·
(

n
∑

j=1
(ψA)j(ψA)

∗
j

) (23.1)

where :
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• X et A are the 2 configurations of interest

• ψX and ψA correspond to the normalized modes

• j is a point of the structure (must be the same for the 2 modes)

• n is the number of points of the structure considered

The MAC(A,X) value is in the range [0,1].

The MAC in Actran

In practice, the number and location of the nodes is not identical for experimental
results and for simulation results. In the same way, the nodes between two
numerical models can also differ. A correspondence must then be performed
to fit the nodes of two configurations. To do so, a projection algorithm is used.
The corresponding nodes between the two models are found by projecting both
modal databases on a third mesh (which can be different or identical to one of
the two first configurations).

Once the projection is made, it is possible to calculate the MAC correlation.
One can then output a waterfall diagram comparing the shape of each normal-
ized mode of the first configuration to each normalized mode of the second
configuration. It is also possible to export the MAC matrix in an external text file.

The feature supports modes and projection meshes of the following formats:

• UNV (IDEAS Universal)

• Output2 format produced by Nastran or Actran

• NFF database produced by Actran

Computing the MAC correlation
The MAC properties window can be opened through menu Tools→ Compute
Modal Assurance Criterion correlation (Figure 23.5)

Figure 23.5: Opening the MAC window.

There are several fields as input of the MAC correlation, as shown in figure 23.6
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1. The first and second modal databases used for the comparison as well as
the type of quantity contained in the databases

2. The geometrical points i.e. the mesh used for the projection. This mesh can
either be the one of the first modal database, the mesh of the second modal
database or another mesh.

3. Plane and gap tolerance used for projection. Please refer to Actran User’s
Guide Chapter 37.2 of Volume 1 for more explanation about those two
parameters.

4. The frequency range of the MAC correlation. By default, it is the entire
frequency range of the modes contained in the modal databases.

5. Selection of 1D modal database. Because sensors are usually unidirectional,
experimental modal databases often contains 1D data in local coordinates
(e.g. displacement normal to the structure). Because this has a direct impact
on the mac result, this must be accounted for. To do so, simply select the
modal database containing 1D in the scrolling list.

Figure 23.6: Setting MAC options and drawing waterfall diagram.

Then, perform the projection and press "ok" to draw the waterfall diagram. Figure
23.7 shows an example of MAC output. The MAC is calculated by the using
twice the same modal database. In this case, the correlation is perfect (1 value on
the diagonal, 0 elsewhere).

In presence of big modal databases, it is better to avoid having numerous nodes
that do not contain any displacement value. Those nodes will be projected
but the default displacement value will be set to 0. As a consequence, they
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Figure 23.7: Example of MAC output: correlation is perfect in this case.

will not contribute to the MAC correlation in any way. The projection time
will then increase unnecessarily. For the same reason it is better to have only
geometrical nodes within reach of the modal databases nodes. Those nodes will
be processed during the MAC computation, but no node of the modal database
will be projected on them.

23.2.2 Participation Factors

The Participation Factors tool in Actran allows to compute the modal participa-
tion factors from results and a given database of modes.
This feature is very interesting for acoustic radiation analyses when:

1. The results are available at several points (e.g experimental measurements).

2. The results have been computed by a direct response (e.g modal response
was not applicable because of complex structural effects not included in the
modal extraction solver : Viscous damping, non homogeneous damping,...).

The Participation Factors tool in Actran allows the number and location of the
nodes to differ between the results and the modes. It supports:

• Results available at discrete points (under-defined case).

• Results available on the same points as modes (perfectly defined case).

• Results available at on a mesh finer than the modes (over-defined case).

372



WATERFALLViewer Menu

As for the MAC computation, a projection algorithm is then used. The corre-
sponding nodes between the results and modes are found by projecting both on
a third mesh (which can be different or identical to one of the two first configura-
tions). A least square method is then used to compute the participation factors,
minimizing the squared error between the corresponding nodes.

The feature supports modes, results and projection meshes of the following
formats:

• UNV (IDEAS Universal)

• Output2 format produced by Nastran or Actran

• NFF database produced by Actran

Computing the Participation Factors
The Participation Factors properties window can be opened through menu Tools
(Figure 23.8)

Figure 23.8: Opening the Participation Factors window.

Figure 23.9: Setting Participation Factors options.

There are several fields as input of the Participation Factors computation, as
shown in Figure 23.9
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1. The modal database used as well as the type of quantity it contains
(DISPLACEMENT, MODAL_DISPLACEMENT, PRESSURE or MODAL_PRESSURE). If the
AUTO keyword is chosen, Actran will search for one of those two quantities.

2. The result file used as well as the type of quantity it contains (DISPLACEMENT,
NORMAL_DISPLACEMENT, ACCELERATION, NORMAL_ACCELERATION, PRESSURE or
MODAL_PRESSURE). As for modes, if the keyword AUTO is specified, Actran

will search in the result file for one of those quantities. If several quantities
are found, Actran will ask to manually select the quantity of interest.

3. The mesh used for the projection. This mesh can either be the one of the
modal database, the results or another mesh.

4. The first mode and number of modes to be considered in the modal database
for the computation. By default, all modes are considered.

5. The frequency range of the Participation Factors computation. By default,
it is the entire frequency range of the results.

6. Plane and gap tolerance used for projection. Please refer to Actran User’s
Guide Chapter 37.2 of Volume 1 for more explanation about those two
parameters.

Press then OK to compute the participation factors. A PLT set will be created
containing the factors, and they will be drawn in the waterfall diagram (see
Figure 23.10).

Figure 23.10: Example of Participation Factors.

The participation factors can then be exported in PLT format, by right-clicking on
the created set, and exporting it (see Figure 23.11).
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Figure 23.11: Exporting the participation factors.

23.2.3 Order Analysis

In addition to vertical and horizontal cuts, an order analysis can be done to
obtain results at particular orders. In this case, one makes the assumption that
the x values are corresponding to frequencies expressed in Hz, while the y
values are corresponding to the rotation speed expressed in round per minutes.
The cut obtained by the order analysis corresponds to the interpolation at line
y = 60 ∗ x/order.

The Order Analysis window can be opened through menu Tools→ Order Analy-
sis (Figure 23.12).

Figure 23.12: Opening the Order Analysis

There are several options for the order analysis, as shown in figure 23.13

1. The list of orders to extract. A single value or a complete list can be
provided.

2. The number of interpolation points along the line.

3. The interpolation order of the extracted curve. This can be chosen between
linear interpolation, quadratic or cubic interpolation.

4. The X axis that is chosen for the curve extraction. One can plot the order
analysis following the rotation speed or the frequency.
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Figure 23.13: Order Analysis options

When performed, diagonal cuts are plotted within the render window, and the
order cut is shown in the bottom render window, depending on the selected X
axis. Typical result is shown in figure 23.14.

Figure 23.14: Obtained solution

23.2.4 Spectrogram Plot

The Spectrogram Plot tool can be opened through menu Tools→ Spectrogram
PLot (Figure 23.15).

Definition
When dealing with ramp-up simulation, acoustic results are obtained at different
rotation speeds (RPM). Suc results are usually visualized in an "RPM" over
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Figure 23.15: Opening Spectrogram Plot tool

"frequency" 2D-graph. Engine orders (ORDER) can be captured as diagonal
curves in this graph. RPM, ORDER n and frequnecy f are linked together as
following:

fn,RPM = n
RPM

60
(23.2)

RPM or ORDER dependency is handled in Actran through the usage of LOAD-
CASE. Each LOADCASE corresponds to an RPM or ORDER (see section 23.2.4 to
know how to specify this information). Due to the evolution of the frequencies
with RPM increase, the list of computational frequencies usually differs from an
RPM to another. The same happens for an order-based analysis. This leads to
multiple PLT files, one per RPM or per ORDER.

A Spectrogram is generally defined as an evolution of audio spectrum over time.
In WaterfallViewer it is refering to an evolution of spectrum over RPM for a
limited number of orders (Figure 23.16). It differs from a Waterfall plot where a
dense matrix of resuts is considered (m*n matrix).

Figure 23.16: Example of Spectrogram Plot
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Pre-requirements
Information of RPM or ORDER must must be indicated in the LOAD-
CASE_INDEX block of the PLT file(s). The syntax is the following:

• either RPM = rpm_value

• or ORDER = order_value

This LOADCASE information can be generated in different ways:

• the user can provide the RPM or ORDER value as name of a LOADCASE

• it is filled automatically for an acoustic radiation analysis (BC_MESH) using
modal participation factor file generated by "RPM to Order conversion" tool

Examples of PLT header content:

BEGIN LOADCASE_INDEX
100010101 0 BCMESH 1 ORDER = 8.0

END LOADCASE_INDEX

BEGIN LOADCASE_INDEX
1000 0 RPM = 1000.0
5000 1 RPM = 5000.0
9000 2 RPM = 9000.0
13000 3 RPM = 13000.0

END LOADCASE_INDEX

Spectrogram Plot parameters
Spectrogram Plot reads the RPM or ORDER information from the input PLT
file(s), merges the multiple PLT files (if any) and re-order the data per Order. The
resolution of detection of the orders is 0.1 order.

The following input parameters are required (Figure 23.17):

• "Convention":

– "Single PLT" containing all RPM or ORDER results
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– or "Multiple PLT files" in case each RPM or ORDER is contained in
separate a file

• Selection of PLT file(s)

– "Input file": name of the PLT file for "Single PLT" convention

– or "Input folder" path for "Multiple PLT files" convention. In this case
all PLT files from the folder specifed are imported

• "Final set name" helps choosing a name for the Orders set created (Default:
AUTO)

• "Orders list" is the list of orders to import in the Orders set (Default: AUTO).
It can be specified or modified manually.

• Button "Build Orders IDs" helps to detect the Orders available in input
file(s). Optional. It is filling the "Orders list".

• Button "Build orders PLT set": create an Orders set in WaterfallViewer data
tree

Figure 23.17: Input parameters for Spectrogram Plot

Spectrogram display
Once the Orders set is created, the user can plot a Spectrogram by right-clicking
in the data tree (Figure 23.18). The quantity to plot and the operator to apply are
chosen from the pop-up window (Figure 23.19).
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Figure 23.18: Right-click in data tree to plot a spectrogram

Figure 23.19: Selection of quantity and operator

The spectrogram is now displayed in the rendering window (Figure 23.20).

Figure 23.20: Spectrogram plot of SPL in dB at a FIELD_POINT
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Information of frequency, RPM and Order value is available for any position of
the mouse in the rendering window (Figure 23.21).

Figure 23.21: Information at mouse position

It is possible to plot any order as curve plot (Order over RPM or frequency) by
extracting the order from the spectrogram (Figure 23.22).

Figure 23.22: Right-click to extract an order as Cut plot over RPM or frequency

Finally the resolution of the display can be improved thanks to the interpolation
option (Figure 23.23). The user provides a value of RPM step and each order is
refined according to this value. Note that this option is only used for display
purpose. It is not applied when exporting data from Spectrogram plot or Curve
plot.

Figure 23.23: Interpolation option to smoothen the display along orders

23.2.5 EXTF tool

EXTF stands for EXcitation and Tranfer Function recombination. It is used to
combine acoustic results (pressure) at field points with real excitations provided
in time domain.

The EXTF window can be opened through menu Tools→ EXTF (Figure 23.24).
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Figure 23.24: Opening the EXTF tool

The concept of the EXTF tool is the following:

1. A transfer function is computed with unit excitations and one or several
loadcase(s);

2. Real excitations are provided in time domain and are dependent on RPM.
EXTF computes the frequency spectrum of the excitations over RPM;

3. The EXTF tool combines excitation and transfer functions for each loadcase
and sums loadcases together in the complex domain;

4. The EXTF tool displays and stores results.

Output results are the following:

• RPM\frequency diagram (waterfall) of Sound Pressure Level at dedicated
field point

• SPL over time at dedicated field point

Drawing function can be selected among following choices: dB, Amplitude, Real,
Imaginary, Phase.

Results are displayed in WATERFALLViewer but are also stored in the working
directory of WATERFALLViewer current session:

1. Files used for DFT and DFT results of each excitation are available in the
DFT directory;

2. DFT results of the excitations are stored as pictures and ASCII files in the
CAMPBELL directory;

3. Recombined results are stored in the EXTF_RESULTS directory and con-
tains:

382



WATERFALLViewer Menu

• RPM\Frequency diagram for each field point selected according to
the drawing function selected

• OSPL at each field point selected

A first dialog box asks for the transfer function file (PLT file) to be used (Figure
23.25). This file can contain one or several loadcases. Only pressure quantity at
field points are considered for the EXTF tool.

Figure 23.25: Transfer function file (PLT format) for EXTF calculation

Once the transfer function file is selected, a second dialog box (Figure 23.26)
allows to choose the following options:

• The excitation files: An excitation file must be provided for each loadcase
of the transfer function. The excitation file is a time domain dependent
quantity. Its format should respect the following syntax:

– 1st column: time

– 2nd column: quantity (real, unit: consistent with transfer function
loadcase)

• The RPM file: The RPM over time must be provided. Its format should
respect the following syntax:

– 1st column: time

– 2nd column: RPM (real, unit: tr/min)

• The parameters for Discrete Fourier Transform (DFT). These parameters are
detailed in Actran User’s guide Volume 1, section ICFD:
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– Time unit: if excitations and RPM are expressed in a unit different
from ’s’, a unit factor can be applied

– Use existing DFT results: if user has already transformed excitation
into frequency domain, the data stored in the directory of the PLT file
can be used again. A warning message reminds the parameters of
DFT used

– DFT Start - End - Interval - Overlap: defines parameters for mutli-time
domain DFT.

– DFT Normalize - Window: allows to apply time domain windowing
during DFT and normalize energy of the signal.

• Field points: Field points available in transfer function file are listed here.
User can choose which field point must be used for recombination (single
selection) or all field points (’All’ selection)

• Drawing function: recombination results are displayed in
WATERFALLViewer and PLTViewer using the selected drawing function.
Results stored in the working directory are also using this drawing function.

Note that excitation files and RPM file must contain the same time series.

Figure 23.26: Main dialog box of EXTF tool

Typical results are displayed in Figures 23.27 and 23.28.
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Figure 23.27: SPL in dB over RPM at field point POINT_2 1

Figure 23.28: OSPL over RPM at field point POINT_2 1

23.2.6 RPM to Order conversion

The RPM to Order conversion window can be opened through menu Tools →
RPM to Order conversion (Figure 23.29).

Figure 23.29: Opening the RPM to Order conversion tool
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The RPM to Order conversion tool enables to reorganize Modal Participation
Factors (MPF) obtained from simulations obtained at different rotation speeds
(RPM) to Modal Participation Factors (MPF) organized by engine orders. This
can be used to run an acoustic radiation analysis for all or selected orders.

Let’s take an example. A Nastran structure dynamic analysis (Sol111) is per-
formed for different subcases. Each subcase corresponds to a specific RPM value.
Each subcase is run for frequencies selected at every 0.5 order:

• SUBCASE 1: 600 RPM, frequencies = 30, 60, 90, 120, 150... Hz

• SUBCASE 2: 3000 RPM, frequencies = 150, 300, 450, 600, 750... Hz

• SUBCASE 3: 6000 RPM, frequencies = 300, 600, 900, 1200, 1500... Hz

• ...

The participation factors for each subcase are exported as .pch format, either in
a single file or in one file per RPM. The RPM to Order conversion tool helps to
reorganize the PCH content by order so that the user can obtain MPF per order:

• Order 0.5, frequencies = 30, 150, 300... using first frequencies of each subcase

• Order 1.0, frequencies = 60, 300, 600... using second frequencies of each
subcase

• Order 1.5, frequencies = 90, 450, 900... ...

• Order 2.0, frequencies = 120, 600, 1200... ...

• Order 2.5, frequencies = 150, 750, 1500... ...

• ...

The Actran acoustic radiation will then be able use these data. Each Actran

LOADCASE will now correspond to an engine order.

The interface (Figure 23.30) helps to choose:

• The input parameters for selecting the input data

• The computational parameters

• The output parameters
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Figure 23.30: RPM to Order conversion tool interface

Input parameters:

• Input Filename (Figure 23.31):

– Multiple Files: a master file (ASCII format) must be created to point
to the input files (see below for the syntax of the master.txt file).

– Single File: The user can choose directly the appropriate format among
following: PLT (Actran ), PCH (Nastran), UNV

Figure 23.31: Options for Input filename

In case the Modal Participation Factors are stored in multiple files, one per
RPM, the user must create a master.txt ASCII file defining the input files and
associated RPM. The syntax of the master.txt file is the following:

– line 1: "name_of_rpm_file_1" rpm_value_1

– line 2: "name_of_rpm_file_2" rpm_value_2
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– ...

In case the Modal Participation Factors are stored in a single file (PLT, PCH or
UNV), the RPM values are supposed to be the internal loadcase ids.

• Input data quantity: MODAL_AMPLITUDES is the only choice. This
corresponds to Modal Participation factors.

Computational parameters:

• Orders to extract:

– AUTO: the orders are automatically detected based on frequencies
available for each RPM. Note that only the common orders are ex-
tracted

– list: the user can enter its own list to specify only a list of available
orders. Example= [8.0, 22.3, 30.0]

• Frequency range: the frequency range can be limited to a user defined
range. By default, the range is limited to [0., 10000.0] Hz.

Output parameters:

• Output data type:

– Single file: Modal Participation Factors are stored in a single PLT
file. Frequencies available for each order may be different. So the
frequencies are merged. If a result does not exist for an order, the
value 0.0 is assigned.

– Multiple files: each order requested is stored in an individual PLT file.
Each PLT file contains its own list of frequencies.

• Output filename: defines the name of the output file(s):

– If Single file has been selected, the name of the PLT file is the filename.

– If Multiple file has been selected, each PLT is using this filename with
an extension corresponding to the value of each order.
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Whatever the situation, the PLT file contains some information in the
LOADCASE_INDEX block:

– ORDER = order_value is the value of order associated to a loadcase

– RPM = [rpm_1, rpm_2,...] is the list of RPMs corresponding to the
frequencies for a given order

The ORDER information is reused by Actran acoustic radiation analysis
(BC_MESH ) to transfer the information to the output results file. Hence the
output PLT file keeps the information of ORDER associated to each LOADCASE.

• Convert data: runs the conversion and write the output files

23.2.7 1D Engine Source Coupling tool

The Engine Source coupling tool enables to evaluate engine sources based on
output files provided by GT-Power. These sources can either be directly used
inside the tmm (See Section ??) or recombined with a provided transfer function.

The definition of an engine source is described in Section 54.2.1 of Volume 1. The
provided files from GT-Power are expected to be provided as follow:

• These should be provided as text files.

• They should either contain crank angle and both downstream and upstream
pressure or source and impedance data.

• One file per RPM should be provided and named as 100RPM.txt for 100
RPM.

Two methods are available to evaluate the engine sources:

• A single configuration method that can only provide the amplitude of
the source without reflection factor, as shown in Figure 23.32. In this
configuration, the source files must all be provided in a single folder. This
method is valid both for crank angle or source-impedance data inputs.

• A double configuration method that can provide the amplitude of the source
with the corresponding reflection factor, as shown in Figure 23.33. In this
configuration, it is expected to have both configurations provided in two
separate folders names Config1 and Config2 respectively. The evaluation
of both the source amplitude and reflection factor is then obtained as shown
in Figure 23.34.
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Figure 23.32: Single configuration window

Figure 23.33: Double configuration window
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Figure 23.34: Double configuration source evaluation

In both configurations, the frequency domain of the evaluated sources, the output
folder and the input folder must be provided. The evaluated engine source is
then shown as in Figure 23.35.

Figure 23.35: Double configuration source result

Optionally, the Actran transfer function can be provided to enable a recombina-
tion using the evaluated sources. Both local indicators and radiated power will
be recombined using the evaluated engine source. The recombination accounts
for the source amplitude C and reflection factor R as follows:

P =
TF ∗ C

1− R ∗ IMB
(23.3)
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Twenty Four

WATERFALLViewer Data
Trees

24.1 Introduction

The Data tree panel of the WATERFALLViewer tool is similar to the Data tree
panel of the PLTViewer tool (see Section 18).

The data tree contains all quantities imported from PLT, UNV Punch or TXT
file. When the data is imported from the file, the results are automatically parsed
and subdivided in different sections, depending on the type of imported file.

In general, the WATERFALLViewer will access tables of results (depending on
loads and frequency) for generating functions and plots.

Figure 24.1: Indicator length.
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Figure 24.2: Vector and Table quantity.

394



Twenty Five

WATERFALLViewer Function
Panel

25.1 Introduction

In order to plot imported data to a figure, functions must first be created. A
function associates pairs of arguments (X,Y) to acoustic values (Z). By convention,
the set of X values represent the frequency and the set of Y values represent the
regimes even if any other physical quantity can be associated to the X and Y
arguments. Functions can be created by drag-and-dropping data from the tree to
the X data vector or Y data vector or Z data table as shown below.

25.2 X and Y Vectors

The size of the X and Y vectors must be relevant compared to the size of the table
that is used for the Z axis. If the Z table is of the size (m x n), the length of the
Y vector should be m and the length of the X vector should be n.

Figure 25.2: Size of the X and Y axis.
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Figure 25.1: Functions of the Waterfall Viewer.

For multiple loadcases analysis, the loadcase List quantity has the right size to
be defined as the Y vector and the frequency list quantity has the right size to be
defined as the X vector.

The loadcase list may contain inappropriate values when the automatic loadcase
generation mechanism of Actran is used (please refer to the Actran User’s
Guide, Section 11.22 of Volume 2). In this case, the user can define directly the Y
vector by using python code such as the function numpy.arange(min,max,step).
If the user wants to define the Y axis as 11 values starting from 1 up to 11, he can
directly introduces numpy.arange(1,11,1) in the Y axis input.
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Figure 25.3: User-defined Y axis.

25.3 Z Table

The Z values must be dragged and dropped from a table of the data tree panel
inside a data container. These data containers are available when selecting an
operator as shown in Figure 25.5.

25.4 Function Definition

Data arrays can be combined by using operations.

For example : 20 log(
√

Re(p)2+Im(p)2

2∗10e−5/
√

2
)

becomes :

20*log10(sqrt(array.real**2+array.imag**2)/2e-5/sqrt(2))

Another example, the velocity amplitude in a node, expressed in dB with a
reference of 1:

20 log(ω ∗
√

Am(Disx)2 + Am(Disy)2 + Am(Disz)2)

becomes in the WATERFALLViewer:
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Figure 25.4: Definition of a function in the data vector.

A set of built-in operators is available in WATERFALLViewer and can be used in
the definition of functions(see Figure 25.5).

Figure 25.5: In-built operators.

The list of the different operators that are available and their description is
provided in Table 19.1.

Please note that the language used for the data vector is the Python lan-
guage (www.python.org). The mathematical python package used is Numpy
(www.numpy.org).
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25.5 Remarks and Further Reading

The check box "Interpolate non computed values" allows replacing all the NaN val-
ues available in Z-axis table, by values obtained by linear interpolation of nearest
available values. Similarly, "Interpolate zero values" forces WATERFALLViewer

to replace zero values by values using a linear interpolation of the nearest non-
zero values. The function panel is not used for Spectrogram Plot (section 23.2.4).
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Twenty Six

WATERFALLViewer Render
Window

26.1 Introduction

The render Window is used to plot the functions defined in the function panel.
This panel is organized in 4 sub-panels:

• Waterfall sub-panel;

• Horizontal Plot sub-panel;

• Vertical Plot sub-panel;

• Figure Properties sub-panel.

26.2 Waterfall Panel

A waterfall diagram is plotted in the waterfall panel. By right-clicking on the
diagram one can create horizontal or vertical cut as illustrated in Figure 26.1.
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Figure 26.1: Add horizontal and vertical cut

Once created, the location of the vertical or horizontal cut can be edited by
dragging the line using left-click. One can also change the line properties by
right-clicking on the line (see Figure 26.2). The following properties can be edited:

• color

• marker

• line width

• line style

Figure 26.2: Vertical Horizontal Cut Line Properties
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26.3 Horizontal and Vertical Plot Panel

Horizontal (and vertical) Plot Panel gathers all the horizontal (and vertical) cuts
defined in the waterfall panel. The curves properties (color, marker, line width,
line style) are identical to the ones defined in the waterfall panel.

Below the horizontal (and vertical) panel, the control bar (see Figure 26.3) is used
to perform the following operations (ordered according to the buttons from left
to right in the control bar):

• home: zoom out to fit all data in the figure.

• save the figure in various image file format such as png or eps.

• copy to clipboard allows to perform a snapshot of the displayed figure.

• export allows to output figure quantities in txt of csv formats.

Clicking on these buttons changes the mouse click behaviour and actions. To
restore the original mouse click behaviour, the user should click a second time on
the button.

Figure 26.3: Figure Control Bar

26.4 Figure Properties Panel

The Figure Properties Panel allows defining the X, Y and Z axis label. One
can also define the upper and lower bound of the color bar and the axis to be
visualized.

The interpolation or discretization of the main map can be modified. De-activating
the interpolation will show the raw discrete data along all directions. Activating
a selective discretization along a particular direction allows to visualize different
loadcases between them inside a single render window. This is usefull when
looking at mode contribution for example.
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Figure 26.4: Render window properties

Figure 26.5: Discretization along a particular axis
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Twenty Seven

Sessions

27.1 Purpose

During any instance of ActranVI, PLTViewer or WATERFALLViewer, a session
file is automatically written in the current report folder. Every action performed
interactively in the user interface (with a limited number of exceptions) is recorded
in this session file using the Actran Application Programming Interface (API).
Please refer to chapters 29 and 30 for more details.

This session file can then be used for:

• Re-launching ActranVI, PLTViewer or WATERFALLViewer in the latest
state;

• Retrieving a stable status of the application when an unexpected crash has
occurred (removing faulty lines in the session file may be needed);

• Automating the creation, the run or the post-processing of an Actran

analysis.

27.2 Save Sessions

When opening ActranVI, PLTViewer or WATERFALLViewer, a session file is
automatically created in the current report folder. The default name of this file
is ActranVI.0.sess, whichever application has been opened.

Remark. The previous sessions files existing in the current report folder
are not overwritten. The number of the current session is increased to the first
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available number. For example, if ActranVI.0.sess exists, the session file
created at the next start of ActranVI will be ActranVI.1.sess. If both
ActranVI.0.sess and ActranVI.2.sess exist, the session file created at
the next start of ActranVI will also be ActranVI.1.sess.

Each action performed in ActranVI, PLTViewer or WATERFALLViewer corre-
sponds to a function of the API. For every user action, the corresponding API
function is written:

• in the session file;

• in the console.

The session can be saved at any time by clicking

File→ Export Session

in the main menu bar.

27.3 Load Sessions

At any time a session file can be loaded and played by clicking

File→ Load Session ...

or

File→ Load Recent Session ...

in the main menu bar.

When loading a session file, all the data currently defined (trees, display,...) are
cleared. Two options are available to the user :

• Clear all data of the current application only (the current application corre-
sponds to the one from which the session loading has been invoked), the
data of the other opened applications not being deleted;
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• Clear all data of all opened applications.

These two options are displayed in the "Load session options" dialog box that
should appear after the session file chooser is closed.

This step is equivalent to the command (see Section 8.1.11):

File→ Clear all trees

of the main menu bar.

Two different options are proposed to play a session file. The "Automatic Import"
and "Interactive Import":

• Automatic import file(s): all files referred in the session file are imported
automatically;

• Interactive import file(s): files referred in the session file are not imported
automatically. Each time a command involving file import is read, the
application explicitly asks the user to select the file. Therefore the user can
select different files than those referred in the session file. This is useful for
example to perform the same actions on another mesh.

27.4 Restrictions

Some actions have no equivalent function in the API and therefore are not
recorded in the session file. These actions are :

• All the actions related to the selection of nodes, elements and PID Domain;

• All actions related to PID Domain assignation modification (remove or add
elements to new or existing PID Domain, ...).

A pop-up window with a warning message is displayed when those actions are
performed.

27.5 Remarks and Further Reading

• The user actions related to camera motions can be excluded from the session
using the general settings (see Section 8.9).
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• The session file is written in the Python language (www.python.org) and
can be enriched with any Python function. Further details on the API are
provided in the chapters 29 and 30.
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Twenty Eight

Scripting

28.1 Introduction

In chapter 27, we detailed how to save and load a session to replicate all operations
done in ActranVI, PLTViewer and WATERFALLViewer. This session feature
rely on the link between every user action and the corresponding function of the
Actran Application Programming Interface (API).

This API defines a set of functions that take zero or more arguments that control
its action. Those functions act on various objects, specific to each Actran user-
interface application.

• In ActranVI: viewport, material, analysis, component, boundary condition,
domain, ...

• In PLTViewer: results set, figures, functions, curves, ...

• In WATERFALLViewer: results set, cuts, ...

These objects are often passed as arguments or returned by the functions of the
API. The different properties that can be accessed for each object is specific to
the object type. When an object is suppressed or overwritten, it is not accessible
anymore.

The Actran API allows the user not only to save and load sessions but also to
create user-defined scripts, which is really powerful to automate pre- or post-
processing operations. The script created can also include any module, function
or command available in the Python language.
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This chapter aims at introducing the key concepts of the Actran API and give
the user the basics to build its own scripts.

28.2 Unified interface

Since release 14.0, ActranVI,PLTViewer and WATERFALLViewer can be used
inside a single unified interface. Each application is opened in a tab, allowing
to quickly switch from one application to the other. There remains one common
console and log window for all three applications. Objects of each application
can be created as soon as an application is opened in the unified interface, and
are accessible from all applications through the common console terminal.

28.3 How to get help within the console

28.3.1 Help on API functions

As the number of functions is large, only the most useful ones are described in
this chapter. The help on the most specific ones can be accessed directly from the
console in ActranVI (see 11.5).

To retrieve the list of all the functions (and their arguments) for each utility, the
user can type one of these three commands within the console:

>> actranvi.help()
>> pltviewer_1.help()
>> waterfallviewer_1.help()

The user can restrict the display to the functions names containing only a given
string with the command:

>> actranvi.help(’string’)
>> pltviewer_1.help(’string’)
>> waterfallviewer_1.help(’string’)

For example, to get the list of ActranVI functions containing the string bc:

>> actranvi.help(’bc’)
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Figure 28.1: List of API functions containing the string bc

28.3.2 Help on ActranVI objects and particular functions

For any object or function, the complete list of its properties can be obtained by
typing the following command within the console:

>> help(object_name)

Remark. object_name is the name of the object as defined when cre-
ated. For example the first fluid material created through the graphical user
interface receives the name fluid_material_1.
The corresponding line in the console is :

>> fluid_material_1 = ...
... actranvi.add_material(’Fluid Material’)

For retrieving a help on a particular function, the application object must be
specified:

>> help(actranvi.add_material)

Figure 28.2 shows an example of help returned for a material object of type Fluid
Material:
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Figure 28.2: First line of the help return for a Fluid material object

The name of an object can also be retrieved by drag’n dropping the object from
the main tree to the console as shown in Figure 28.3.
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Figure 28.3: Retrieve object name with drag’n drop in the console

28.4 Remarks and Further Reading

Further informations about the Python language can be found on http://www.
python.org/.
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Twenty Nine

ActranVI API

29.1 Main ActranVI pre-processing functions

Functions used during pre-processing are either available to edit or create new
objects. In most cases, the type of the object (for instance, the type of a created
material) can be set during the creation of the object, or edited later on. The main
functions for pre-processing are listed in Table 29.1.

29.2 Main ActranVI post-processing functions

The main post-processing functions are listed in Table 29.2.
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Function Arguments Description

read_mesh file, file_format
Allows importing a mesh file and creating a
main topology.

read_analysis file Allows importing an Actran analysis.
read_material file Allows importing an Actran material.
read_table file Allows importing an Actran table.

reinterpolate topology
Modifies the interpolation order of an exist-
ing topology.

add_domain topology Creates a new domain.
auto_create_domain pid Creates a new domain from an existing pid.

auto_create_domains topology
Creates a new domain from every existing
pid in a topology.

add_viewport - Creates a new viewport.
add_material type Creates a new material.
add_table type Creates a new table.
add_analysis type Creates a new analysis.
add_bc analysis,type Creates a new boundary condition.
add_component analysis,type Creates a new component.
add_ analysis Creates a new object of the specified type.

get_ type, name, id
Finds a specified object type based on his
pid, type or name.

add target, source
Assigns to a target (being any kind of ob-
ject) a source (being a mesh, ...).

set_prop object, property
Sets the property of a selected object to a
specified value.

validate
analysis, argu-
ments

Validates an analysis by a test run using the
specified arguments.

run
analysis, op-
tions, arguments,
clean_scratch

Runs the computation of an analysis using
the specified options and arguments.

write_analysis
analysis, file, for-
mat

Exports an Actran input file from an analy-
sis.

clear_all - Clean the whole content of ActranVI.

quit force
Closes the current session (force allows re-
moving the confirmation popup)

centercb -
Calculate the center and 1st axis of a modal
duct (This is a function of the modal duct).

axiscb -
Calculate the 2nd and 3rd axes of a modal
duct (This is a function of the modal duct).

paramcb -
Calculate the other geometry parameters of
a modal duct (This is a function of the modal
duct).

Table 29.1: ActranVI functions for pre-processing.
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Function Arguments Description

read_mesh file, file_format
Allows importing a mesh file and creating a
main domain.

add_viewport - Creates a new viewport.

add_result_file
mesh, file,
sub_type

Reads the content of a result file and creates
a container to access those.

add_cut - Create a new cutplane object.

import_results
result_container,
quantity

Imports the selected quantity from the
result_container in the current session.

display_map operator, quantity
Displays a map of the selected quantity us-
ing the selected operator.

display_deform operator, quantity
Displays a deformation of the selected
quantity using the selected operator.

display_iso_surfaces operator, quantity
Displays isosurfaces of the selected quantity
using the selected operator.

display_vectors operator, quantity
Displays vectors of the selected quantity us-
ing the selected operator.

set_prop object, property
Sets the property of a selected object to a
specified value.

remove_all_display - Removes all visible visualizations.

cut_display cut
Activates the visualization of the selected
cutplane.

remove_cut_display cut
De-activates the visualization of the selected
cutplane.

Table 29.2: ActranVI functions for post-processing.
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PLTViewer API

30.1 Access to results within Actran results file

Actran results file contains different arrays, representing different local or global
quantities on points, domains or surfaces, for every loadcase. These are ordered
in a tree within PLTViewer. All these result quantities can be easily accessed
using the API functions.

The Actran results file can be considered as an object (a set), which contains
sub-objects (domains, points, ...). These objects contain themselves sub-objects
(called fields, such as fluid pressure, ...). These sub-objects can contain multiple
results (depending on the number of loadcases). This succession of objects is
shown in Figure 30.1. Each object or sub-object can be called by its identifier,
being a string or integer. The identifiers correspond to the identifiers of the
Actran result file, as described in the Actran User’s Guide.

For instance, the mean square pressure of the acoustic domain of Id 1 can be
accessed using the following command:

fluid_pressure = set_1.domain["Acoustic1"].field["mp"].lc[1]

where fluid_pressure is an array. This value can be also retrieved by alternative
ways, for example through the definition of other objects:

acoustic_domain = set_1.domain["Acoustic1"]
fluid_pressure = acoustic_domain.field["mp"].lc[1]

where acoustic_domain represents the object containing all quantities related to
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the selected domain.

Figure 30.1: Content of the results objects

For each type of object, the list of sub-objects can be called by adding the .ids
command to the object. For instance, calling the list of sub-objects on various
quantities or domains provides:

>>> set_1.DOMAIN["Acoustic2"].ids
[’f’, ’mass’, ’mp’, ’sp’, ’vol’]
>>> set_1.ids
[’DOMAIN’, ’INTERFACE’, ’POINT_1’, ’POINT_2’, ’SURFACE’]
>>> set_1.SURFACE.ids
[’CouplingSurface1’, ’CouplingSurface2’, ’SampledRandomDiffuse1’]

The identifier of the selected object can be retrieved by adding the .id command
to the object. For instance:

>>> point = set_1.POINT_1["1"]
>>> point.id
’1’

For modes, nodes and points, the comment present within the Actran results
file can be retrieved by adding the .comment command to the object. For instance:

>>> point = set_1.POINT_1["1"]
>>> point.comment
’coordinates = [ 0.5 0. 0. ]’
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30.2 Main PLTViewer functions

The list of main PLTViewer functions is given in Table 30.1.

When creating new curves, figures or functions, it is advised to specify a name to
the object, in order to call this object later in the script.

30.2.1 Examples
Plotting a curve
The default syntax for plotting a simple curve is the following:

set_1 = import_file(file=r’C:\test.plt’,ftype=’plt’)
fig_1 = new_figure()
func_1 = new_func()
update_func(func=func_1,x=set_1.NODE["184"].field["f"],...

...y=REAL(set_1.NODE["184"].field["suz"]))
curve_1 = plot( function=func_1, figure=fig_1 , label=’NODE 184’ )
set_prop( fig_1, xlabel=’f’, ylabel=’Solid_UZ (REAL)’ )

The different properties of the curves, function and figures can be specified at the
creation of the objects. The script above is equivalent to the same compact one:

set_1 = import_file(file=r’C:\test.plt’,ftype=’plt’)
fig_1 = new_figure( xlabel=’f’, ylabel=’Solid_UZ (REAL)’)
func_1 = new_func(x=set_1.NODE["184"].field["f"],...

...y=REAL(set_1.NODE["184"].field["suz"]))
curve_1 = plot( function=func_1, figure=fig_1 , label=’NODE 184’ )

Multiple curve creation
When adding different curves of the same type of value, the number of lines in
the script can become important:

set_1 = import_file(file=r’C:\test.plt’,ftype=’plt’)
fig_1 = new_figure( xlabel=’f’, ylabel=’Solid_UZ (REAL)’)
func_1 = new_func(x=set_1.POINT["1"].field["f"],...

...y=REAL(set_1.POINT["1"].field["suz"]))
curve_1 = plot( function=func_1, figure=fig_1 , label=’POINT 1’ )
func_2 = new_func(x=set_1.POINT["2"].field["f"],...

...y=REAL(set_1.POINT["2"].field["suz"]))
curve_2 = plot( function=func_1, figure=fig_1 , label=’POINT 2’ )
func_3 = new_func(x=set_1.POINT["3"].field["f"],...

...y=REAL(set_1.POINT["3"].field["suz"]))
curve_3 = plot( function=func_1, figure=fig_1 , label=’POINT 3’ )
func_4 = new_func(x=set_1.POINT["4"].field["f"],...

...y=REAL(set_1.POINT["4"].field["suz"]))
curve_4 = plot( function=func_4, figure=fig_1 , label=’POINT 4’ )
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Since standard Python syntax can be used, the size of the script can be reduced
through the use of loops (for, while, ...) :

set_1 = import_file(file=r’C:\test.plt’,ftype=’plt’)
fig_1 = new_figure( xlabel=’f’, ylabel=’Solid_UZ (REAL)’)
for point in set_1.point:

func_1 = new_func(x=point.field["f"],y=REAL(point.field["suz"]))
plot( function=func_1, figure=fig_1 , label=’POINT ’+point.id )

Please refer to the Python documentation for more details.
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Function
Mandatory
inputs

Optional inputs Description

import_file file, ftype -
Allows importing an
Actran results file

add_reverse_set set - Creates a reverse set
rename_set set, name - Renames the imported set
remove_plt_set set - Removes a set

merge_sets list of sets
title, tol, axisymmetric or-
der, lc_offset_duct_mode,
force_average

Merges multiple plt_sets

new_figure - figure object props
Creates a new figure in the
graphical user interface

duplicate_figure figure -
Duplicates an existing fig-
ure

remove_figure figure - Removes an existing figure
new_func - x,y Creates a new function

update_func func,x,y -
Updates the existing x and
y of an existing function

remove_func func -
Removes an existing func-
tion

plot fig, func

label, line_color,
line_style, marker_color,
marker_style, opacity,
thickness, type

Creates a curve with speci-
fied properties

remove_curve curve - Removes an existing curve

set_prop object
figure object props, curve
object props

Sets the properties of ob-
jects (curves,...)

export_text fig, filename -
Exports the curves under
txt format

convert_to_audio -

plt_set, wavefilename,
read_file, obj, loadcase,
mono, window, maxlevel,
length, df, interpolation,
time

Converts an acoustic pres-
sure frequency response to
an audio file

export_image fig, filename width, height
Exports the curves under
png format

clear_all - -
Clean the whole content of
PLTViewer.

quit - force
Closes the current session
(force allows removing the
confirmation popup)

Table 30.1: PLTViewer functions.
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WATERFALLViewerAPI

The list of WATERFALLViewer functions is given in Table 31.1.
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Function Mandatory inputs
Optional
inputs

Description

import_file file, ftype -
Allows importing
an Actran results
file

plot x vector, y vector, z matrix

fig_set , inter-
polate_matrix,
up-
date_widgets

Creates water-
fall diagram with
specified properties

add_cut plot , position - Adds a cut in the

remove_cut cut -
Removes an exist-
ing cut

export_text fig, filename -

Exports the
WATERFALLViewer

diagram under txt
format

export_image fig, filename width, height
Exports the curves
under png format

mac

geom_model_file,
geom_model_format,
modal_database_1_file,
modal_database_1_format,
modal_database_2_file,
modal_database_2_format

frequency_range,
gap_tol,
plane_tol,
one_dimension
_modal_database

Computes the
modal assurance
criterion

participation_factors

results_file, re-
sults_format, modes_file,
modes_format, mesh_file,
mesh_format

frequency_range,
gap_tol,
plane_tol,
modes_quantity,
re-
sults_quantity

Computes the
modal participa-
tion factors

clear_all - -
Clean the whole
content of
WATERFALLViewer.

quit - force

Closes the current
session (force al-
lows importing the
confirmation

Table 31.1: WaterfallViewer functions.
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